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Oracle Retail Macro Space Management, Fixture Studio User Guide, Release 14.1 

 

Oracle welcomes customers' comments and suggestions on the quality and usefulness of 
this document. 

Your feedback is important, and helps us to best meet your needs as a user of our 
products. For example: 

 Are the implementation steps correct and complete? 

 Did you understand the context of the procedures? 

 Did you find any errors in the information? 

 Does the structure of the information help you with your tasks? 

 Do you need different information or graphics? If so, where, and in what format? 

 Are the examples correct? Do you need more examples? 

If you find any errors or have any other suggestions for improvement, then please tell us 
your name, the name of the company who has licensed our products, the title and part 
number of the documentation and the chapter, section, and page number (if available). 

Note: Before sending us your comments, you might like to 
check that you have the latest version of the document and if 
any concerns are already addressed. To do this, access the 
Online Documentation available on the Oracle Technology 
Network Web site. It contains the most current 
Documentation Library plus all documents revised or 
released recently. 

Send your comments to us using the electronic mail address: retail-doc_us@oracle.com 

Please give your name, address, electronic mail address, and telephone number 
(optional). 

If you need assistance with Oracle software, then please contact your support 
representative or Oracle Support Services.  

If you require training or instruction in using Oracle software, then please contact your 
Oracle local office and inquire about our Oracle University offerings. A list of Oracle 
offices is available on our Web site at www.oracle.com. 

http://www.oracle.com/
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Preface 
This guide describes the Macro Space Management user interface. It provides step-by-
step instructions to complete most tasks that can be performed through the user 
interface. 

Audience 
This User Guide is for users and administrators of Oracle Retail Macro Space 
Management. This includes merchandisers, buyers, business analysts, and administrative 
personnel. 

Documentation Accessibility 
For information about Oracle's commitment to accessibility, visit the Oracle Accessibility 
Program website at 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.  

Access to Oracle Support 
Oracle customers that have purchased support have access to electronic support through 
My Oracle Support. For information, visit 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are 
hearing impaired. 

 Related Documents 
For more information, see the following documents: 
 Oracle Retail Macro Space Management Release Notes 

 Oracle Retail Macro Space Management Administration Module User Guide 

 Oracle Retail Macro Space Management Configuration Module User Guide 

 Oracle Retail Macro Space Management Data Importer User Guide 

 Oracle Retail Macro Space Management Fixture Studio User Guide 

 Oracle Retail Macro Space Management Product Studio User Guide 

 Oracle Retail Macro Space Management Report Designer User Guide 
 Oracle Retail Macro Space Management Merchandiser User Guide 

 Oracle Retail Macro Space Management Planner User Guide 

 Oracle Retail In-Store Space Collaboration Release Notes 

 Oracle Retail In-Store Space Collaboration User Guide 

 Oracle Retail In-Store Space Collaboration Mobile User Guide 

 Oracle Retail Macro Space Planning Installation Guide 

 Oracle Retail Macro Space Planning Data Model  

 Oracle Retail Macro Space Planning Security Guide 

  

http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs
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Customer Support 
To contact Oracle Customer Support, access My Oracle Support at the following URL: 

https://support.oracle.com 

When contacting Customer Support, please provide the following: 

 Product version and program/module name 

 Functional and technical description of the problem (include business impact) 

 Detailed step-by-step instructions to re-create 

 Exact error message received 

 Screen shots of each step you take 

Review Patch Documentation 
When you install the application for the first time, you install either a base release (for 
example, 14.1) or a later patch release (for example, 14.1.1). If you are installing the base 
release or additional patch releases, read the documentation for all releases that have 
occurred since the base release before you begin installation. Documentation for patch 
releases can contain critical information related to the base release, as well as information 
about code changes since the base release. 

Improved Process for Oracle Retail Documentation Corrections 
To more quickly address critical corrections to Oracle Retail documentation content, 
Oracle Retail documentation may be republished whenever a critical correction is 
needed. For critical corrections, the republication of an Oracle Retail document may at 
times not be attached to a numbered software release; instead, the Oracle Retail 
document will simply be replaced on the Oracle Technology Network Web site, or, in the 
case of Data Models, to the applicable My Oracle Support Documentation container 
where they reside. 

This process will prevent delays in making critical corrections available to customers. For 
the customer, it means that before you begin installation, you must verify that you have 
the most recent version of the Oracle Retail documentation set. Oracle Retail 
documentation is available on the Oracle Technology Network at the following URL: 
http://www.oracle.com/technetwork/documentation/oracle-retail-100266.html 

An updated version of the applicable Oracle Retail document is indicated by Oracle part 
number, as well  as print date (month and year). An updated version uses the same part 
number, with a higher-numbered suffix. For example, part number E123456-02 is an 
updated version of a document with part number E123456-01. 

If a more recent version of a document is available, that version supersedes all previous 
versions. 

Oracle Retail Documentation on the Oracle Technology Network 
Documentation is packaged with each Oracle Retail product release. Oracle Retail 
product documentation is also available on the following Web site: 
http://www.oracle.com/technetwork/documentation/oracle-retail-100266.html 

(Data Model documents are not available through Oracle Technology Network. These 
documents are packaged with released code, or you can obtain them through My Oracle 
Support.) 

Documentation should be available on this Web site within a month after a product 
release. 

https://support.oracle.com/
http://www.oracle.com/technetwork/documentation/oracle-retail-100266.html
http://www.oracle.com/technetwork/documentation/oracle-retail-100266.html
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Conventions 
Navigate: This is a navigate statement. It tells you how to get to the start of the procedure 
and ends with a screen shot of the starting point and the statement “the Window Name 
window opens.”  
This is a code sample 
 It is used to display examples of code 
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1 
Fixture Studio Overview 

Overview of Components 
The Fixture Studio Window has a number of parts. 

 
 

Option Description 

Menu Bar This gives access to a number of menus, each controlling one aspect of Fixture 
Studio  

Toolbar 
This allows the selection of a number of options relative to fixture and gondola 
creation. 

Block Browser 
This has a hierarchical tree of fixtures or gondolas depending on which tab is 
selected. 

Preview Window 
When the fixturing tab is active, this gives a preview of the object selected in the 
fixture hierarchy. Display of this window can be turned on or off using the 
Preview option on the view menu. 

Status Bar  This gives information on the number objects selected, status of current action, 
and so on. 

Block Definitions 
Window 

This window contains a list of all gondolas held in the Macro Space Planning 
database. 

Gondola This window contains a list of all blocks (fixtures, fittings and so on) held in the 
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Option Description 

Definitions 
Window 

Macro Space Planning database. 

Note: whether blocks are automatically loaded into Fixture 
Studio depends in setting in the Options dialog box (View 
menu). If blocks are not set to automatically load, they must 
be imported using the Read Blocks option on the File menu. 

Fixture Studio and Local Memory 
All addition, editing and deletion of fixtures and gondolas is held within local memory in 
Fixture Studio. Information is only written back to the Macro Space Planning database 
when explicitly saved. 

Options on the Toolbar 
The Toolbar gives access to a series of Fixture Studio options (some of which are also 
available from the menu bar). 

 

Icon Option Description 

 

Read Blocks Read in block information from the database, current drawing in Planner 
or a combination of the two. 

 

Save Blocks Save block information to the database and - depending on settings - to 
DWG files. 

 

Exit Fixture 
Studio  Exit the module. 

 

Add Group 
Add a Group to the Fixture or Gondola hierarchy. The changes will not be 
written to the database until the Save Blocks option is used from the file 
menu or toolbar. 

 

Edit Group 
Edit a Group in the Fixture or Gondola hierarchy.  The changes will not be 
written to the database until the Save Blocks option is used from the file 
menu or toolbar. 

 

Delete Group 
Delete a Group from the Fixture or Gondola hierarchy.  The changes will 
not be written to the database until the Save Blocks option is used from 
the file menu or toolbar. 

 

Add Block 
Definition 

Add a block (fixture) definition.  The information will not be written to the 
database until the Save Blocks option is used from the file menu or 
toolbar. 

 

Edit Block 
Definition 

Edit an existing block definition.  The changes will not be written to the 
database until the Save Blocks option is used from the file menu or 
toolbar. 
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Icon Option Description 

 

Delete Block 
Definition 

Delete a block definition.  The deletion will not be written to the database 
until the Save Blocks option is used from the file menu or toolbar. 

 

Add Gondola 
Description 

Add a gondola description. This will not be written to the database until 
the Save Gondolas option is used from the File menu.  

 

Edit Gondola 
Description 

Edit an existing gondola description. Changes will not be written to the 
database until the Save Gondolas option is used from the File menu.  

 

Delete Gondola 
Description 

Edit an existing gondola description. The deletion will not be written to 
the database until the Save Gondolas option is used from the File menu. 

 

Edit Gondola 
Sizes 

Set up the list of sizes that gondolas can assume when placed in Planner, 
Merchandiser or In-Store Space Collaboration 

 

Edit Gondola 
Part Types 

Set up the list of gondola part types. (These are used for reporting 
purposes. 

 

Map Gondola 
Parts 

Map the name of an actual gondola part to a naming convention. This is 
used if blocks have names not following a naming convention. 

 

Copy Copy the selected text 

 

Paste Paste the selected text 

 

Find Find a specified block by name 

 

Filter Block 
Definitions 

Filter block definitions to match a list of criteria 

 

Set Columns in 
Grid 

Set the columns that appear in the block definitions grid. 

 

Block Wizard Calls the Block Wizard 

 

Help Call these help files. 

 

Refresh Reloads a set of basic information from the database. This includes 
information on layers, levels and so on. 

File Menu 
The File Menu  has varying options concerned with reading and saving blocks, AutoCAD 
operations and connection to AutoCAD. 
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Note: The Load Blocks into Drawing, Load Blocks From 
Disc, Laying Out Blocks, Normalize Blocks, Create 3DS Files 
and Redefine blocks from disc will be grayed out unless the 
Connect to AutoCAD option has been checked. 

Option Description 

Read Blocks 
Depending on the settings in the Read Block Definitions dialog box this reads 
information from the Macro Space Planning database, the currently active drawing 
or both into Fixture Studio. 

Save Blocks This saves the details of all selected blocks back to the central Macro Space 
Management Planning from Fixture studio. It does not save Gondola Definitions. 

Save 
Gondolas 

This saves details of gondola definitions back to the database. It does not save details 
of component fixtures. 

Load Blocks 
into Drawing 

If active, this option is used to take copies of the DWG files from the Macro Space 
Planning directories currently specified in Fixture Studio and load a copy to the 
currently active drawing in AutoCAD 

Load Blocks 
from Disk 

If active, this option enables the user to select blocks from a source outside of the 
Macro Space Management database and load them into the currently active 
AutoCAD drawing. (This is in contrast to the Load Blocks into Drawing option 
which selects copies of the DWG files from the Macro Space Planning directories 
currently specified in Fixture Studio). 

Layout 
Blocks in 
Drawing 

If active, this option is similar to the Load Blocks into Drawing option, except that it 
bypasses the AutoCAD Insert command and lays out the selected blocks in a grid 
pattern in the currently active drawing in the AutoCAD environment. 

Normalize 
Blocks 

If active, this option is used to modify the AutoCAD properties of blocks selected in 
Fixture Studio. It is the equivalent of the AutoCAD Object Properties dialog box, but 
can be used to perform bulk operations. 

Create 3DS 
Files 

If active, this option allows users to create 3DS files (used in the Merchandiser 
module) from an AutoCAD 3DS file.  
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Option Description 

Redefine 
blocks from 
Disk 

If active, this option allows the user to overwrite any blocks in the current selected 
floor plan in Planner with the latest versions specified in Fixture Studio. 

Block Factory This option opens Block Factory. Block Factory can be used to create a set of logical 
block names 

Configure This opens the Configuration Module 

Connect to 
AutoCAD 

This option will only be active if Planner is open. It allows users to connect to the 
drawing current open in Planner. If the focus is switched to a different drawing in 
Planner, this option must be closed and reopened so that Fixture Studio is connected 
to the new drawing. 

Exit Selecting this option closes Fixture Studio.  

Edit Menu 
The Edit Menu has varying options concerned with editing block descriptions. 

 

Add Block, Edit Block and Delete Block 
Add Block, Edit Block and Delete Block  result in a block being added, or the selected 
block being either edited or deleted. See the sections on the Block Details dialog box and 
creating fixtures for more information. 

Copy Data, Paste Data and Copy Options 
Copy Data, Paste Data and Copy Options allow information to be copied from one block 
to another, or copied into a block being added. 

Copy Options 
Copy Options brings up a dialogue box allowing the data being copied to be filtered. 
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Only data that has been selected in the check boxes will be copied. 

Copying and Pasting Data 
To copy data from one block to another: 

1. Select the required data in the Copy Options dialog box. 

2. Highlight the block the information is to be copied from in the Block Definitions 
Grid. 

3. Select Copy Data from the Edit menu. 

4. Highlight the block the information is to be copied to in the Block Definitions Grid. 

5. Select Paste Data from the Edit menu. 

6. If data is going to be overwritten, a confirmatory warning will appear. 

 

Clear all Blocks 
Clear all Blocks removes all blocks from the list of blocks currently loaded into Fixture 
Studio. 

Filter Data 
Filter Data brings up the Filter Listed blocks dialogue box. 
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See the section on Filtering Listed Blocks for more information on how to use this dialog 
box. 

Edit Sizes 
Edit Sizes brings up the Edit Sizes dialogue box. This is used to configure the sizes for 
stretchable blocks. 

 
See the section on the Sizes tab  of the Block Details dialog box for more information. 

Categories 
Edit Categories bring up the Edit Categories dialog box. This is used to configure a list of 
Categories that can be assigned to fixtures on the Categories tab of the Block Details 
dialog box. Categories are often used as filters for reporting purposes. 
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For more information on Categories, see the information on the Category Tab of the 
Block Details dialog box. 

Attribute Variables 
Edit Attribute Variables brings up the dialog box used to configure the Attributes that 
can be assigned to fixtures in the Planner and Merchandiser Modules, and in In-Store 
Space Collaboration. 

 
For more information on Attribute Variables, see the information on the UDA Tab of the 
Block Details dialog box. 

View Menu 
The View Menu has varying options concerned with filtering and viewing blocks. 
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Filter Listed Blocks 
Filter Listed Blocks brings up the Block Filter. This can be used to select specific classes 
of blocks. 

 
Check the required options and click OK. The list of blocks in the Block Definitions 
Gird will be filtered to match the selection. 

Options 
Options brings up the Options dialogue box. This can be used to set some options 
determining how Fixture Studio Functions  
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Option Description 

Show Tooltips This option enables tool tips. 

Show Warnings This option enables warnings. 

Automatically read 
blocks on start 

This option loads the block information into Fixture Studio when the module 
is started. If this option is not checked, the blocks have to be manually read in 
using the Read Blocks option on the File menu. 

Set OSnaps for 
picking 

This option turns on OSnaps in the Planner module if they are off and if the 
Pick button is used in the Size tab of the Block Details dialog box. 

Only pick 1 point for 
heights 

This option assumes the base of the block is at zero elevation, allowing only 
the top of the block to be selected if Pick button is used in the Size tab of the 
Block Details dialog box. 

Note: 'Set OSnaps for Picking' and 'Only pick 1 point for 
heights' are not currently functional. 

Other Options 

Option Description 

Block 
Browser This option shows or hides the Block Browser (Object Browser) 

Preview 
This option shows or hides the Preview Window in the Block Browser (Object 
Browser) 

Group By 
This option allows data to bin the block Definitions Grid to be grouped by selected 
criteria. 

Window Menu 
The Window Menu has two groups of options. 
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The first set of options arranges the active windows within Fixture Studio. 

Cascade arranges them so they are stacked sequentially across the diagonal of the screen . 

 
Tile Horizontal arranges then so they all share the available space horizontally. 

 
Tile Vertical arranges then so they all share the available space vertically. 

 
The second set of options allows switching between those windows. Clicking on either 
Gondola Definitions or Block Definitions will cause that window to become active 
within Fixture Studio. 
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Help Menu 
The Help Menu has two options. 

 
Clicking Fixture Studio Help (or pressing the F1 function key) will call this help module. 

Clicking About Fixture Studio will bring up a dialogue box with information on the 
version of Fixture Studio the user has. 
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2 
Reading, Saving and Deleting Information 

Reading Blocks 

Automatically Reading Blocks on Start-up 
Users have the option of whether Fixture Studio automatically reads in block details on 
starting. This is controlled by the Automatically read blocks on start option in the 
Options dialog box accessed from the View menu. 

 

Note: If the option is not selected, blocks must be manually 
read in by selecting the Read Blocks option from the View 
menu or toolbar. 

Automatically reading in blocks on start up only reads in information from the database. 
At this stage Fixture Studio in not connected to Planner (File menu) therefore no 
information can be read in from that source. 

Gondola Information on Start-up 
Once the information is loaded into local memory, all changes and edits are saved into 
that local memory. The updated information is only written back to the database when 
the Save Blocks option is selected from the file menu. 

Note: Gondola information is read into Fixture Studio on 
start-up. Again, it is held in local memory and is only 
written back to the central Macro Space Planning database 
when the Save Gondolas option is invoked from the file 
menu. 

Manually Reading Blocks 
Blocks are read from the database, from the drawing or both. The Read Block option can 
be invoked from the File menu or toolbar. To have the option of reading in blocks from 
the drawing (or merging results) the Connect to AutoCAD option must also have been 
selected on the File menu. 
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Read 
Blocks 

On selecting Read Blocks, the Read Block Definitions dialog box will appear. This has 
three options: 

Option  Description 

Database Read in information from the database only 

Drawing 
Read in information from the Planner drawing Fixture Studio is connected to.  This 
option will only be available if the Connect to Planner option has been selected on the 
File menu. 

Merge 
Read in information from the database, plus any blocks in the Planner drawing 
Fixture Studio is connected to that are not currently in the database.  This option will 
only be available if the Connect to Planner option has been selected on the File menu. 

 These are described in more detail below. 

Read Blocks Option 
On selecting this option the user has two check boxes: 'Clear existing Block definitions' 
and 'Overwrite Existing Block definitions. 
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1. Clear existing Block definitions 

If checked, this option deletes all information currently held in local memory and 
refreshes it with  that held in the central Macro Space Planning database. 

2. Overwrite existing Block definitions 

This check box is only available if the 'clear existing Block definition' check box is not 
selected. On selecting 'Overwrite existing Block definitions', the Apply Data filters 
check box also becomes available. If checked, the button to the right can be used to 
bring up the Copy Options dialog box. Options checked within this dialog box will 
result in data from the central Macro Space Planning database overwriting what is 
held in local memory when the OK button is clicked in the Read Block Definitions 
dialog box. 

Note: If neither check box is checked, data held in local 
memory will be overwritten without any filtering. 

Drawing Option 

Note: The usual purpose of reading in from the drawing is 
during implementation to bring in blocks from raw 
AutoCAD. It is normally used by expert users. 

This option is only available if the Connect to AutoCAD option has been selected from 
the File menu. On selecting the Drawing option the user has two check boxes: 'Clear 
existing Block definitions' and 'Overwrite Existing Block definitions. 
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1. Clear existing Block definitions 

If checked, this option deletes all information currently held in local memory and 
refreshes it with  a list of the blocks in the drawing. 

2. Overwrite existing Block definitions 

This check box is only available if the 'clear existing Block definition' check box is not 
selected. On selecting 'Overwrite existing Block definitions', the Apply Data filters 
check box also becomes available. If checked, the button to the right can be used to 
bring up the Copy Options dialog box. Options checked within this dialog box will 
result information read from the list of blocks in the drawing overwriting what is 
held in local memory when the OK button is clicked in the Read Block Definitions 
dialog box. 

Merge Option 
The merge option is a combination of reading from the database and reading from the 
drawing. It is only available if the Connect to AutoCAD option has been selected from 
the File menu. 

 
If Merge is selected, the blocks in the currently selected drawing will be compared to 
those held in local memory. Data from any blocks in the drawing but not in the database 
will be read into local memory. If blocks in the drawing are also in local memory and 
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they contain information different to local memory, some of this information (typically 
size data, block description [not block name] and connection point information) will be 
read into Fixture Studio and overwrite the information in local memory. 

Note: The Load Blocks into Drawing is not currently 
functional. 

Saving Blocks 
Information on blocks is held within the central Macro Space Planning database. When 
Fixture Studio is started, the information is loaded into local memory. When data has 
been added, changed, or deleted, that data needs to be written back to the central Macro 
Space Planning database to be made permanent. This is done by selecting the Save 
Blocks option on the File menu. 

Note: Gondola information is read into Fixture Studio on 
start-up. Again, it is held in local memory and is only 
written back to the central Macro Space Planning database 
when the Save Gondolas option is invoked from the file 
menu. 

Block information can be saved to the database, to the drawing or both. The options are 
invoked from the File menu or from the toolbar. To have the option of saving block 
information to the currently active drawing (and DWG file for the block held in the 
directory specified in the configuration module) the Connect to AutoCAD option must 
also have been selected. 

 
 

 

Save Blocks 

Concepts for Saving Blocks 
Before saving any blocks, it is helpful to understand how the process works. There are 
two cases: connected to Planner and no connected to planner.  
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Not Connected To Planner 
If Fixture Studio is not connected to Planner (option on File menu) then Fixture Studio 
can only save information back to the Macro Space Planning database. This would 
typically be used to write MSP specific information in local memory back to the database. 
Examples would include fixture attribute information, changes to merchandisable areas 
and so on. 

 

Connected to Planner 
If Fixture Studio is connected to Planner (option on File menu) then Fixture Studio can 
save information back to the Macro Space Planning database as well as the block in the 
currently active drawing and the DWG file in the directory specified in the Directories 
tab of the Configuration module. 
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On clicking OK in the Save Block Definitions dialog box, the following actions take place. 

1. The information held in local memory is permanently written to the database. 

2. XData (MSM specific data) is written to the instance of the block in the currently 
active drawing. (An instance of every block being saved must be in the currently 
active drawing). 

3. A copy of the block in the currently active drawing is written to the directory 
specified in the Category tab of the block Details dialog box. 

Note: If Fixture Studio is not connected to Planner, the 
fixture in the active drawing will not have its XData 
updated, nor will a copy of the block be written to the 
directory specified in the Category tab of the block Details 
dialog box. 
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Save Blocks - Not Connected to Planner Drawing 

 
If Fixture Studio is not connected to the Planner drawing, the options to write to the 
drawing and write block files will be grayed out and unavailable. It will only be possible 
to save the current version of the local data held in Fixture Studio to the database. The 
available options are: 

Option  Description 

Add New 
Definitions 

This option writes back all new block definitions in the locally stored data that 
are not presently held that in the database. 

Enforce Save 
This option will write back information from any blocks that have been 
changed but not selected for saving if the 'Only Save Selected Blocks' option 
has been selected. 

Only Save Selected 
Blocks 

This option will only save blocks that have been highlighted. It allows a subset 
of data to be saved back; not the entire contents of Fixture Studio. 

Update Database 
with Drawing This option is not currently functional.  
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Save Blocks - Connected to Planner Drawing 

 
If Fixture Studio is connected to the Planner drawing, the options to write to the drawing 
and write block files will be available.  This means date will be written to the database. In 
addition, XData can be written to the blocks in the drawing Fixture Studio is currently 
connected to and DWG files for the blocks being saved will be written to the Windows 
folder specified in the Directories tab of the Configuration module. 

Note: More information on this is in the section on fixture 
creation. 

Option  Description 

Add New 
Definitions 

This option writes back all new block definitions in the locally stored data that 
are not presently held that in the database. 

Enforce Save 
This option will write back information from any blocks that have been 
changed but not selected for saving if the 'Only Save Selected Blocks' option 
has been selected. 

Save Dumb Blocks Save blocks without any MSM information assigned. 

Only Save Selected 
Blocks 

This option will only save blocks that have been highlighted. It allows a subset 
of data to be saved back; not the entire contents of Fixture Studio. 

Write Block Files 
Write XData to the blocks in the current drawing and write a copy of the 
associated DWG files to the Windows folder specified in the Directories tab of 
the Configuration module. 

Update Database 
with Drawing 

This option is not currently functional. 

Note: The block written to the specified directory is the 
'definition' block. Instances of this block are then placed in 
floor plans - it is the 'template'  for all blocks being placed by 
store planners. 
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Deleting Blocks 
Deleting blocks from Fixture Studio takes place in multiple stages. 

1. Mark block for deletion within Fixture Studio. 

2. Save deletion information back to the database. 

3. Purge the block information from the database. 

Marking blocks for deletion within Fixture Studio 
Blocks are marked for deletion in Fixture Studio by highlighting the block then using the 
Delete option on the right click menu. 

 
A confirmation dialog box will appear.  Click OK to confirm the deletion. 

 
The block name will then be grayed out in the Fixture hierarchy and the icon will turn 
black in the Block details list. 

 

Save deletion information back to the database 
At present the block has a delete flag set against it in the information held locally within 
Fixture Studio. The next stage is to write that information back to the central Macro Space 
Planning database so the delete flag is set there as well. This is done by highlighting the 
entry in the Fixture Hierarchy and then using the Save Block Definitions dialog box from 
the File menu. 
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The Destination should be set to Database and the Enforce Save/Only Save Selected 
blocks options check. On clicking OK, the delete flag will be written to the database. 

Permanently Deleting the blocks in the Administration Module 
The blocks can be permanently deleted from the database by selecting the Purge option 
from the Tools menu in the Administration module. 

 
A dialog box will appear with the results.  



Deleting Blocks 

24 Oracle Retail Macro Space Management 

 
This will list the block successfully deleted and the blocks which cannot be deleted. 
Typical reasons preventing blocks from being deleted include: 

 Fixtures present in floor plan (blocks cannot be deleted from the database if instances 
still exist in other tables in the database). 

 Fixture information may be present in other tables in the database, causing 
referential integrity problems. 
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3 
AutoCAD Operations from Fixture Studio 

Connecting to AutoCAD 
Before the AutoCAD functionality can be used from within Fixture Studio, users must 
first connect to the Planner module. Until this is done, the AutoCAD options on the file 
menu will remain grayed out and unavailable. 

 
The Connect to AutoCAD option on the File Pull down Menu must be selected. If the 
AutoCAD environment is not open, AutoCAD will be activated. If i t is open, Fixture 
Studio will link to AutoCAD. When fixture Studio has connected to Planner, the 
AutoCAD based options will change from being grayed out to available and the Connect 
to AutoCAD option will have a tick by it. 
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Load Blocks into Drawing 
The Load Blocks into Drawing command is used to take copies of the DWG files from 
the Macro Space Planning directories currently specified in Fixture Studio and transfer 
them to the currently active drawing in AutoCAD 

Note: The Connect to AutoCAD option must be selected on 
the File menu. 

There are three stages to this. 

1. Select the required blocks in Fixture Studio 

2. Select the Load Blocks into Drawing option 

3. Select the Insert option in AutoCAD 

Selecting the Required Blocks in Fixture Studio 
Selecting the requited blocks can be done in two ways in Fixture Studio; from the 
hierarchical tree, or from the Block Definitions window. They can be selected from the 
hierarchical tree by left clicking on an individual block, or by holding down <Ctrl> and 
left clicking to make multiple selections. They can be selected from the Block Definitions 
window by left clicking on an individual block or by holding down <Ctrl> or <Shift> and 
left clicking to make multiple selections. 

 



 Load Blocks into Drawing 

 AutoCAD Operations from Fixture Studio 27 

 

Using the Load Blocks into Drawing option 
Using the Load Blocks into Drawing will load the block definitions into the AutoCAD 
drawing. They will be loaded to the AutoCAD database associated with drawing and 
will not become visible until  the insert command is used to put instances into the visible 
part of the drawing. 

 

Using the Insert Option 
The Insert option can be invoked by typing INSERT into the command line. 

 
This will bring up the Insert dialogue box. 
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Block definitions can be selected using the Name drop down list. After specifying the 
Insertion Point, Scale, Rotation Angle and whether or not the components of the block 
are to be exploded, clicking on OK will place an instance of the block definition in the 
drawing. 

Note: See the AutoCAD help files for full information on the 
Insert Options. 

Load Blocks from Disc 
Load Blocks from Disc  enables the user to select blocks from a source outside of the 
Macro Space Management database and load them into the currently active AutoCAD 
drawing. (This is in contrast to the Load Blocks into Drawing option which selects copies 
of the DWG files from the Macro Space Planning directories currently specified in Fixture 
Studio). 

There are two stages to this. 

1. Select the Load Blocks from Disk option 

2. Select the Insert option in AutoCAD 

Using the Load Blocks from Disc Option 
Using the Load Blocks from Disc option will transfer the block definitions into the 
AutoCAD drawing. They will not become visible until instances have been placed in the 
drawing. 

Note: The Connect to AutoCAD option must be selected on 
the File menu. 
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This will bring up Select blocks to Load dialogue box. Navigate to the required directory 
and highlight the required blocks. Click on Open to transfer the block definitions to the 
active AutoCAD drawing. They will not become visible until the insert command is used 
to put instances into the visible part of the drawing. 

 

Using the Insert Option in AutoCAD 
When the block definitions have been transferred into the drawing, they are stored as 
information only. In order for an instance of the block to be visible  in the drawing, it has 
to be inserted by typing Insert into the command line. 

 
This will bring up the Insert dialogue box. 
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Block definitions can be selected using the Name drop down list. After specifying the 
Insertion Point, Scale, Rotation Angle and whether or not the components of the block 
are to be exploded, clicking on OK will place an instance of the block definition in the 
drawing. 

Note: See the AutoCAD help files for full information on the 
Insert Options. 

Laying Out Blocks 
The Laying out Blocks  option is similar to the Load Blocks into Drawing option, except 
that it bypasses the AutoCAD Insert command and lays out the selected blocks in a grid 
pattern in the currently active drawing in the AutoCAD environment. 

Note: The Connect to AutoCAD option must be selected on 
the File menu. 

There are two stages to this. 

 Select the required blocks in Fixture Studio 

 Select the Layout Blocks in Drawing option 

Select the Required Blocks in Fixture Studio 
Selecting the requited blocks can be done in two ways in Fixture Studio; from the 
hierarchical tree, or from the Block Definitions window. They can be selected from the 
hierarchical tree by left clicking on an individual block, or by holding down <Ctrl> and 
left clicking to make multiple selections. They can be selected from the Block Definitions 
window by left clicking on an individual block or by holding down <Ctrl> or <Shift> and 
left clicking to make multiple selections. 
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Select the Laying Out Blocks Option 
Click on the Layout Blocks in Drawing option in the File pull down menu. 

 
This will bring up the Layout Options dialogue box. 
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The spacing between blocks can be specified by the X, Y and Z spacing. Ticking the 
appropriate check boxes will add the block name and/or description to each block when 
it is drawn the active drawing. Ticking the Clear Drawing check box will clear all 
previous blocks from the drawing. 

Note: The Z spacing is generally left at 0 so that the blocks 
draw at floor level. 

Normalize Blocks 

Overview of Normalizing Blocks 
The Normalize Blocks  command is used to modify the AutoCAD properties of blocks 
selected in Fixture Studio. A copy of these blocks must be present in the AutoCAD 
drawing Fixture Studio is currently connected to. The properties of those blocks can them 
be modified by means of the Normalize Blocks command. The effect of this is local and 
the Fixture Studio Save Blocks command must be used to write the changes back to the 
DWG files reference by AutoCAD and Planner. In addition, any blocks that have been 
modified that are already placed in a floor plan will not be updated. For that a further 
operation is required. This can be done in several ways. Two of the most common are: 

 Manually invoke the Restructure Drawing option from the Modify menu in Planner. 

 Use the Restructure Drawing options during batch publishing of floor plans. 

Reasons for using Normalize Blocks 
Normalize blocks is the equivalent of the AutoCAD Object Properties dialog box, but can 
be used to perform bulk operations. This is particularly useful when working with blocks 
that have been created outside of Macro Space Planning as they may require their 
properties changed to work within the application. 

 For KPIs to work within Planner, the blocks color must be set to 'By Block'  

 For the 'thicken' form of highlighting to work within Planner, the line weight must be 
set to 'By Block'. 

Preparing to use the Normalize Blocks Functionality  
Normalize Blocks operates on any instances of the blocks that are present in the drawing 
Fixture Studio is currently connected to. Before using the Normalize blocks function, the 
user should ensure that a copy of each required block is present in the drawing. One way 
of doing this is to use the Load Blocks into Drawing option from the file menu.  
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Using the Normalize Blocks Functionality 
The Normalize Blocks dialog box is accessed from the File pull down menu. 

 

Note: The Connect to AutoCAD option must be selected on 
the File menu. 

The Normalize Blocks dialogue box enables any currently selected blocks to have their 
AutoCAD Layer, Color, Line Type and Line Weight changed. 

 

Layer 
 If set to Ignore, layers will be unchanged. 

 If set to Ignore 2D/3D layers they will not be affected by any changes to other layers  

 If set to Reset to 0, all selected blocks will have their parent layer set to the default of 
0. 

Color 
 If set to Ignore, line weights will be unchanged. 

 If set to By Layer, then the selected blocks will adopt the default color for the layer 
they are inserted on. 

 If set to By Block, the selected blocks will adopt the default color for the layer they 
inserted are on except where the Planner functionality changes the color to a 
alternative one - for example for a KPI. 
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 If set to Custom, then the modified color for the selected blocks can be set by means 
of the spin control. These blocks will not then adopt the parent color of the layer they 
are inserted on; nor can their color be changed to display KPIs.   

Note: Color should normally be set to By Block. This enables 
blocks to have their colors changed in Planner when KPIs 
are applied. 

Line type 
 If set to Ignore, line types will be unchanged. 

 If set by ByLayer, the selected blocks will adopt the default line type for the layer 
they inserted are on. 

 If set to ByBlock the selected blocks will adopt the default liner type for the layer they 
inserted are on except where the Planner functionality changes it to an alternative 
one. 

 If set to Custom, then the line type for the selected blocks can be set by means of the 
drop down list. 

Line Weight 
 If set to Ignore, line weights will be unchanged. 

 If set By Layer, the selected blocks will adopt the default weight type for the layer 
they inserted are on. 

 If set ByBlock, he selected blocks will adopt the default line type for the layer they 
inserted are on except where the Planner functionality changes it to an alternative 
one. 

 If set to a Custom level all selected blocks will be set to the line weight selected from 
the drop down list. These blocks will not then adopt the parent line weight of the 
layer they are inserted on; nor can their line weight be changed by the Planner 
functionality.   

Note: Line weight should normally be set to By Block. This 
enables blocks to have the thicknesses of their lines changes 
for highlighting purposes in Planner. 

Saving the Changed Blocks 
Normalize Blocks modifies the block definitions in the drawing. It is still necessary to 
save those changed block definitions back to the directories holding the DWG files. This 
can be done using the Save Blocks option from the File menu. Full details on how to use 
this dialog box can be found in the section on Reading, Saving and Deleting information. 
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 The following settings should be used: 

 Destination should be set to both Database and Drawing. 

 Options should be Enforce Save, Only Save Selected Blocks and Write Block Files. 

 If there are new blocks in the drawing the Add New Definitions check box should be 
selected as well. 

Updating Floor Plans 
Any older instances of the block that are present in existing floor plans will have the old 
settings. These can be updated in one of two ways:  

 Manually invoke the Restructure Drawing option from the Modify menu in Planner. 

 Use the Restructure Drawing options during batch publishing of floor plans. 

Manually using Restructure Drawing in Planner 
Restructure Drawing can be called from the Modify Menu (Modify > Blocks > 
Restructure Drawing). This will bring up the Restructure Drawing dialog box. 
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Selecting all blocks then invoking the Redefine Blocks from Disc option will update the 
block definition in that specific floor plan.  

Note: See the Oracle Retail Macro Space Management Planner 
User Guide for full information on how to use Restructure 
Drawing. 

Using Restructure Drawing in a Batch Process 
An alternative way of ensuring floor plans are updated with the latest definitions is to do 
it via a batch process. This is set up using the Configure Floor Plan Publishing option 
from the File menu. The Pre-processing tab has an option to Redefine Blocks from Disk. If 
this is selected, any batch publishing of floor plans will result in the block definitions in 
the floor plan being updated. 
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Note: See the Oracle Retail Macro Space Management 
Administration Module User Guide for full information on how 
to use this functionality. 

Create 3DS Files 

About 3DS Files 
DWG files are used in the Planner module. A different sort of file (3DS file) is used to 
represent equipment and merchandise in the Merchandiser module. They are also used 
to display the block in the Preview tab of the Block Details dialog box. 
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An error message will be displayed if the required 3DS files are not found in the 
Merchandiser Module or in the Preview tab of the Block Details dialog box. 

Creating 3DS Files 
3DS files are created using the DWG file as a template. 

Note: The Connect to AutoCAD option must be selected on 
the File menu. 

There are two stages to this. 

1. Select the required blocks in Fixture Studio 

2. Select the Crease 3DS Files option 

Select the Required Blocks in F ixture Studio  
Selecting the requited blocks can be done in two ways in Fixture Studio; from the 
hierarchical tree, or from the Block Definitions window. They can be selected from the 
hierarchical tree by left clicking on an individual block, or by holding down <Ctrl> and 
left clicking to make multiple selections. They can be selected from the Block Definitions 
window by left clicking on an individual block or by holding down <Ctrl> or <Shift> and 
left clicking to make multiple selections. 
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Select the Create 3DS Option 
Click on the Create 3DS Files option in the File pull down menu. 

 
The required 3DS files will then be created in the same directory (specified in the 
Directories tab of the Configuration module)  as the original DWG files. A confirmatory 
dialog box will appear. 
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Note: 3DS files are also used in the Preview Tab of the Block 
details dialog box. If they are absent a 'graphics not found' 
message will result. 

Redefine Blocks from Disc 
Redefine Blocks from Disc allows the user to overwrite any blocks in the current 
selected floor plan in Planner with the latest versions specified in Fixture Studio. 

Note: The Connect to AutoCAD option must be selected on 
the File menu. 

It is accessed from the File pull down menu and is only active when Fixture Studio is 
connected to AutoCAD. 

 
On selecting the command, Fixture Studio will identify all blocks in the drawing 
referenced by the Connect to AutoCAD option and replace them with the blocks 
currently referenced in Fixture Studio. A confirmatory dialog box will appear. 
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Note: this task can also be carried out using the Restructure 
Drawing option in the Planner module. 
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4 
Navigating Block Definitions 

Setting Columns 
The columns that display in the Block Definitions window can be configured by clicking 
on the Set Columns in Grid Icon in the toolbar. 

Note: The columns displayed in the Gondola Definitions 
window cannot be configured. 

 
This will bring up the Columns dialogue box. 

 
The Columns frame on the left contains a list of the columns that are currently displayed. 
The Available Frame on the right contains a list of columns that are not being currently 
displayed. The list of columns to be displayed can be modified by making use of the 
selection arrow in the middle of the dialogue box. When the selection has been made, 
clicking on OK will result in the Block Definition table being rearranged accordingly. 
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Grouping Operations - Edit Menu 
The Group By option on the View Pull Down Menu allows blocks with  a common 
criterion to be grouped together, then the list expanded or collapsed. 

 
Show Group By (<Ctrl> + G) brings up a box above the table of blocks descriptions 
titled ‘Drag a column header here to group by that column’. 
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When this is done the list of blocks is sorted into groups specified by the header dragged 
into the box. 

 
Clicking on the dragged column header will change the direction the data is sorted. The 
grouped data can be expanded or collapsed using the options on the View pull down 
menu. A collapsed view is as below. 
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Any individual section of grouped blocks can be expanded or collapsed by clicking on 
the ‘+’ or ‘-’ signs to the left of the section. 

Filtering Blocks 
The list of blocks showing in the Block Details dialogue box may be filtered using the 
filtering option on the toolbar (or from the Edit menu). 

 
This will bring up the Filter Listed Blocks dialog box. 

 
Filtering by name uses implied wild cards, although ‘*’ and ‘?’ are also allowed. 
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Search String Result 

Leg All examples of blocks containing Leg 

I_BR_T-Leg_1x48x72 Find that exact file name 

I_BR_T-Leg_1* Find all examples of blocks beginning I_BR_T-Leg_1 

 
To show all blocks again, clear the text box and press Return. 

Filtering by Block Status 
The Block Status can be seen to the left of the Block Definitions Window. 

 
By using the Block Status frame it is possible to select blocks meeting specific stages of 
being registered in Fixture Studio. 

Icon Description Comments 

 

Show Valid 
Blocks 

These are blocks that have just been updated by having the XData 
written to the blocks stored in the directory specified in the Categories 
tab of the Block Details dialog box. 

 

Show New 
Blocks 

These are blocks just imported into fixture studio. 

 

Show 
Changed 
Blocks 

These are blocks where the data has been changed in Fixture Studio 
but not yet written back to the database. 

 

Show 
Database 
Blocks 

These are blocks where the information in Fixture studio matches that 
held in the database. 

 

Show 
Drawing 
Blocks 

These are blocks in the drawing containing XData, but where that 
information has not yet been written back to the database. This is 
achieved by assigning data in the Block Details dialog box and then 
writing that data back to the drawing, but not the database. 

 

Show Dumb 
Blocks 

These are blocks where no Macro Space Planning information has 
been assigned: they are pure AutoCAD blocks. 
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Filtering by Block Type 
By using the Block Type Frame, the blocks displayed in the Block Definitions window 
can be restricted to those of specific types. 

 
These types are set in the Retail Type drop down list in the Category Tab of the block 
Details dialog box. 

 

Find Block Definitions 
Clicking on the Find Icon  on the toolbar will bring up the Find Block dialogue box. 
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To use the Find Option, type in the required search string into the Find box and press 
Return . A list of block definitions matching the search string will appear in the box 
below. To display a block definition in the hierarchical tree in the Object Browser, 
highlight it in the list of block definitions and click on the OK button. The block 
definition in the Object Browser will be highlighted and the Find Block dialogue box will 
close. 

Note: The search string will not allow wild cards such as ‘?’ 
and ‘*’. The search string will match any block description 
with a comparable string in the ID, Name or Description 
fields. In the above example the search string rack has 
matched instances of the name Leg. 
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5 
Relationships with Other Modules 

Overview of Relationships to other Modules 
The settings made within Fixture Studio are affected by and interact with settings made 
within other modules within Macro Space Management 

 

Administration Module 
The following can be configured within the Admin Module: 

 List of Manufacturers. 

 List of Ranges. 

 Available status’s 

 List of possible Styles  

 List of default units 

 User Defined Attributes  

Configuration Module 
The following can be configured within the Configuration Module: 

 Directory for graphics (dwg and 3DS) files  

Layers 
 List of aliased layers a block can be inserted on, and which connections are valid on. 

These can only be configured within Planner. 
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Levels 
 List of available levels to insert an block on – only configurable within database 

Product Studio 
 List of available materials – this affects the appearance of the graphics. 
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6 
The Admin Module 

Access to the Administration Module 
Access to the Administration module is controlled by the Functional Security dialog box 
accessed from the Security Menu.  

 
Access to this module is strictly controlled as Administrators control access rights and 
privileges for users within Macro Space Planning. They also control the global settings 
which affect the behavior of the application for all users. The examples in this section 
show where data in Fixture Studio is configured. Most users will not actually be able to 
access the module - the information in this section is to allow users to see how data is 
configured, 

Configuring the List of Manufacturers 
The List of Manufacturers is used in the General Frame of the Categories tab in Block 
Definitions. 
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The List of Manufacturers can be configured using the Manufacturers option on the 
General menu in the Administration Module.  

 
This brings up the Manufacturers dialogue box. 

 
This enables a list of manufacturers to be built up and edited. This list is then used in 
both the Fixture Studio and Product Studio modules. The manufacturers assigned to 
fixtures and products are primarily used for reporting purposes. 

Configuring the List of Ranges 
The List of Ranges is used in the General Frame of the Categories tab in the Block 
Definitions dialog box. 
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The List of Ranges can be configured using the Ranges option on the Merchandising 
menu in the Administration Module. 

 
This brings up the Ranges and Range Groups dialogue box. 

 
Temperature ranges can be assigned to both equipment and merchandise to ensure that 
only products and planograms are only placed on compatible equipment. 
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Configuring the Available Status's 
The List of Statuses is used in the General Frame of the Categories tab in Block 
Definitions. 

 
The List of Statuses can be configured using the Status option on the General menu in the 
Administration Module. 

 
This brings up the Status dialogue box. 
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The Statuses available for blocks can be added, edited and deleted. Their order can also 
be configured. Changes can be defined as reversible or irreversible and files can be set to 
read only sta tus when that status is reached. Finally, statuses can be set to be selectable or 
not selectable. Selectable statuses can be selected manually. Non-selectable statuses 
change automatically when other actions are carried out. 

Configuring the List of Styles 
The List of Styles is used in the Available Styles Frame of the Styles/Ranges tab in Block 
Definitions. 



Configuring the List of Styles 

58 Oracle Retail Macro Space Management 

 

The List of Styles can be configured using the Styles option on the Merchandising menu 
in the Administration Module. 

 
This brings up the Styles dialogue box. 
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Styles can be added, edited and deleted in the Styles tab. The relationships between the 
varying types of styles can be defined in the Style Relationships Tab. The Test Tab allows 
users to conform the requisite Style Relationships have been defined. Styles can then be 
used (for example) to ensure than only compatible shelves are put onto fixtures in 
Merchandiser or that only compatible planograms are put onto equipment in the Planner 
and Merchandiser modules and in  In--Store Space Collaboration. 

Configuring the Default Units 
The List of Units  is used in the General Frame of the Categories tab in Block Definitions. 

 

The List of Units can be configured using the Units option on the General Pull down 
menu in the Administration Module. 
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This brings up the Units Admin Tool dialogue box. 

 

This allows units to be added, edited or deleted. It also allows other settings to be 
specified; for example whether use of that unit is mandatory. 

Configuring Fixed User Defined Attributes 
The List of Fixed User Defined Attributes is used in the UDAs tab in the Block 
Definitions dialog box. 
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UDAs are of two types: 

UDA 
Type Description 

Fixed 
UDA 

This is definition data - one set of data will apply to all fixtures of that type. Fixed UDAs 
are configured in the Administration Module. 

Variable 
UDA 

This is instance data - different values can be assigned to each example of that fixture 
placed in a floor plan. Variable UDAs are configured using the Edit Attribute 
Definitions option from the Edit menu in Fixture Studio. 

The list of fixed User Defined Attributes (UDA’s) can be configured using the User 
Defined Attribute option on the Edit menu in the Administration Module. 
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This brings up the User Defined Attributes dialogue box. This allows User Defined 
attributes to be added, edited and deleted. Fixed UDAs for fixtures are configured using 
the Block option.  
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7 
The Configuration Module 

Configuring Directories 
The Directory used to store DWG and 3DS files is specified in the Categories tab in the 
Block Definitions dialog box. 

 
This determines the directory where Macro Space Management looks for the graphics 
associated with the corresponding block definitions. The Directories Tab can be accessed 
when the Configuration Module is accessed from the Administration module. Directory 
paths can then be set. 
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Setting up the Required Directories 
Setting up the required directories is done in two stages: 

Create the required directories using Windows Explorer 
Using Windows Explorer, navigate to where the Macro Space Management data files are 
held. Create the required directories. 

 

Note: These directories must be on a server in order to be 
accessible to all users. 

Set up the required links in the Configuration Module 
Links to the directories in the Windows file structure are set up in the Directories tab of 
the Configuration module. This can only be accessed from the Administration Module. 
 Once in the Directories tab, paths to the windows folders can be set up using the Add 
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Directory option. This writes the paths back to the Macro Space Planning database, 
making the windows folders accessible to all Fixture Studio users. 
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8 
Layers 

Configuring Layers 
The List of Layers is used in the Layers frame of the Insertion tab in Block Definitions. 

 

The List of Layer Aliases can be configured using the Layer Aliases option on the Format 
pull down menu in the Planner module. 

 
This brings up the Layers and aliases dialogue box. 
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This can be used to configure Layers and Layer Aliases. 
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9 
Levels 

Configuring Levels 
The List of Levels  is used in the Insertion tab in Block Definitions. 

 
The list of levels is configured directly in the Macro Space Planning database. If 
additional levels are required, this must be done by an administrator with access rights to 
the database. See the Oracle Retail Macro Space Planning Data Model for details of the 
pertinent table. 
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10 
Product Studio 

Configuring the List of Materials 
The list of Materials is used in the Category tab in Block Definitions. The Material is used 
to color the item of equipment in the Merchandiser module, while the Print Material 
governs the color the fixture or fitting will be displayed in when a floor plan is published. 

 

The List of Materials can be configured using the Materials option on the View menu of 
Product Studio. 

 
This brings up the Materials dialogue box. 
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This can be used to add edit and delete options determining the surface appearance of 
graphics blocks inserted into the Merchandiser environment. It has no effect on how 
graphics display in the Planner environment. 
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11 
Fixture Creation 

Adding, Editing and Deleting Fixture Groups 
Groups are used to arrange fixture and gondola definitions into logical sub-sets. The 
resulting hierarchy is used in Fixture Studio for maintaining information on the 
equipment used in Macro Space Planning. The hierarchy also appears in the Object 
Browser in the Planner and Merchandiser modules and in In-Store Space Collaboration. 
These groups are a way of arranging large numbers of fixtures into sub-sets sharing a 
common characteristic. For example, one group could hold all fittings and fixtures used 
for clothing, another all those used for chilled or frozen foods.  

 
 Groups can be Added, Edited and Deleted using the options on the toolbar. (They may 
also be added using the options on the right click menu). 

 

Icon Option 

 

Add Group 

 

Edit Group 

 

Delete Group 

Adding a Group 
To add a group, highlight the parent group to which it is going to be added. Click Add 
Group. The Group dialogue box will appear. 

 
Enter a description and select an icon from the drop down list. Click on OK to conform. 
The group to be added is a child of its selected parent group. 
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Edit Group 
To add a group, highlight the group which is to be edited. Click the Edit Group  Icon. The 
Group dialogue box will appear. 

 
Edit the description if requited. It is also possible to select an alternative icon from the 
drop down list. Click OK to conform. The Group details will now be updated. 

Delete Group 
To delete a group, highlight the group to be deleted. Click on the Delete Group Icon. If 
the Group to be deleted has child groups or block definitions, a warning dialogue will 
appear. 

 
If there are no child objects, the group will be deleted without any requirement for 
confirmation. 

Note: Information of Fixture Groups will not be written back 
to the database until the Save option is used from the File 
menu. Information on Gondola Groups will not be written 
back to the database until the Save Gondolas option is used 
from the File menu. 

Overview of AutoCAD Blocks 
Note: This section is intended for new users of AutoCAD - it 
can be skipped by experienced users. Some of the details 
have been simplified for purposes of explanation. 

New users often struggle to understand the concept of an AutoCAD block and how 
Macro Space Management interacts with it. This section of help explains the basic 
concepts of an AutoCAD Block. 
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The AutoCAD Drawing 

 
The AutoCAD drawing (floor plan) may be considered to be in two parts: 

1. Model space (or the drawing area) 
This is the part of the drawing that is visible to the user. It is where a fixture (or a 
store plan) is created. 

2. Database 

This part of drawing is not visible to the user. It contains reference information for 
each instance of a block drawn in the visible part. 

Blocks and their Purpose 
Blocks are a mini-drawing representing a single object that will be placed multiple times. 
Consider a checkout. Each store might contain ten checkouts. If there are three hundred 
stores in the chain, there will be total of three thousand checkouts. Drawing each 
checkout individually would be very labor consuming. Better to draw a single checkout 
and then store it in a form that can be repeatedly reinserted into other drawings. The 
form it is stored in is called a block. 

Blocks can exist in two forms; 

1. Locally within the drawing 

Once a block has been created within a drawing, it can be reused multiple times 
within that drawing. It cannot however be used outside of that drawing. 

2. As an External DWG file  

It is also possible to write the block to an external Windows folder in the form of a 
DWG file. This form of block can be used multiple times in any number of drawings. 

The process can be represented diagrammatically as follows: 

Note: This description refers to a process using AutoCAD 
functionality. 

 
 

1. The fixture is drawn in AutoCAD. 

2. The AutoCAD Block command is used to write local block into the database part of 
the drawing. 
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3. The AutoCAD Write Block (WBlock) command is used to write a copy of the block to 
a Windows folder 

4. Once in the Windows folder, the AutoCAD Insert command can be used to insert 
multiple copies of the block into other drawings. 

Naming Conventions 

Note: Naming conventions are important to the efficient 
operation of Macro Space Management. Lack of a naming 
convention will often make it more difficult to locate the 
required fixture blocks. Lack of a naming convention may 
also result in the creation of multiple gondolas that could 
have been defined more efficiently using a naming 
convention. 

A naming convention is a pre-thought out and logical way of assigning block names. If 
blocks are given names like Widget-187567 and Gizmo-ADRTYN, it is not obvious what 
the blocks are for, or what their dimensions are. With a well thought out naming 
convention, things are far simpler. 

 
In the above example, there are three types of block; Back Panels, L shaped uprights and 
T shaped uprights. It is apparent from the block names that the back panels have widths 
of 600 and 900 mm, and that they have heights of 1400, 1600, 2500 and 2900 mm. 
Similarly, i t is obvious that both the L and T shaped uprights come in four heights; 1400, 
1600, 2500 and 2900 mm. Widget-187567 might well be a back panel of width 600 mm 
and height 2500 mm, but the lack of naming convention means this cannot be deduced 
from the block name. 

Drawing the Fixture 
The beginning point for creating a fixture is to create a representative drawing within the 
AutoCAD environment. This would normally be created within a drawing used as a 
Fixture Library. 
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The drawing should be dimensionally accurate and showing the level of detail required 
for display in the Macro Space Management Planner and Merchandiser environments. 
The following points should be noted. 

1. Do not use unnecessary detail 

The drawing should be representative of the fixture, but drawing too great a level of 
detail is not recommended. This will increase the size of the eventual DWG file (and 
3DS file) that will result. Because a floor plan may contain some thousands of 
fixtures, an over elaborate fixture drawing (and resulting increased file size) will 
result in performance in the floor plan becoming slow. 

2. Ensure the insertion point is appropriately positioned 

It is useful to have a consistent position for the insertion points for the fixtures that 
are drawn. This makes it easier when configuring blocks in Fixture Studio. For 
example, all fixtures could be created with insertion points of bottom, back, left; 
while all pegs could be created with insertion points of middle, centre, back. Another 
point to consider when selecting insertion points is In-Store Space Collaboration. This 
application represents fixtures and fittings as rectangles based on the extents of the 
block. 

 
The checkout above (purple outline) is not rectangular in shape. The dotted outline 
indicates the rectangle that will represent the checkout in In-Store Space 
Collaboration. The insertion point for the fixture should be placed where the blue 
square is and set to bottom back left. If the insertion point is placed where the red 
square is, the rectangle representing the checkout will not be drawn in the correct 
position in ISSC. 

3. Ensure that the front direction of the fixture is correct 
Fixtures are assigned a front direction. This indicates the primary direction that a 
customer approaches to get merchandise. 
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By convention, this is normally 270 degrees (the equivalent of south). The fixture 
should be drawn so that, when converted into a block, it is in this orientation. 

4. Add in 2D/3D Functionality 

If 2D/3D functionality is required, the varying parts of the block must be configured 
accordingly. (See the section on how to create 2D/3D functionality for more 
information). 

5. Ensure the Color and Line Weight are set to 'By Block' 
The ability to change the color and line weights of individual blocks within a 
drawing (floor plan) is used by two specific items of Macro Space Management 
functionality. 

– KPI's depend on the ability to change the color of individual blocks  

It is possible to color code blocks in a Planner floor plan by specific performance 
criteria. In the example below, fixtures designated as promotional fixtures have 
had their outline changed to red, while standard fixtures have gray outlines. 

 
This functionality will only work if the color properties for the block are set to 
'By Block' in the AutoCAD Properties dialog box when the block is being 
configured. 



 Drawing the Fixture 

 Fixture Creation 79 

 
– The 'Thicken' form of Highlighting requires the line weight of the block to be 

changed. 

Highlighting options for blocks are set in the Fixturing tab of the Configuration 
module. One option is Thicken. If the Highlight in View option is selected on the 
Object Browser in Planner, fixtures selected in the Fixture Hierarchy will have 
their outlines thickened. 

 
This functionality will only work if the Line weight properties for the block are 
set to 'By Block' in the AutoCAD Properties dialog box when the block is being 
configured. 
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2D/3D Functionality 
2D/3D functionality allows users to toggle between an outline at floor level and a full 3D 
representation of a fixture in the Planner module. The function is accessed from the 
Planner module from either the Retail Layers toolbar or the View Menu. 

 

 
This is useful when publishing a store plan as it can be output with the fixtures in a 
simplified form with many of the construction lines omitted. The screen shot below 
shows the fixtures in both 3D (top) and 2D (bottom) form. 
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This can be achieved as follows: 

Note: If an existing block from a client is being modified, this 
will have to be exploded first and then re-blocked after the 
2D/3D modifications have been made. 

1. Create a drawing to be used as a Fixture Library 

2. In the drawing create two layers called 2D and 3D. (These precise names must be 
used as the MSM functionality references them). 

3. While on Layer 0, draw an outline representing the outline of the block at floor level. 

Note: The outline is only required if the fixture or fitting 
places directly on the floor. If the object is (for example) a 
shelf, then it only requires a 3D component so that it 
vanished from view when a floor plan is toggled to 2D. 

4. Using the properties dialog box: 

a. Set the Layer to 2D. 

b. Set the Color to ’By Block’ - this will ensure the block colors correctly for KPIs, 
etc. 

c. Set the Line Weight to ’By Block’ - this will ensure that the block thickens 
correctly if ’Thicken’ is a highlight option. 

5. While on Layer 0, draw a 3D representation of the block at floor level. 

6. Using the properties dialog box: 

a. Set the Layer to 3D. 

b. Set the Color to ’By Block’ - this will ensure the block colors correctly for KPIs, 
etc. 

c. Set the Line Weight to ’By Block’ - this will ensure that the block thickens 
correctly if ’Thicken’ is a highlight option. 

7. Use the Block command to turn the 2D and 3D components into a block. 

8. Test that the block toggles between 2D and 3D mode by turning the 2D and 3D layers 
off and on as required. 
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Note: Setting Color and Line Weight to By Block enables 
instances of that block placed in floor plans to have the color 
and line weight modified by the application. If the Color and 
Line Weight are set to By Layer, then instances of that block 
will adopt the defaults for that layer when placed and 
cannot be modified by the application. 

Information for AutoCAD Experts 
When converted onto a block later (on Layer 0), the block will contain internal layers 
called 2D and 3D. When the block is placed into floor plan in Macro Space Management, 
this will result in the creation of additional layers called 2D and 3D in that floor plan. 
When the 2D/3D functionality is used, the respective layers will be toggled on/off, 
leaving those parts of the block on either the 2D layer or 3D layer visible.   

Creating and Inserting AutoCAD Blocks 
Note: This section of help shows how to make, save and 
insert blocks using purely AutoCAD tools. It is intended for 
users new to AutoCAD so they can see the basic process 
involved. The procedure for registering blocks in Fixture 
studio is a little more complex and is discussed further on in 
this help material. 

The stages of creating a block are as follows: 

Required Stages for Block Creation 

Draw fixture 
The fixture is drawn using standard AutoCAD methods. It must be on Layer 0 of the 
drawing. 

 

Convert to a Block 
To convert to a block, type BLOCK into the command line and press Return. The Block 
Definition dialog box will appear. 
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1. Enter a unique name into the Name text box. 

2. Click Select Object and select the required fixture 

3. If the bottom back left corner of the fixture is at coordinates, 0,0,0, no further action is 
required. If the bottom back left corner of the fixture is not at 0,0,0 then the Pick Point 
button in the Base Point frame should be used to specify the bottom back left corner 
of the fixture. 

Note: the requirement to pick bottom back left is Macro 
Space Planning specific - it is not required in 'raw' 
AutoCAD. 

4. Set the correct units in the Settings Frame 

5. On clicking OK, the selected fixture will be saved as a block. 

The drawing of the fixture has now been converted into a block. This block may be 
inserted multiple times within the current drawing, but cannot yet be inserted in other 
drawings. 

Write to Windows Folder 
To take an existing block and write it to a Windows folder, Type WBlock (Write Block) 
into the command line and press Return. The Write Block dialog box will appear. 
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1. Click the Block Radio button 

2. Select the name of the required block from the drop down list. 

3. Select a destination to save the block. This can be done by clicking the button in the 
destination frame. 

4. Ensure the Insert Units are set correctly. 

5. On clicking OK, the block will be saved as a DWG file to the external windows 
folder. 

Inserting a Block 
To take an existing block and reinsert it in a drawing, type INSERT into the command 
line and press Return. The Insert dialog box will appear. 

 
1. Select the Name of the block from the drop down list. This will give a list of blocks 

currently inserted in the drawing. If the required block is not in the list, click the 
Browse button, navigate to the appropriate Windows folder and select the required 
DWG file. 
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2. If the Specify On-Screen check box is ticked, the block can be inserted at any point in 
the drawing. If it is un-ticked, it will be inserted at the specified coordinates. 

3. On clicking OK, the block will be inserted into the drawing. 

AutoCAD Blocks and Macro Space Management 
In order to ensure optimum performance within Macro Space Planning, blocks must be 
created and defined in a very specific sequence. Failure to follow all steps in this process 
may result in problems when using functionality within Macro Space Planning. 

 

Required Steps 

Create Block in the Planner Module 
The first stage of the process is to create an AutoCAD block in the Planner module. This 
block should be configured so it meets the requirements of Macro Space Planning. 

1. The insertion point should be in a systematic position - for example all fixtures can be 
created with insertion points at bottom back left, all shelves with insertion point at 
top back left.  

2. If 2D/3D functionality is required, the block should be drawn on 2D and 3D layers as 
required. 

3. Ensure the units are correct for the type of database the block will be used in: 
imperial or metric as required. 

4. Ensure the block is appropriately named - where possible use a naming convention 
as this will markedly help with the creation of gondolas. 

5. If possible, ensure the block is stored in a Fixture Library. 

Note: Insertion points, 2D/3D functionality and naming 
conventions are discussed in more detail elsewhere in this 
help file. 

Import the Block into Fixture Studio  
Importing the block from a Fixture Library into Fixture Studio is good practice. This is 
done as follows: 

1. Ensure both Planner and Fixture Studio is open. Also ensure the Fixture Library is 
the active drawing in Planner. 

2. Select the Connect to AutoCAD option from the File Menu. This will link Fixture 
Studio to the currently Active Drawing in Planner. It also means Fixture Studio can 
access the AutoCAD functionality it will require to save the block. 
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3. Select the Read Blocks option from the view menu. This will bring up the Read 

Blocks dialog box. Select the Merge option - this will compare the information in the 
database and the currently active Planner drawing. Any blocks that are in the 
drawing, but not the database will be imported into Fixture Studio. 

 
4. The block(s) will then be seen in the Fixture Hierarchy. They can be 'dragged and 

dropped' to the appropriate Fixture Group in the Hierarchy 

 
5. The required fixture is then highlighted and the Edit Block option selected. This will 

bring up the Block Details dialog box. 
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The required details are then configured in each tab. One item of data to set is the 
Directory. This specifies the Windows folder where the copy of the DWG file inserted 
by MSM into the planner drawing will be stored. On clicking OK, the details for the 
block will be stored locally in Fixture Studio - and not yet written back to the Macro 
Space Planning database. This can be seen in the list of blocks, where the Red icon 
and -1 Block ID indicate that data is not yet saved back to the database. 

 
6. Save the block details back to the database. This is done by selecting the Save blocks 

option from the File Menu. 

 
– Both the Database and Drawing options should be selected - the drawing option 

will ensure that XData is written to the current copy of the block in the Fixture 
Library. 
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– Add New Definitions should be selected to ensure the new block's details are 
written back to the database. 

– Only Save Selected blocks should be selected to avoid writing back details of all 
blocks (new or not) to the database. 

– Write Block Files ensures XData is written both to the block in the Fixture Library 
and to the copy of the DWG file stored in the Directory specified in the Block 
Details dialog box. 

It is important to understand how this process works. 

 
On clicking OK in the Save Block Definitions dialog box, the following actions take 
place. 

a. The information held in local memory is permanently written to the 
database. 

b. XData (MSM specific data) is written to the instance of the block in the 
currently active drawing. (An instance of every block being saved must be in 
the currently active drawing). 

c. A copy of the block in the currently active drawing is written to the directory 
specified in the Category tab of the block Details dialog box. 

After saving, a confirmatory dialog box will appear. 
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Note: When first saving blocks, Fixture Studio sometimes 
saves the DWG file to the MSM directory rather than the 
directory specified in the block details dialog box. This 
problem can be solved by 'cutting and pasting' the DWG 
Files to the correct directory. 

7. Create a 3DS File 

To create a 3DS file, highlight the required block(s) in the Fixture Hierarchy and then 
select the Create 3DS file(s) option from the File menu. (You must be connected to 
AutoCAD [Planner] to access this option). 

 
On clicking the option, the 3DS files will be created and a confirmatory message will 
appear. 
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Note: Creating a Lightwave file is outside the scope of this 
part of help. 

Tips and Tricks 
The following tips and tricks are useful when creating blocks. 

Fixture Library 
It is recommended all blocks be manipulated in fixture libraries. These are drawings that 
hold ’master copies’ of specific types of blocks. Blocks are often organized using a grid - 
enabling them to be stored in a manner that facilitates locating any block that is to be 
modified. 

 
There are often multiple fixture libraries. Each contains a specific class of block - for 
example racking or freezer/chiller units. 

Note: The combination of Fixture Studio and fixture libraries 
provides an alternative to the Design Centre that pure 
AutoCAD users may be familiar with. 

Having all blocks of a certain type grouped together in a drawing makes editing of the 
blocks easier, should it be required in the future. 
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XData 
Some data is stored in a specialized attribute called BSLINK-ATT. This attribute is 
produced when the Write Block command is used when saving blocks in Fixture Studio. 
It is located at the insertion point of the block, is of very small size and only becomes 
visible after the block is exploded in an AutoCAD floor plan. 

 
This data is used for a number of actions including: 

 Connection Points 

 Fixture Manipulation 

If the XData is absent, this will affect the operation of this functionality in Planner. 

Viewing the XData 
Occasionally it is useful to view the XData (for example when liaising with Oracle 
Support). This can be done as follows in AutoCAD: 

Enter SEQ into the AutoCAD command line. 

 
The Command Line will instruct the user to select a  block. 

 
On clicking a block, the command line dialog box will appear with the XData visible. 

 
Pressing Return returns the user to the AutoCAD floor plan. 

Using Composites to Rename Blocks 
It is possible to create a composite block that will result in a renamed block being 
inserted into an existing drawing (floor plan) as part of the process required to. This is 
done as follows within AutoCAD: 

1. Within a fixture library take a specific block from the client and explode it.  
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2. Select the exploded sub-entities and remake the (child) block with the required 
modified name. 

Note: See the section on repositioning insertion points using 
composites - this task can be carried out at the same time as 
the block is renamed. 

3. Select the recently created block and remake it as another block with the original 
block name. This is the composite (parent) block. 

– The inner (child) block has the modified name. 

– The outer (parent) composite block has the original name. 

This should have resulted in a composite with the following properties that can be seen 
in the schematic diagram below: 

 
The block with the red outline is the inner (child) block with the new name. The block 
with the blue outline is the (parent) composite block with the original name. 

As will be described in a later chapter, the child block and parent composite block can 
then both be registered in Fixture Studio. An existing floor plan can then be opened 
(using Store Planner) in the Planner module. The Restructure Drawing facility can then 
be used to: 

1. Redefine Blocks from Disc 

This action will result in the recently created composite (parent) block replacing the 
older client designed block of the same name in the drawing. As the composite block 
has exactly the same insertion point as the older block it is replacing, it will occupy 
exactly the same position in the drawing. 

2. Explode Composites 
This action will result in the composite (parent) block exploding and disappearing. It 
will leave behind (in exactly the same position) the inner (child) block. This block will 
have the modified name. 
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Note: For the Explode Composite option to work in 
Restructure Drawing, the block must be set to type 
’Composite’ in the Retail Type drop down list in the 
Category Tab of the Block Details dialog box in Fixture 
Studio. 

After the composite has been exploded, the Synchronization option can be used to 
write the changes back to the database. 

Note: Restructure Drawing and Synchronization are covered 
in more detail in the chapter on converting the client’s 
existing drawings for use in Macro Space Management. 

Correcting Insertion Points using Composite Blocks 

Note: this section will only be of assistance to an experienced 
AutoCAD user. 

All DWG files have an insertion point. This serves as a datum for when blocks are 
inserted and manipulated within a floor plan. In the example below, the insertion point 
can be seen at bottom, back, left for the fixture block. This is the default position assumed 
by much of the functionality in Macro Space Management and In-Store Space 
Collaboration. 

 
If the insertion point is in another position, for example bottom, front, left, then there 
may be problems with functionality within Macro Space Management and In-Store Space 
Collaboration. For example: 

 Area Calculations may not give the correct results. 

 Product blocks may not place correctly in the Planner module. 

 Shelves may not place correctly in the Merchandiser module without the aid of 
connection points. 

This problem may be corrected as follows: 

1. Within a fixture library take a specific block from the client and explode it. 

2. Select the exploded sub-entities and remake the (child) block with the insertion point 
in the bottom, back, left position using an appropriate block name. 
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Note: See the section on renaming blocks using composites - 
this task can be carried out at the same time as insertion 
points are repositioned. 

3. Select the recently created block and remake it as another block with the original 
insertion point and original block name. This is the composite (parent) block. 

This should have resulted in a composite with the following properties: 

– The inner (child) block has an appropriate bottom, back, left insertion point and a 
suitable name. 

– The outer (parent) composite block has the original name and insertion point. 

This can be seen in the schematic diagram below: 

 
The block with the red dotted outline is the inner (child) block with the bottom, back, 
left insertion point. The block with the blue dotted outline is the (parent) composite 
block with a bottom, back, right insertion point. The child block and parent 
composite block can then both be registered in Fixture Studio. An existing floor plan 
can then be opened (using Store Planner) in the Planner module. The Restructure 
Drawing facility can then be used to: 

1. Redefine Blocks from Disc 

This action will result in the recently created composite (parent) block replacing the 
older client designed block of the same name in the drawing. As the composite block 
has exactly the same insertion point as the older block it is replacing, it will occupy 
exactly the same position in the drawing. 

2. Explode Composites 

This action will result in the composite (parent) block exploding and disappearing. It 
will leave behind (in exactly the same position) the inner (child) block. This block will 
have a bottom, back, left insertion position and possibly a different name (perhaps 
one obeying a naming convention). 

Note: For the Explode Composite option to work in 
Restructure Drawing, the block must be set to type 
’Composite’ in the Retail Type drop down list in the 
Category Tab of the Block Details dialog box in Fixture 
Studio. 
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After the composite has been exploded, the Synchronization option can be used to 
write the changes back to the database. 

Note: Restructure Drawing and Synchronization are covered 
in more detail elsewhere in this help file. 
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Block Details Dialog Box 

Overview of Block Details dialogue box 
The Block Details dialogue box allows the user to give the WBlock (World Block) 
created in Planner the intelligent properties needed by Macro Space Planning to carry out 
the full range of its fixturing, merchandising and reporting functions. Data added to 
Block Details is stored in the central Macro Space Management database. 

 

The Block Name at the top of the dialogue box must correspond to that of the AutoCAD 
WBlock it is associated with. If they do not correspond, the Macro Space Management 
block cannot be placed in the CAD or Virtual Reality environments. The Block 
Description allows the user to enter a more comprehensive description of the block. The 
Tabs allow the user to switch between various categories of Macro Space Management 
Block information. There are eleven tabs in total: 

Tab Description 

Category This tab holds the basic information on the block. 

Insertion 
This tab holds information on the layer and level defining how the block will 
be inserted into the floor plan. 

Size This tab is used to define the sizes for the block that will be used by MSP. 

Connections This tab is used to define the connection points that define how one block 
connects to another. 

Parts 
This tab is used to build up a parts list for the block. This would be used if 
(for example) a fixture was built up from a kit of parts. Having a parts list 
enables an accurate bill of materials to be built up for a floor plan. 
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Tab Description 

Fixture 
This allows product blocks to be assigned to the block. This allows product 
placeholders to be used to represent the presence of products in a floor plan. 

UDAs (User Defined 
Attributes) 

This tab is used to assign user defined attributes. These are of two types. 
Fixed attributes apply to all instances of the block, while variable attributes 
can be assigned on a case by case basis. 

Styles/Ranges Styles and ranges are used as filters to determine what can be placed on the 
block. 

Merchandisable 
Areas 

This tab allows users to define the volume that can be occupied by products. 
This will generally be less than the total volume of the fixture. 

Shelves This tab allows the user to define a set of angles available to place shelves at.  

Preview 
This tab allows users to preview different aspects of the configuration for the 
block including insertion points, merchandisable areas and so on. 

Each tab is split into a series of frames. Each frame deals with one aspect of the 
information on that tab. 

About Naming conventions 
Gondola creation relies on a convention for block naming. Accordingly blocks should be 
named in a systematic manner. 

 
Naming conventions are often of the general form Block Type-dimension-dimension-
dimension. In the above example, the convention is Backpanel-width-height. 

 Backpanel-600-1150 is a back panel 600 mm wide x 1150 mm high. 

 Backpanel-600-1500 is a back panel 600 mm wide x 1500 mm high. 

Note: Components for gondolas will be selected using these 
name conventions, so it is important that a consistent 
scheme is used when creating blocks. If this scheme is not 
consistent, it may not be possible to select the required 
blocks for creating gondolas. Block names can also include 
suffixes, for example -HD and -HD-Foot. 
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Suffixes can be used to further restrict the list of available blocks for a specific gondola. 

Block Factory 
The Block Factory option is available from the File menu. 

 
On selecting Block Factory, the Block Factory dialog box will open. 

 
Block Factory will create a list of blocks within the fixture hierarchy. If a Fixture Group 
has been highlighted before Block Factory has been opened, the blocks will be created at 
that point in the hierarchy. If no fixture group has been highlighted, the blocks will be 
created under the fixture hierarchy root. When blocks are created in the hierarchy, they 
will have the name, description and dimensions assigned. All other information will 
have to be entered by editing the within the Block Details dialog box. 

There are two options; manually enter the information into Block Factory, or use the 
Wizard to automatically create blocks. 



Block Factory 

100 Oracle Retail Macro Space Management 

Manual Use of Block Factory 

 
To enter information manually, enter the Name, Description, Length, Depth and Height 
in the top line. To store each line press Return. On clicking OK, the entries will be written 
to the fixture hierarchy. 

Block Factory Wizard 
The Block Factory Wizard is accessed by clicking the Wizard button in the Block Factory 
dialog box. 

 
A Name and Description can be entered followed by the dimensions. The dimensions to 
be included and the separators can be specified, but the resulting name combinations 
must be unique. On clicking OK, this will produce a list of block names followed by 
dimensions in the Block Factory dialog box. 
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On Clicking OK, this information will be written to the fixture hierarchy. 

 
The blocks can then be edited using the Block Details dialog box with additional 
information added before the modified block is saved back to the database. 

Note: Using the Block Factory (or the Block Factory Wizard) 
does not create any graphics - the DWG and 3DS files will 
still have to be manually created and imported into Fixture 
Studio. 
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Category Tab 

Overview of the Category Tab 
The Category Tab is used to set general parameters for the block being defined. 

 

These parameters are discussed in more detail in the following sections. 

Equipment Options 
The Equipment options can be set by a wizard to ensure the correct equipment type is 
assigned.  
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Equipment Frame Options 
A number of options are available in the Equipment Type frame. These have a significant 
influence on how the block will behave in a floor plan. 

Option Description 

Retail Type 

Retail Type determines the general characteristics of how the block behaves in the 
floor plan. For example only blocks of type 'Fixture' (Planner and Merchandiser 
and In-store Space Collaboration) or 'Shelf' (Merchandiser and ISSC) will accept 
merchandise. This can be set using either the drop down list or the wizard. 

Can Populate 
with Display 
Style 

The Can Populate with Display Style is only available if the Retail Type has been 
set to fixture or shelf. It determines whether the item of equipment can accept 
products at Display Style level in the Merchandiser module. 

Can Populate 
with 
Placeholder  

The Can Populate with Product Placeholder is only available if the Retail Type 
has been set to fixture or shelf. It determines whether the item of equipment can 
accept product placeholders in the Merchandiser module. 

Attaches to 
Primary 
Equipment 

This determines if the object can attach to primary equipment (fixtures) in the 
Merchandiser module. It will be grayed out for certain Retail Types. 

Attaches to 
Secondary 
Equipment 

This determines if the object can attach to secondary equipment (typically shelves) 
in the Merchandiser module. It will be grayed out for certain Retail Types. 

Accepts 
Secondary 
Equipment 

This allows the object to accept secondary equipment (for example shelves and 
rods) in the Merchandiser module. It will be grayed out for certain Retail Types. 



 Equipment Options 

 Category Tab 105 

Option Description 

Corner Block 

This is a flag to show that the particular item of equipment is designed to go into a 
corner, for example to allow a run of fixtures to continue when it changes 
direction as a wall goes through a right angle. It also restricts options for 
populating and carrying out area calculations. 

   

Retail 
Types Description 

Other 

Equipment type Other is used as a catchall for blocks that are necessary for floor 
planning purposes but do not play a direct part in floor planning. An example might be 
blocks representing electrical sockets. X-Ref'd architectural plans also show as blocks of 
type Other in the synchronization dialog box when assigned to floor plans. 

Fixture 
Fixtures are the only items of equipment that can take merchandise, either directly or 
by means of associated shelves. Fixtures can be either floor mounted (placed directly on 
the floor) or wall mounted (bolted to a wall).   

Shelf 
Shelf objects are the only items of equipment other than fixtures that can hold 
merchandise. They must have a fixture as a parent when placed in a floor plan. Shelf is 
a blanket term for shelf objects such as baskets, shelves, pegs and so on.  

Product 

These blocks are used to represent products on fixtures and shelves. They can either be 
placeholders (which occupy the merchandisable area of the equipment without giving 
any information on the number of product items placed) or display styles 
(Merchandiser and ISSC) which represent individual SKUs. 

Fitting Fittings are items of equipment that can hold other equipment (for example signage). 
They cannot hold merchandise.  

Reference These are the blocks used for specific forms of annotation such as bay numbering and 
aisles.  

Title Block 
This is the 'frame' around a floor plan holding information such as the store name, data, 
store designer and so on. These are very specific types of AutoCAD blocks  and have to 
be assigned a type accordingly. 

Composite 

This is a block made up from other blocks. An example would be a checkout composite 
made up of blocks representing a checkout, display cabinet, till and chair. This 
composite would be placed in the floor plan as a single entity, thus simplifying 
placement. After placement, it can be exploded into its constituent blocks, thus 
allowing the individual parts to be used in store planning. 

Part 
This is used for blocks created purely for the purpose of creating a part list associated 
with a fixture, fitting or shelf. This type of block exists in the database only and is not 
intended for placement in floor plans.  

Equipment Wizard 
The equipment wizard  

Options Description 

Equipment 
Type Frame 

The Type and Description lists in the Equipment Type frame can be set to 
appropriate values for that block. When the OK button is clicked, the Retail Type and 
Icon will automatically be set in the Categories tab of the Block Details dialog box. 
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Options Description 

Equipment 
Size Frame 

The Equipment Size frame enables the dimensions to be entered. On clicking the OK 
button, these will automatically be set in the Sizes tab of the Block Details dialog box. 

Note: For the Calculate and Pick buttons to be active, 
the Connect to AutoCAD option must have been 
selected on the File menu and there must be an 
instance of the block in the Planner drawing. 

There are three ways of inputting dimensions: 

 Manually: numbers can be typed into the appropriate text boxes. 
 Calculate: if connected to an AutoCAD with an instance of the block in the 

drawing, clicking the Calculate button will automatically populate the length, 
depth and height. 

 Pick: if connected to an AutoCAD with an instance of the block in the drawing, 
clicking the Pick button will take the user to the drawing where the user can 
click two points (for example by using OSnap) to define that dimension. 

Spacing 
Frame 

The spacing frame is used to set the dimensions for a vertical array of connection 
points. This can either be set manually, of by means of the Pick buttons. The option 
will be grayed out if the Retail Type (Equipment Type frame) is not appropriate. 

The General Frame 
The General Frame enables the user to set a series of options concerning the basic 
properties of the block. 

 
The general options are as follows: 

Option Description 

Directory 

The Directory the block will be stored in is specified from a drop down list. The list 
of available directories is specified in the directories tab of the Configuration module 
(accessed from the File menu). 

Note: See the Configuration Module help file for 
more information on how to configure directories. 
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Option Description 

Manufacturer 

The Manufacturer for the block can be selected from a drop down list. This list is 
configured in the Administration Module (General Menu). 

Note: See the Administration Module help file for 
more information on how to set up a list of 
manufacturers. 

Category Assign a Category to the block. This category can then be used for reporting 
purposes. 

Units 

Units specify the unit of measurement for the block. This should be set to the 
appropriate metric or imperial units. 

Note: See the Administration Module help file for 
more information on how to configure up a list of 
units. 

Material 
The Material can be selected from a drop down list. It determines the default color of 
the 3DS file used to represent the item of equipment in the Merchandiser module. 
The list of material is configured in the Product Studio module (View menu). 

Print 
Material 

The Print Material is selected from a drop down list. It determines the color of the 
item of equipment will print if a snapshot is taken of the view in the Merchandiser 
module. The list of material is configured in the Product Studio module (View 
menu). 

Note: See the Product Studio help file for more 
information on how to set up the list of materials. 

Status 

The Status is selected from a drop down list. It serves as an indication of where the 
block is in its business life cycle; for example in service, or superseded from service. 
This status can be used for a number of purposes. These include: 
 Use as a filter for populating fixtures into the object grid. (This requires changes 

to the Custom SQL). 
 Use as a filter for reporting purposes. 

The list of Statuses is configured in the Administration module (General 
menu). 

Note: See the Administration Module help file for 
more information on how to configure the list of 
statuses. 

Effective 
Date 

The Effective Date is set using the drop down control. It is the date at which the item 
of equipment is set to come into service. Items of equipment before their Effective 
Date (or with their Effective Date before the Active Date of the Floor Plan) are grayed 
out and unavailable in the Object Browser in the Planner and Merchandiser modules. 
The Effective Date can also be used as a filter for reporting purposes. 

Expiry Date 

The Expiry Date can be set using the drop down control. It is the date at which the 
item of equipment is set to come into service. Items of equipment after their Expiry 
Date (or with their Expiry Date after the Active Date of the Floor Plan) are grayed 
out and unavailable in the Object Browser in the Planner and Merchandiser modules. 
The Expiry Date can also be used as a filter for reporting purposes. 
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Option Description 

Product 
Code 

The code is entered by the user. An example would be a manufacturer’s product 
code. It is used for reporting purposes. 

Icon 
The Icon for the block can be selected from a drop down list. This list can only be 
customized by Oracle. The selected Icon will then appear against the Block 
Definition in the various hierarchical trees. 

Other Options 

 

Type 
The Type Frame specifies how the block is to be drawn in the AutoCAD drawing or 
Virtual Reality environment. Fixed Size blocks are always drawn at a constant scale. This 
is how most blocks will be designated as it means they change in scale as the drawing 
scale is changed. Symbol, Scaled size and Drawn 1:1 do not currently have any effect. 

Graphics 
The Graphics Frame specifies what sort of graphics is drawn in the Planner environment. 
No Graphics is an option that can be used for blocks that are not visually displayed - 
such as parts. An example would be an associated block (such as a bolt or castor) which 
doesn’t need to have graphics, but can still be included in reports. The 3D and 2D 
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checkboxes no longer have any effect. The drop down list is used to specify the shape of 
the merchandisable area for fixture type blocks. 

 Rectangular is the default setting and should be used for all blocks of basically 
rectangular shape. 

 Circular can be used for all blocks with  a circular profile. 

 Semi-circular can be used for all blocks with a semi-circular profile 

 Triangular caters for all blocks with an irregular profile. The functionality allows the 
user to draw an outline representing the merchandisable surface for the block. 

Note: the method for drawing the extents of the shelf is 
covered in more detail in the section of Merchandisable 
areas. 

Working Axis and Stacking Axis 
When different products are placed onto a shelf object they have to be aligned with each 
other during placement.  Single products can be placed as groups with defined numbers 
of facing, depth and stack. 

 
However, the way different products place next to each other needs to be defined. In this 
case different groups of products have been placed next to each other. The way different 
products are placed is based on the working and stacking axes defined. 
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The working axis of an item of shelf equipment is the axis which product that is being 
sequentially placed is aligned along. The stacking axis (or axis’s) is the additional 
direction(s) that products may be stacked on a fixture or shelf object. 

 The X axis is from left to right. 

 The Y axis is from front to back. 

 The Z axis is used for vertical placement. 

 
In the example below, the shelf is used to display products that are normally displayed 
one facing high and next to each other. An example would be packet goods like rice on 
closely spaced shelves. In this case only an X working axis is required. 
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In the next example a product like boxed shirts is being displayed on a shelf. Here, each 
style of shirt will be presented in sequence along the shirt. Each style of shirt will come in 
different sizes such as small, medium and large.  Accordingly, as well as an X working 
axis to allow different styles of shirts to be placed along the length of the shelf, it requires 
a Z stacking axis to enable different sizes of the same style to be stacked above each 
other. 

 
  
Different types of fixture or shelf object will require different working and stacking axes. 
For example a freezer unit might require X and Y working axes to arrange pizzas, while a 
peg would require a Y working axis to hand products. 



Other Options 

112 Oracle Retail Macro Space Management 

Area Calculations 
The Area Calculations Direction Frame is used to set the directions that the area 
calculation function uses when establishing the area apportioned to the fixture. (Fittings 
and shelves are not used in area calculations). 

Note: Area calculations are initiated from the Calculations 
menu in the Planner and Merchandiser menus. They allow 
users to take into account the amount of aisle apportioned to 
the fixture. For example a fixture 4 feet long by 2 feet deep 
would have a foot print of 8 square feet. Area Calculations 
might assign a total area of 30 square feet to the fixture. 
Using this area for reporting purposes is more representative 
than the footprint, for example reporting on sales per square 
foot would take into account the size of the aisle in front of 
the fixture. 

Area calculation works by "feeling" out from the object in the specified directions. The 
starting point is the 'Front' direction of the fixture - this is specified in the Insertion tab. 
The check boxes that are then ticked should be appropriate to the function of the object. 
A fixture that is part of a gondola might have West, South and East ticked - feel out in 
front and to the sides. A freestanding display podium might have all directions checked 
because customers could approach from all points of the compass. 

 
The data for all fixtures in a floor plan can then be determined by using the Allocate 
Areas option from the Calculations menu in the Planner and Merchandiser modules. On 
clicking OK, this information will be written back to the database where it can be used 
for reporting purposes. 
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Reporting Options 
The Reporting Options Frame allows the user to specify whether the Block Definition 
should be excluded from reports or the central database. Not all blocks need be included 
in a report, for example Title Blocks and some symbols such as directional arrows. It may 
also be that is no need to store instances of a certain type of block in a database, for 
example Reference blocks, so there will not a record in the Fixtures table to represent the 
block.  

Option Description 

Exclude from 
Reports 

This check box can be used as a flag. The flag can then be used as a filter to exclude 
items in a report. If you exclude instances of a block from the database, then it will 
also be ignored when rebuilding the drawing from the database. 

Exclude 
Instances in DB 

This check box allows the user to exclude information from the block being stored 
in the database during a save. 

Exclude 
Attributes 

This check box allows certain attributes of the Block Definition to be excluded from 
being stored in the central database. This option is not enabled in this 
implementation of Macro Space Management. 

Include in 
Fixture 
Annotation 

This check box controls fixture annotation in the Planner module. If this option is 
checked, the block will be annotated according to options set in the Text styles 
option (Planning menu) in the Administration module. 

Setting up the List of Categories 
Categories are used for reporting purposes: they provide an easy way to identify all 
items of equipment matching specific criteria.  

Creating the List of Categories 
To create a list of categories, select Edit Categories from the Edit menu. This is used to 
configure the categories that can be assigned to fixtures on the Categories tab of the Block 
Details dialog box. 
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Using Categories 
Once entered, these categories can be assigned to fixtures using the Categories drop 
down list on the Category Tab of the Block Details dialog box. 

 
When generating reports (for example in BI Publisher), Categories can then be used as a 
filter. 
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Insertion Tab 

Overview of the Insertion Tab 
The Insertion Tab is used to specify a number of details affecting how the block is 
inserted into the drawing. 

 
 

The options are as follows: 

Option Description 

Layers This option determines which layer the block will be placed on when inserted 
into a floor plan. 

Levels This option determines which level (elevation) the block will be placed at when 
inserted into a floor plan. 

Front Direction This option sets which face of the fixture is the primary  one approached by 
customers 

Placement This option specified whether the equipment is to be placed on a wall or the 
floor. 
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Option Description 

Insertion Position 
This option is set to match the AutoCAD insertion point for the block. This is 
necessary to ensure the block inserts in the correct position. 

Child Insertion 
Position 

This option determines the location for the first product to be inserted on the 
fixture. 

Insertion Options These options govern the behavior of the block at the moment of insertion. 

Layers and Levels 
Layers and Levels determine what layer the fixture is inserted on and at what elevation it 
is placed. 

 

Layers 
Floor plans are broken up into a series of layers, each of which are generally associated 
with one class of object. Examples would be separate layers for fixtures and for product 
annotation.  Layers are configured in the Layer Alias dialog box accessed from the 
Format menu in the Planner module. 

 
The hierarchy and layers set up in this dialog box are replicated in the Layers frame of 
the Block Details dialog box. Blocks are assigned to a layer by navigating to it in the 
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hierarchy and highlighting the pertinent layer.  When placed in a floor plan the block will 
adopt this layer. 

Levels 
The level is the elevation that the block will be placed on when inserted in the floor plan. 
The default levels are set up directly in the database - see the Oracle Retail Macro Space 
Planning Data Model for details. The default levels for a particular floor plan can 
be modified from the Floor dialog box in the Store Manager module in the Planner and 
Merchandiser modules. 

 
Blocks are assigned to a level by highlighting it.  When placed in a floor plan the block 
will adopt this elevation. Common levels used are: 

Level  Comment 

Floor This is the level generally assigned to fixtures and fittings 

Undefined 
This is the level generally assigned to shelves as their elevation depends on where 
they are placed on their parent fixture. 

Insertion Options 
The insertion options determine how objects are place in the floor plan and how products 
place on those objects. 



Insertion Options 

118 Oracle Retail Macro Space Management 

 

Insertion Position 
The Insertion Position is a position specified within Macro Space Management that 
matches the insertion position created when the associated graphic for the block was 
drawn in AutoCAD. It is important that the fixture Studio insertion point matches the 
insertion point already defined in the graphic. If they do not match, then the graphic will 
be inserted into the AutoCAD and Merchandiser environments at a position that differs 
from the correct one. This in turn will result in problems with adjacency calculations, 
placing of associated equipment and products, etc. 

Note: The Insertion Position specified within Macro Space 
Management is passive – changing the Insertion Position 
does not change the position of the graphical insertion 
position created when the graphic was drawn. 

 
There are twenty seven possible insertion positions, aligned in three layers: top, (green 
circles), middle (blue circles) and bottom (yellow circles ). The layer can be selected by 
clicking on the appropriate radio button. Each layer contains nine possible insertion 
points ranging from left rear to front right. The required option can be selected by 
clicking on the appropriate radio button. 
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Note: A consistent convention should be adopted for the 
position of the insertion point. If all blocks are drawn using 
this convention, then the potential for misalignment is 
sharply reduced. 

 
 In the above example, the insertion position (blue square) is bottom-back-left, with the 
radio button in the Insertion position frame set accordingly. 

 
In the above example, the insertion position (blue square) is top-front-right, with the 
radio button in the Insertion position frame set accordingly. 

Child Insertion Position 
The Child Insertion Position is the datum point at which an item of merchandise at 
Display Style level is inserted onto a fixture or shelf object in the Merchandiser module. 
There are twenty seven possible insertion positions, aligned in three layers: top, (green 
circles), middle (blue circles) and bottom (yellow circles ). The layer can be selected by 
clicking on the appropriate radio button. Each layer contains nine possible insertion 
points ranging from left rear to front right. The required option can be selected by 
clicking on the appropriate radio button. 

 
An item of packaging going onto a shelf would generally have its child insertion position 
set to bottom-back-left. 
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Each layer contains nine possible insertion points ranging from left rear to front right. 
The required option can be selected by clicking on the appropriate radio button. 

The position the first product will be inserted can be seen in the Preview Tab if the First 
Product Option is checked. 

Insertion Options 
The Insertion Options Frame specifies how the block will behave on being inserted into 
the AutoCAD environment. 

Option Description 

Rotate 
Attribute 

If selected, this causes any non-constant attributes on the block to be rotated so they 
are upright and readable. An example might be a text tag associated with a block. If 
the block is inserted in an orientation where the text would otherwise not be 
readable, the text will be rotated so it becomes visible. 

Explode 
Block on 
Insert 

If selected, any composite blocks will be exploded into their constituent parts when 
inserted into a floor plan. 

Adopt Layer This option is no longer in use. It has been included so as to be compatible with 
earlier versions of Macro Space Management. 

Other Insertion Options 
The other two insertion options are Front Direction and Placement 
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Front Direction 
The Front Direction  represents the side of the fixture that has been designated as the 
front of the fixture. This can be visualized as the direction the customer will approach the 
fixture from. It also determines the default orientation of any shelves and merchandise 
that might be placed on the fixture. 

 
  

Note: When assigning block details, it is strongly recommended that all blocks be 
initially defined with the same Front Direction. If front directions vary from block to 
block, this will lead to confusion when blocks are inserted in the drawing or formed into 
gondolas. 

Placement 
This enables two forms of mounting options to be specified. 
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Option Description 

Space Mounted This block can be inserted into any floor space. 

Wall Mounted This block can be attached to a wall on insertion. 

 



 

Size Tab 123 

15 
Size Tab 

Overview of the Size Tab 
The Size Tab is used to specify the dimensions of a fixture.  

 

It contains options: 

Option Description 

Actual size  This is the actual size of the item of equipment 

Nominal 
Dimensions 

This is a size that can be entered by the user. It is a purely nominal size that can be 
used for calculation purposes. 

Size details The size details frame is used to select sizes that can be assigned to stretchable blocks. 

Stretchable Blocks 
Stretchable blocks are blocks where the user can select the size when placed in a floor 
plan. Blocks become stretchable when a size rule has been applied.  Stretchable blocks 
can be used: 



Actual and Nominal Sizes 

124 Oracle Retail Macro Space Management 

 To represent a fixture that exists in a range of sizes. In this instance one block could 
be used to represent a dozen fixtures. 

 To represent obstructions like columns in a floor plan. In this event, one block could 
be used to represent a column of any size. 

Representing fixtures using stretchable blocks has advantages and disadvantages. It 
makes it easier to create and maintain the fixture and gondola libraries as fewer blocks 
are required. However, it may be possible for store planners to place a fixture in a 
combination of sizes that does not exist in practice. This will lead to problems when 
equipment is ordered in order to put a floor plan into service. In addition, reporting bills 
of materials, etc, becomes more complex if stretchable fixtures are used. This is because 
the report must now identify the fixture sizes and use a 'look up'  list to relate that to a 
part number. 

Actual and Nominal Sizes 
The Actual size and Nominal Dimensions for an item of equipment are entered in the 
Size tab. These dimensions are used for blocks of a fixed size. If additional information is 
entered in the Size Details frame, the block will become stretchable - able to take up a 
range of sizes. 

 

Actual Size 
The Actual Size Frame specifies the default size for the block. If no details are entered in 
the associated Size Details frame, the Actual Size frame specifies the only permissible set 
of dimensions that can be used. Details may be entered in three ways: 

Entry Method Description 

Direct entry If the actual dimensions are known, they can be manually entered into the pertinent 
text boxes. 

Calculate  

For this option to work, Planner must be open, the Connect to AutoCAD option 
must be selected on the File menu and the floor plan in Planner that Fixture Studio 
is connected to must contain an instance of the block for which the sizes are to be 
calculated. Clicking the Calculate button will then return the maximum Length, 
Depth and Height of the block. 
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Entry Method Description 

Pick 

For this option to work, Planner must be open, the Connect to AutoCAD option 
must be selected on the File menu and the floor plan in Planner that Fixture Studio 
is connected to must contain an instance of the block for which the sizes are to be 
calculated. Clicking the Pick button for a specific dimension will take the user to the 
Planner drawing. The user will then be invited to pick two points - for example by 
using AutoCAD's OSnap option. On clicking the second point, the user will be 
returned to Fixture Studio and the dimension automatically entered in the text box. 

Care should be taken to ensure the Actual Size is entered accurately. This is because 
Macro space Planning uses the data for a number of purposes including drawing 
gondolas in Planner, Merchandiser and In-Store Space Collaboration. If the entered sizes 
are not accurate equipment may be drawn overlapping or with gaps between it. 

 The Actual Sizes are used when placing instances of gondolas. If these sizes are not 
accurate the gondola may have parts that overlap or have gaps between them. For 
example, if a fixture has an actual length of 35 inches and a nominal length of 36 
inches, it is important to use the actual length. 

Nominal Dimensions 
Nominal dimensions are primarily used for primary fixtures, where attached secondary 
equipment will substantially increase the volume. For example, consider a backpanel 600 
mm long, 1900 mm high and 5 mm deep. If this backpanel has shelves attached, it will 
eventually occupy a significantly larger space. It could therefore be assigned nominal 
dimensions of 600 mm long, 1900 mm wide and 300 mm deep to allow for the eventual 
shelves. 

Note: Any product or placeholders put onto a fixture with 
nominal dimensions will occupy a volume that corresponds 
to the larger of the Actual and Nominal Sizes. 

Overview of Size Details 
Size details are used to make a block stretchable - to give it the ability to adopt a range of 
sizes when placed into a floor plan. These are used in three stages: 

1. Sizes are set up using the Sizes dialog box accessed from the Edit menu in Fixture 
studio. 

 

2. Sizes are assigned to blocks in the Sizes tab of the Block Details dialog box in Fixture 
Studio. 
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3. When an instance of a block is placed in a floor plan, the user can select the required 

size on insertion. 

 

Setting up Sizes and Size Groups 

Overview 
Sizes are used to assign the permissible dimensions to stretchable blocks. For 
administrative purposes, defined Sizes are organized by Size Groups. Sizes and size 
Groups are set up in the Sizes dialog box accessed from the Edit menu. 

 
These are then assigned to individual items of equipment in the Size tab of the Block 
Details dialog box. 

The Sizes dialog Box Menus and Toolbar 

File Menu 
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The File menu contains options to save the current changes, save the current changes 
and exit or exit without saving any changes. 

Edit Menu 

 
The Edit menu allows users to add, edit and delete sizes and size groups. 

Help Menu 

 
The Help Menu allows users to call Fixture Studio help. 

Toolbar 

 

Icon Description 

 

Save changes 

 

Close dialog box 

 

Add Size Group 

 

Edit Size Group 

 

Delete Size Group 

 

Add Size 

 

Edit Size  

 

Delete size 

Size Groups 
Sizes Groups are used to group together sizes of common purpose. They can be added, 
edited or deleted using the options from the Edit menu or toolbar. 
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Icon Description 

 

Add Size Group 

 

Edit Size Group 

 

Delete Size Group 

Adding a Size Group 
This is a function that allows a hierarchical tree to be built. To add a Size Group highlight 
the node in the hierarchical tree to which the new Size Group is to be added and click on 
the Add a Size Group icon. The Size Group dialogue box will appear. 

 
Type in the name of the required Size Group and then click OK. The Size Group will be 
added to the hierarchical tree. 

Editing a Size Group 
Size Group names can be edited. To do this, highlight the required Size Group and click 
on the edit a Size Group icon. The Size Group dialogue box will appear. 

 
Change the name of the Size Group then click on OK. The Size Group will be amended in 
the hierarchical tree. 

Deleting a Size Group 
To delete a Size Group, highlight the group and click on the Delete a Size Group icon on 
the toolbar. It is generally best to either delete any associated Sizes first or to move them 
to another Size Group by dragging and dropping. 

Sizes 
To Add a Size click on the Add a Size icon in the section of the toolbar concerned with 
Adding, Editing and Deleting Sizes. 

 

Icon Description 

 

Add Size 
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Edit Size  

 

Delete size 

When adding a Size, first select the Size Group it is to be added to by clicking on it. If this 
is not done, an error message will result. 

 
If a Size Group has been selected, the Size dialogue box will appear. This has two tabs: 
Details and Types. 

Details Tab 
The details tab is used to enter the name and description of the Size, together with the 
unit. 

 
 

Option Description 

Name The is the name of the size 

Description This is the description that will appear in the Sizes dialog box - it can be used to give 
more information on the purpose of the Size.  

Title  This is the name that will be given to the size in the size tab of the block details dialog 
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box. 

Units These are the units associated with the size. These will normally be inches or 
millimeters. 

Types Tab 
The Types Tab holds details of the sizes that can be assigned to a stretchable block. 

 
These options are discussed in more detail in the next section. 

Saving Information 
To save the information entered in the Size dialog box, click OK. The dialog box will 
close and the information written back to the database. 

Size Types 
There are a number of options for setting sizes. These are selected from the Type drop 
down list in the Types tab. 
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The different size types are: 

Type Description 

Fixed Give the store planner the option of a single, fixed size. 

Variable An option for a size variable by a fixed increment between a maximum and minimum 
size. 

Choice Pick from a set of specified values. 

Match Match the value of another selected dimension. 

Delta Set the value to be that of another dimension plus a specified amount. 

Ratio Set a size to be a ratio of another dimension 

Locked 
Lock a dimension from being chosen. This restricts the user to selecting the values for just 
one or two dimensions. 

 

The parameters are as follows: 

Option Description 

Dependent 
on 

This option allows the dimension to be configured as independent of other 
dimensions or dependent on one of the other two. 

Prompt 
This is the name for the dimension that will appear in the stretchable fixture dialog 
box when a user places a fixture in the Planner or Merchandiser modules or in In-
Store Space Collaboration. 

Maximum This is the maximum value the dimension can take. 

Minimum This is the minimum value the dimension can take. 

Increment This is the step size between maximum and minimum dimensions. 
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Note: Some of these options may be grayed out and 
unavailable depending on the size option selected. 

Fixed Sizes 

 
When setting fixed sizes, only a single dimension can be input for length, depth and 
height. All other options are grayed out. In the above example, the use would only be 
able to place a fixture with Length 48 inches, Depth 24 inches and Height 72 inches. 

Variable Sizes 

 
Variable Size allows the user to set a number of discrete sizes that can be selected when 
the block is inserted into a floor plan.  In the above example, the minimum size for the 
length has been set to 48 inches and the maximum to 72 inches. As the increment has 
been set to 12 inches, the user will be able to select lengths of 48, 60 or 72 inches when a 
fixture with this Size is inserted in the floor plan. 
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Choice 
Choice allows the user to set in a number of predefined size options. 

 
When this option is selected from the Type drop down menu an additional Size Choices 
Tab will appear. 

The names entered in the prompt fields in the Types tab will appear in the Size Choices 
tab as the names of the dimensions. 

 
The actual dimensions can be added in the Size Choices Tab. The toolbar allows the user 
to add, delete and re-order the list of dimensions. 

Icon Option 

 

  
Add New Choice 
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Icon Option 

 

  

Delete Selected Choice 

 

Move Choice Up - this will change the order they are displayed in the Stretchable 
Fixtures dialog box when placed in a floor plan.  

 

Move Choice Down - this will change the order they are displayed in the Stretchable 
Fixtures dialog box when placed in a floor plan.  

Match Sizes 
Match Sizes enables the user to link one dimension to another. 

 
At least one dimension must be defined using another size option, for example Fixed. 
Other dimensions can be slaved to that specified dimension. In the above example, the 
length has been set up to match whatever value the user selects for the depth.  

Delta 
Delta will allow a user to select another dimension and specify the current dimension to 
match that plus/minus a specified increment. 
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This functionality is not implemented in this release of Macro Space Management. 

Ratio 
Ratio will allow a user to select another dimension and specify the current dimension to 
be multiplied by a specific ratio. 

 
This functionality is not implemented in this release of Macro Space Management. 

Locked 
Locked sizes enable the choices visible to the user to be restricted to only one or two 
dimensions when the dialogue appears during insertion. 
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For this option to work, lists of dimensions must first have been input into the Size 
Choices tab. 

 

Working with Size Details 
Size details are assigned to blocks in the size details frame. 
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There are three options: 

Option Description 

Associate  
Associate a set of sizes (previously configured in the Sizes dialog box accessed from 
the View menu) with the block. 

Edit 
Edit the parameters of the sizes that will be associated with the block. This option 
should be used with caution as it will affect all other blocks with that set of sizes 
associated with it.  

Remove Remove the set of sizes from this block. when placed this block will now assume the 
sizes in the Actual Size frame. 

Associate 
When a block can be assigned multiple dimensions, it needs to be associated with a Size 
Group. The block will then adopt the size rules associated with that Size Group and 
hence will have a range of permissible dimensions assigned to it. This is done by clicking 
Associate. This will bring up the Size dialog box. 

 

Note: Create new size allows user to create a new range of 
sizes. It is better to this using the option accessed from the 
Edit menu. 
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This dialog box contains the sizes that have been configured using the Size option 
accessed from the View menu. Highlight the required choice and click OK.  The size 
choices will be assigned to the block. 

 

Edit 
Clicking Edit brings up the Size dialog box. This enables user to edit details of the sizes 
being assigned to the block. (This dialog box can also be accessed via the View menu). 

 

Note: This operation edits the size rules, not the dimensions 
for the block being defined. 

Editing the size rules will affect ALL blocks currently associated with that set of size 
rules. Accordingly, it should be done with caution. 

Remove 
Removing a Size Group association can be achieved by clicking on Remove. This 
removes the link to the size group (and its associated size rules) but it does not delete the 
Size Group itself. The Size details frame will then show that no Size Group has been 
associated with this particular block. 
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Connections Tab 

Overview of the Connections Tab 
The Connections Tab lets the user specify the connection options for Macro Space 
Management blocks. These are used within the Planner and Merchandiser modules. 

The Planner Module displays basic left/right/rear connection points allowing fixtures 
and fittings to be accurately aligned relative to each other. The Merchandiser model 
allows more complex use of connections, including additions of small items of 
equipment such as grilles to shelf objects. There connection settings also act as the 
defaults in the Add Shelf dialog box in the Merchandiser module. 

Note: Gondolas provide a more efficient way of placing large 
numbers of items of equipment in a fixed alignment. 

 
A small Toolbar at the top lets users Add, Copy and Delete connections, while the 
Wizard on the toolbar allows the user to add three basic connections. The Connections 
List below lists all current connections for the Macro Space Management Block. 
Highlighting an individual connection enables the lower part of the tab - which allows 
the details of the connection to be configured. 
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The Connections Tab and the Configuration Module 
Settings in the Configuration Module (File menu > Configure) can affect how connection 
points appear in the Preview tab the Block Details dialog box of Fixture Studio. They also 
affect how connection points appear and behave in the Merchandiser module. 

 
 

Option Effect 

Gender 
Filter 

If selected, the two sets of connection points being used to connect one item to another 
must have opposite genders or no genders to connect.  

Size Filter  If selected, the two sets of connection points being used to connect one item to another 
must have compatible sizes to connect.  

Shape 
Filter 

If selected, the two sets of connection points being used to connect one item to another 
must have compatible shapes to connect.  

Pointer 
Size 

This affects the appearance of the connection point as displayed in the Merchandiser 
module. 

Line Size This affects the appearance of the connection point as displayed in the Merchandiser 
module. 

Colors  The colors for Neutral, Male and Female connection points can be set. These settings 
have local effect - changing one user's settings will not affect other users. 

The Connections Toolbar 
The Connections Toolbar allows users to Add, Copy and Delete Connections. It also 
allows the user to invoke the Connections Wizard. 

Option Description 

 

Add a Connection 
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Option Description 

 

Copy a Connection 

 

Delete a Connection 

 

Connection Point Wizard 

Connection Options 

Add a Connection 
To add a connection to the list of connections:   

1. Click Add Connection on the toolbar. This will create a blank line at the top of the list 
of connections. 

2. Type in a name for the connection in the newly created blank line and press return.  

3. This will create a new connection in the list of connections. This can be configured as 
required. 

 
See the information on Connection Lists for how to configure the connection. 

Copy a Connection 
To copy an existing connection: 

1. Highlight the connection it is desired to copy and click Copy Connection on the 
toolbar. 

2. This will bring up the Copy connection point dialog box. Type in a new name for the 
connection being copied. Click OK. 

3. A copy of the connection will be created in the list of connections. This can be edited 
as required. 
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Delete a Connection 
To delete a connection, highlight the connection to be deleted and click on the Delete 
icon. The user will be asked to confirm deletion. 

 

Connection Wizard 
The Connections Wizard can be used to add a set of basic connection points that allow 
fixtures to snap to each other in the Planner and Merchandiser modules. 

1. Click the connections Wizard icon on the toolbar. 

2. This will bring up the Connections Wizard dialogue box. 

 
3. Select the required options: 

– Selecting Add Connection on Left will add a Connection on the left. 
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– Selecting Add connection on Right will add a Connection on the right. 

– Selecting Add Connection at Back will add a Connection at the back. 

– Selecting Back Connector can Attach to Sides will configure the back connector 
so it is compatible with the connection points on the sides of the fixture. 

– Selecting Clear Existing Blocks will remove all existing connections and replace 
them with ones created by the wizard. The left connection is male and the right 
female so that fixtures can only attach when they are facing the same way. The 
left connection is additionally set to be the default. The Back connection has no 
gender, so it will attach to any other connection. 

4. On clicking OK on the Wizard, the selected default connections will be added. 

 

Connection Tab Options 
The connection tab options will be grayed out an unavailable until a connection is 
selected from the list of those available. The details of that connection can then be 
configured using the available options. 

 

Type 
The type frame allows the user to  
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Option Description 

Text Reference 
Point 

Selecting this radio button makes the connection one used for text. This brings up 
a slightly different form of the tab. 

Note: The Text Reference point option is not 
currently operative. 

Connection Selecting this radio button makes the connection one used as a connection point. 

Default 
Connection 

If selected this makes this connection the default for the fixture. This connection 
point will then be used when the Attach option is selected in the Add Fixture 
dialog box when inserting a fixture in Planner. 

The user can specify whether the selected item is to be used as a physical connection 
point or as the anchor for instance specific text for the block. This option is set by the 
radio button. In addition, the selected connection can be designated as the Default by 
ticking the check box. If the Text Reference Point option is chosen, a new version of the 
Connections Tab appears. This can be used to attach text to a block in Planner. 

Filters 
The Filters Frame enables the user to set parameters that can be used as filters to decide 
whether two connection points are compatible or not. 

Note: Which of these filtering options is active in a floor plan 
in Merchandiser is determined by settings in the Fixturing 
tab of the Configuration module. 

Gender 
The gender of a connection determines whether that connection is compatible with 
another. There are three genders; male, female and none. They are selected from by 
means of the radio button. 

  Can connect with 

Male Female None 

Female Male None 

None Any other connection 

Shape 
The Shape of a point connection can be specified from the drop down list. The shape is a 
theoretical concept and can be any convenient name - like connects with like. All shapes 
can connect with the 'None' option. The list of shapes available can only be defined 
directly in the database. In the example below, the 'Shapes' have been changed to text 
entries for specific types of connections. 
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Size 
A maximum and minimum size for the connection can be set using the spin controls.  A 
pair of connection points must have compatible sizes to connect together. If the Match 
checkbox is ticked, then the connections must have identical maximum and minimum 
sizes. If they are not identical, the connections will not mate. If the Match checkbox is not 
ticked, then the connections must have overlapping size ranges. If they are not 
overlapping, the connections will not mate. 

  Connection 1 Connection 2   

Size Range 0 - 50 25 - 75 Compatible 

Size Range 0- 25 50 - 75 Incompatible 

Position Frame 
The Position Frame is used to specify the origin of the connection point. This is based on 
X, Y and Z offsets relative to the insertion point of the block.  

Note: The pick button is not fully functional at present. 

Array 
The Array Frame is used when it is desired to produce a connection line, plane or box. 
There are three options: 

Option Description 

One dimension Setting up spacing in a single dimension results in a line of connection points. 

Two dimensions 
Setting up spacing in two dimensions results in a two dimensional array of 
connection points. This would typically be in the X-Z plane which would result 
in an array of points parallel to the back of the fixture. 

Three dimensions Setting up spacing in three dimensions would result in a cuboid of connection 
points - it is difficult to think of circumstances when this would be required. 
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The above examples show the three options. 

Spacing 
This specifies the distance between successive points. 

Tip: If set to 0 a connection line will be drawn. This allows 
attachment at any point along the line, rather than at specific 
connection points. 

Max Extents 
This specifies the dimension in that particular plane. It is drawn relative to the position 
point specified in the Position frame. 

Tip: Once a value has been entered, clicking on the calculate 

icon will give the maximum distance the connection 
points can extend. 

Horizontal and Vertical Angles 
The Horizontal and Vertical Angles are used to control the direction of connection 
points, irrespective of whether they are assigned as a point, as a line or as a plane. 
Changing the Horizontal Angle changes the direction the designated connection point 
faces over the floor.  

 Setting it to 0 degrees will make them face east; setting to 180 degrees will make 
them face west. 

 Setting the Vertical Angle affects whether the connection points are horizontal or face 
up or down. 

 Setting to 0 degrees will result in the connections being horizontal, 90 degrees 
pointing vertically up and 270 degrees vertically down. 

Note: Setting to 180 degrees will result in the connection 
point turning upside down and facing in the opposite 
direction. Please use caution when using this option.   
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Connection Points for a Shelf 
Shelves might be attached to a back panel. This worked example is for a back panel 36 x 1 
x 72 inches in size. 

Settings 
The first example is for a connection line 

 

Type Frame 
The Type is set to Connection. 

Filters Frame 
 The Gender is set to Female - this means that the connection point on the 

corresponding shelf will be set to male to make the connection compatible. 

 The shape is set to slot/shelf. This option can be customized in the Connection Shape 
table in the database - see the Oracle Retail Macro Space Planning Data Model for 
details. 

 The Size has been set to 10 and the Match option selected. 

All of the above options can be used as filters if required. 

Note: The color of the connection line will depend on the 
gender and settings in the Fixturing tab of the Configuration 
module. 

Position Frame 
This is set up using a standard Cartesian coordinate system. 

 The connection will be on the left edge of the back panel , so the X coordinate is set to 
0. 

 The connection will be in the front face of the back panel, so the Y coordinate is set to 
-1 (bring it forward by one unit). 

 The shelves will start 6 inches up from floor level, so the Z coordinate is set to 6. 
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Array Frame 
This connection line is being configured in the vertical (Z) plane, so we are only 
interested in the Z data. 

 The spacing is set to 0 so this will be a continuous line. 

 The Max extent is set to 60. This is calculated as follows: 

– The height of the fixture is 72 inches. 

– The connection line will start 6 inches from the base 

– The connection line should stop 6 inches from the top. 

– 72 inches - (6 inches + 6 inches) = 60 inches. 

Horizontal and Vertical Angle Frames 
These are used to set the orientation of the connection points. 

 The Horizontal angle is set to 270 degrees so the connection points protrude forward 
from the face of the back panel. 

 The Vertical angle is set to 0 degrees so that the connection points are level. 

Connection Points 
This example is similar to the first example except that the spacing has been set to 6 
inches for the Z axis in the Array frame. This has resulted in a series of connection points 
rather than a connection line. 

 

Connection Lines for a Slatwall 
Note: Please refer to the worked example for connection 
points for a shelf before attempting this example. 

Varying shelf objects such as rods and pegs might be attached to a slatwall. This worked 
example is for a slatwall 36 x 1 x 72 inches in size. 
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Settings 

Type Frame 
The Type is set to Connection. 

Filters Frame 
 The Gender is set to Female - this means that the connection point on the 

corresponding rod will be set to male to make the connection compatible. 

 The shape is set to slot/shelf. This option can be customized in the Connection Shape 
table in the database - see the Oracle Retail Macro Space Planning Data Model for 
details. 

 The Size has been set to 20 and the Match option selected. (This differs from the 
setting for Shelves to enable filtering options to work). 

All of the above options can be used as filters if required. 

Note: The color of the connection line will depend on the 
gender and settings in the Fixturing tab of the Configuration 
module. 

Position Frame 
This is set up using a standard Cartesian coordinate system. 

 The connection will be three inches in the left edge of the back panel, so the X 
coordinate is set to 3. 

 The connection will be in the front face of the back panel, so the Y coordinate is set to 
-1 (bring it forward by one unit). 

 The shelves will start 6 inches up from floor level, so the Z coordinate is set to 6. 

Array Frame 
This connection lines are being configured in the horizontal (X) and vertical (Z) planes.   

 The Z spacing is set to 6 so the lines will be 6 inches apart in the vertical plane. 

 The X spacing is set to 0 so this will be a continuous line. 

 The Max X extent is set to 30. This is calculated as follows: 

– The width of the fixture is 36 inches. 
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– The connection line will start 3 inches from the left hand edge. 

– The connection line should stop 3 inches from the right hand edge. 

– 36 inches - (3 inches + 3 inches) = 30 inches. 

 The Max extent is set to 60. This is calculated as follows: 

– The height of the fixture is 72 inches. 

– The connection lines will start 6 inches from the base 

– The connection lines should stop 6 inches from the top. 

– 72 inches - (6 inches + 6 inches) = 60 inches. 

Horizontal and Vertical Angle Frames 
These are used to set the orientation of the connection points. 

 The Horizontal angle is set to 270 degrees so the connection points protrude forward 
from the face of the back panel. 

 The Vertical angle is set to 0 degrees so that the connection points are level. 

Connection Points for a Pegboard 
Note: Please refer to the worked example for connection 
points for a shelf before attempting this example. 

Varying shelf objects such as pegs might be attached to a peg board. This worked 
example is for a peg board 36 x 1 x 72 inches in size. 

 

Settings 

Type Frame 
The Type is set to Connection. 

Filters Frame 
 The Gender is set to Male - this means that the connection point on the 

corresponding rod will be set to female to make the connection compatible. 
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 The shape is set to peg/pegboard. This option can be customized in the Connection 
Shape table in the database - see the Oracle Retail Macro Space Planning Data Model for 
details. 

 The Size has been set to 5 and the Match option selected. (This differs from the 
setting for Shelves to enable filtering options to work). 

All of the above options can be used as filters if required. 

Note: The color of the connection line will depend on the 
gender and settings in the Fixturing tab of the Configuration 
module. 

Position Frame 
This is set up using a standard Cartesian coordinate system. 

 The connection will be three inches in the left edge of the back panel, so the X 
coordinate is set to 3. 

 The connection will be in the front face of the back panel, so the Y coordinate is set to 
-1 (bring it forward by one unit). 

 The shelves will start 18 inches up from floor level, so the Z coordinate is set to 18. 

Array Frame 
This connection lines are being configured in the horizontal (X) and vertical (Z) planes.   

 The X spacing is set to 6 so the lines will be 6 inches apart in the horizontal plane. 

 The Y spacing is set to 6 so the lines will be 6 inches apart in the vertical plane. 

 The Max X extent is set to 30. This is calculated as follows: 

– The width of the fixture is 36 inches. 

– The connection points start 3 inches from the left hand edge. 

– The connection points should stop 3 inches from the right hand edge. 

– 36 inches - (3 inches + 3 inches) = 30 inches. 

 The Max extent is set to 48. This is calculated as follows: 

– The height of the fixture is 72 inches. 

– The connection lines will start 18 inches from the base 

– The connection lines should stop 6 inches from the top. 

– 72 inches - (18 inches + 6 inches) = 48 inches. 

Horizontal and Vertical Angle Frames 
These are used to set the orientation of the connection points. 

 The Horizontal angle is set to 270 degrees so the connection points protrude forward 
from the face of the back panel. 

 The Vertical angle is set to 0 degrees so that the connection points are level. 
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Parts Tab 

Using the Parts Tab 
The Parts Tab is used to improve the accuracy of reporting. A fixture can be represented 
by a single block in a floor plan. However the real life fixture may be more complex and 
made up from a number of parts such as uprights, cross-bars, castors and securing bolts. 
It is therefore possible to create a block and associate parts with it. When a report (such 
as a bill of materials) is run on a floor plan, that report can then be expanded from a list 
of parts to a list of required sub-components. 

 

Note: Part blocks do not need graphics files - they will not be 
inserted into a floor plan. 

Creating Parts 
Part Blocks are specialized type of block that have no graphics and exist only within the 
Macro Space Management database. Their only use is for reporting purposes. 

Note: It is recommended that Part Blocks are kept in specific 
and separate Groups within the Fixture Studio Hierarchy. 
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Only a few basic parameters need to be defined - although more can be set if needed for 
detailed reporting purposes. 

Category Tab 
After inputting an appropriate block name and description, in the Category Tab set the 
following: 

 Set Equipment type to Part 

 Ensure Effective and Expiry dates are set appropriately. 

 Select the Part Icon. 

Insertion Tab 
For the Insertion Tab, select a nominal layer. 

Note: A layer is not necessary for a block that is to be used 
purely for reporting purposes, but Macro Space 
Management will not allow the block to be saved until one 
has been set. 

Size Tab 
Unless it is necessary to have accurate dimensions, set nominal values in the Actual size 
frame. The block can then be saved to the database. 

Building up a Parts List 

Available Parts 
The Available Parts Frame contains a list of all available parts. Block Names and 
Description can be sorted in ascending or descending order by clicking on the column 
header. 

Associated Parts 
The Associated Parts Frame contains a list of all parts associated with that particular 
block.  Quantities, Block Names, and Description can be sorted in ascending or 
descending order by clicking on the column header. 

Building and Editing a Parts List 
To add a part to the Associated Parts list, highlight the part in the Available Parts frame 
and use the Add arrow. Alternatively highlight and double click on the part in the 
Available Parts frame. To remove a part from the Associated Parts list, highlight the part 
in the Associated Parts frame and use the Add arrow. Alternatively highlight and double 
click on the part in the Associated Parts frame. 

 

Changing the number of a specific part 
To change the number of a specific part in the associated parts list, highlight the required 
part then left click on the number itself in the Qty column. 
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The number can then be edited. Press <Return> to store the number. 
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Fixture Tab 

The Fixture Tab 

Overview 
The Fixture Tab is used to specify the behavior of shelving and the Product Block for a 
fixture. 

 

Fixture Options 
The Fixture Frame allows some details of how the fixture is to be merchandised to be 
specified.  

Note: Vertical Category and Tierage have been largely 
superseded by Styles in Macro Space Management. 

Vertical Category 
Vertical Category allows the aliased layer to be occupied by the fixture to be further sub-
divided. The default is 0, but fixtures can be assigned to further vertical categories within 
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the aliased layer. For example, TV’s could be assigned to Vertical Category 1; CD Players 
to Vertical Category 2... 

Setting the Vertical Category affects Adjacency calculations – fixtures in different Vertical 
Categories will not be shown as adjacent. Setting the Vertical Category also affects 
annotation – if Vertical Categories are set, each category will receive its own separate 
annotation. Finally, setting Vertical Categories affects the reporting options – material in 
different categories can be reported separately. 

Tierage 
Tierage is used when the fixture has distinct merchandisable levels ra ther than shelves. 

 
Examples of fixtures that have tiers are those used to display magazines or perfumes. 

 If the Fixture has shelves, the Tierage value should be left set to 0. 

 If the fixture has tiers rather than shelves, then the number of tiers should be 
specified. 

Note: There are two ways of assigning a Product Base to a 
tiered fixture. 

The product base can be designed such that a single product base fits the tier structure. In 
this case the entire fixture can be merchandised, but only with a placeholder indicating a 
class of product, for example cards or lipsticks. Alternatively, each tier can be defined as 
a Merchandisable Area in the Merchandisable Areas tab. Each tier can then have a 
product base assigned to it. This would allow more specific placeholders to be used. For 
example CD’s with artist's names beginning with A & B would be placed on the upper 
tier. 

Product Blocks 
The Product Block  Frame allows the details of the Product Block to be assigned to the 
Fixture. 

Note: If a product block has not been specified for a  fixture 
or shelf, it will not be possible to merchandise that item of 
equipment with a placeholder. 

Product Blocks assigned in this frame are used to act as indications of the dimensions 
that can be merchandised when placeholders for a general class of product (for example 
shoes or canned goods) are assigned to the fixture. The default Product Block is PBASE, 
which is a simple rectangular block but other product blocks can assigned. For example a 
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round product block could be assigned to a table top, and a stepped product base could 
be assigned to a display cabinet with tiers. 

Shelving 
The Shelving Frame is used to set parameters affecting the behavior of shelves on a 
fixture. 

Note: This functionality has now been largely superseded by 
connections. If specified, connection lines will overwrite this 
spacing. 

Slot Spacing gives the distance between successive shelves. 

First Slot Number gives the height of the initial shelves. 

Measure from Bottom and Include First Shelf are not active in this implementation of 
Macro Space Management. 

About Merchandisable Areas, Product Blocks and Display Styles 

Options 

Merchandisable Areas 
A merchandisable area is an irregular cube shaped space associated with a specific 
fixture or shelf object. It delineates the volume relative to the dimensions of that object 
that can be filled with product. 

Note: Merchandisable areas are defined within the 
Merchandisable Areas Tab in the Block Definitions dialogue 
box. 

The merchandisable area is defined by specifying the two points that represent opposing 
corners of the cuboid. Accordingly, the geometry is simple and inflexible. 

Placeholders and Display Styles 
In the AutoCAD environment, all merchandise is displayed using placeholders. 

In the Virtual Reality environment, there are two forms in which merchandise can be 
displayed. 

 At Article (SKU) level and above, they are displayed in the form of placeholders, 
which indicate that a particular form of merchandise has been used to populate that 
section of the store. 

 Placeholders are simple geometrical shapes (such as cubes and cylinders) and have 
no surface detail. 

At Display Level, a product block containing a more detailed physical representation of 
the product is placed, the amount of detail depending on local settings. 
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In the above example, the lower shelf is populated with a placeholder; while the upper 
shelf has products displayed using three types of display style product blocks. (The 
plates are shown as graphical style product blocks, the boxes on the left as simple boxes 
and the boxes on the right as textured boxes. 

Product blocks for Fixtures and Shelf Objects 
Because the merchandisable area is of simple geometry, fixtures and shelf objects need to 
have default product blocks associated with them in their block definitions. These default 
product blocks can be of more complex shapes, for example cylinders, hemispheres, 
hexagons, etc. Only a single design of each class of product block is required as their 
dimensions are scaleable. When placed on a fixture or shelf object product blocks expand 
to the maximum dimensions permitted by the merchandisable area. Thus a single 
cylindrical product block can be used for wide range of fixtures and shelf objects. 

The Product Block will subsequently be used to define the volume occupied by a 
placeholder. For example, a circular table must still have a cubic merchandisable area 
defined, as all merchandisable areas have to be simple cuboids. 

 
In the above diagram, the merchandisable area is represented by the cuboid with the 
heavy black outline. However, if this cuboid was merchandised directly with a 
placeholder, i t would result in product being shown beyond the actual surface of the 
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fixture. Accordingly, a cylindrical Product Block is associated with the fixture. This 
expands to the limits set by the merchandisable area and represents the limits that will be 
shown as occupied by a placeholder. 

Merchandising with Product Blocks and Placeholders/Display Styles 
1. Placeholders 

If a fixture or shelf object is merchandised with a placeholder, it will occupy the 
extents defined by the Merchandisable Area defined in block definitions. 

In the example below, the fixture on the left has a default Product Block assigned 
(green cylinder). It will not be required unless the fixture is merchandised by a 
placeholder. Because the default Product Block is scalable, i t will take up the size 
determined by the merchandisable area of the fixture. When the placeholder is then 
shown (yellow cylinder), i t takes up the volume defined by the product block, which 
has itself expanded to the extents determined by the merchandisable area. 

Note: If the specified Product Block had been hexagonal, 
then the placeholder would have been shown as a hexagonal 
shape, scales to the extents of the merchandisable area. 

A similar logic applies to other shapes of Product Block – they allow placeholders to 
be displayed in a number of geometries. 

 
2. Display Style Product Blocks 

If the same fixture is merchandised with a Display Style Product Block (the blue box 
in the right hand diagram) the display style product block will be placed within the 
limits set by the merchandisable area (the cuboid outlined in black). The display style 
product block then has to be moved within the limits of the actual merchandisable 
surface of the fixture using the alignment options available within Merchandiser. 

Note: The display style product block represents the actual 
dimensions of an instance of the merchandise being placed 
on a fixture. This means multiple instances of display style 
product blocks can be placed until the available volume 
defined by the merchandisable area is filled. 

 



About Merchandisable Areas, Product Blocks and Display Styles 

162 Oracle Retail Macro Space Management 

If a placeholder is used to represent merchandise, only a single instance is required, 
as this represents the volume occupied by a class of product, not individual items. 
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UDA (User Defined Attributes) Tab 

The UDA Tab 
The User Defined Attributes Tab is used to specify customized information for a block. 
This information can then be used for filtering or reporting purposes. 

 

Attribute Forms 
There are two forms of attribute: 

Fixed Attributes 
Fixed attributes are 'definition data' assigned to a specific block definition in Fixture. 
They are configured in the UDA dialog box accessed from the General menu of the 
Administration module. Values can then be set on a block-by-block basis in the Fixed 
Attributes frame in Fixture Studio. The list of fixed attributes is constant from block to 
block. This list cannot be varied - only the values assigned to it can. 

Variable Attributes 
Variable attributes differ in two ways from fixed attributes: 
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 The list of attributes assigned to a specific block can be varied. The list of fixed 
attributes in invariable. 

 Different values can be assigned to each instance of that block placed in a floor plan. 
 This allows information to be assigned on a case by case basis - for example whether 
a fixture is damaged or whether it has an incorrect planogram on it. 

This information can then be used for reporting or compliance purposes. Variable 
attributes are configured using the Edit Attribute Definitions option from the Edit menu 
in Fixture Studio. A list of possible options is assigned in the UDA tab of the Block 
Details dialog box. After an instance of the block has been placed in a floor plan, users 
can set individual values for each of the variable attributes by selecting the fixture/block 
and using the Show Attribute on the Fixturing Toolbar of the Object Browser. 

Configuring Fixed UDAs 
Setting up Fixed User Defined Attributes takes place in two stages. 

1. The User Defined attributes are configured in the Administration Module. 

2. The values for the User Defined Attribute are assigned on a case-by-case business to 
each block definition in Fixture Studio. 

Configuring Fixed UDAs in the Administration Module 
UDAs are configured in the Administration Module via the User Defined Attribute 
option from the General Module. 

 
See the Administration Module Help File for more information on how to accomplish 
this. 

Note: Only users with  Administrator's privileges can access 
the Administration Module 

Setting Values for Individual Block Definitions 
Once the User Defined Attributes have been configured in the Administration module, 
values can be set for individual block definitions. 
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The list of User Defined Attributes will appear in the left. The value can then be set on 
the right. It could be a text, date or Boolean value. Depending on settings in the Admin 
module, a default could already be assigned, or the numeric or text value confined to 
ones specified in a drop down list. Once assigned, the UDA could be used for filtering 
purposes - for example in refining a list of available fixtures in the Object Browser in the 
Planner or Merchandiser module. The UDA could also be used for filtering purposes in a 
report, for example in restricting data to a list of fixtures with a common characteristic. 

Note: The display of information in the object browser is 
controlled by data in the Custom SQL table in the database. 
This can only be modified by users with  access rights to the 
database. 

Configuring Variable Attributes 
Setting up Variable Attributes takes place in two stages. 

1. The Variable Attributes are configured using the Edit Attribute Definitions option on 
the Edit menu. 

2. The variable attributes that can be set are then assigned to individual blocks. 

When an instance of that block is placed in a floor plan then the values of the variable 
attributes that have been assigned to that block can be set in the Planner and 
Merchandiser modules. These values can also be set in In-Store Space Collaboration - this 
enables tasks such as store survey or compliance to be carried out. 

Configuring Variable Attributes 
Variable Attributes are configured using the Edit Attribute Definitions option on the Edit 
menu. This will bring up the Attribute Definitions dialog box. Variable Attribute 
definitions can then be added, edited or deleted by means of the options on the toolbar. 
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Date set in this dialog box will appear in the UDA tab of the Block Details dialog box and 
in the Attributes dialog box in the Planner and Merchandiser modules and in In-Store 
Space Collaboration. 

 ID - this cannot be edited and is automatically assigned by the software. 

 Name - this is the name given to the Variable Attribute. 

 Data Type - this is set from a drop down list and is determined by the type of 
information to be stored. The options are as follows: 

Data Type Description 

String Used for text values. 

Integer Used for whole numbers: 1, 2, 3, etc. 

Long Used for fractional numbers1123.456, etc. 

Single  Can be used as a substitute for Long. 

Double Can be used as a substitute for Long. 

Boolean Used for Yes/No options (with check boxes). 

Currency Used for financial values. 

Image Not in use. 

 Control type - this specifies the type of control to be used in the Attributes dialog box 
in the Planner and Merchandiser modules and in In-Store Space Collaboration. 

Control 
Type 

Description 

Text Box A box for text, numbers or monetary values to be entered. 

Drop Down 
List 

Drop down list of preset values, normally used in conjunction with options in the 
Lookup field. Text can also be typed in. 

Check Box A checkbox for Yes/No options, normally used with the Boolean option. 

 Mandatory - if checked, this will force the user to assign a value in the Attributes 
dialog box in the Planner and Merchandiser modules and in In-Store Space 
Collaboration before that dialog box can be closed. 

 Sequence - this determines the order the options will be displayed in the Attributes 
dialog box in the Planner and Merchandiser modules and in In-Store Space 
Collaboration. 

 Tab - this option is not currently in use. 
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 Lookups - this enables the user to populate a predefined list of options for drop 
down lists. Each options is separated from the next by a 'pipe' - for example Value 
1|Value 2|Value 3. 

Note: in order to ensure the value is stored, press Return 
after entering it. 

Once all values have been assigned, they can be saved back to the database by using the 
Exit option. 

Assigning Variable Attributes to Individual Blocks 
After configuration in the Attribute Definitions dialog box, the list of Variable Attributes 
will appear in the left hand side of the Variable Attributes frame of the UDA tab on the 
block details dialog box. 

 

 The '>' button can be used to add Variable Attributes to the list on the right hand 
side. This list will be displayed when the Attributes dialog box is invoked in the 
Planner and Merchandiser modules and in In-Store Space Collaboration. 

 The '<' button can be used to remove Variable Attributes from the list on the right 
hand side. 

Using Variable UDAs 

Variable Attributes 
Variable attributes are used for reporting purposes - particularly for compliance. They 
allow specific values to be assigned to individual instances for a fixture placed in a floor 
plan in the Planner or Merchandiser modules or in In-Store Space Collaboration. They 
are used in a three stage process: 

1. A list of variable attributes is created in Fixture Studio. 

2. Those attributes are assigned to specific blocks via the Block Details dialog box in 
Fixture Studio. 

3. Individual fixtures, fittings or shelf objects can then be selected in a floor plan and 
values assigned to the variable attributes. 

Creating the List of Variable Attributes 
Selecting Edit Attribute Definitions from the Edit menu brings up the Attribute 
Definitions dialog box. This is used to configure a list of variable attributes that can be 
assigned to fixtures on the UDA tab of the Block Details dialog box. 

Attributes are configured as follows: 
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Item Description 

ID This will be assigned automatically by the software. 

Name This is the name of the attribute. It will appear in the Block.  

Data type This is the form of the data that will be entered. 

Control Type 
This is the form of control used to accept date in the Planner and Merchandiser 
modules and in In-Store space Collaboration. It can be a check box, drop down list 
or text box. 

Mandatory 

This is whether the data is mandatory or not. This option should be used with 
caution as the Attributes dialog box cannot be closed in the Planner or 
Merchandiser modules or in In-Store Space Collaboration without the mandatory 
information being present. 

Sequence 
This is the order the information will be displayed in the Attributes dialog box in 
the Planner or Merchandiser modules or in In-Store Space Collaboration. 

Tag This option is not presently in use and can be left blank. 

Lookups This is used to populate a drop down list (if in use).  

Assigning Variable Attributes to fixtures in  Fixture Studio 
Once attributes are set up, they are assigned to individual blocks in the UDA tab of the 
block details dialog box. The attributes can be added (or removed) from the list of those 
that will display be means of the >  or < buttons. 
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Using Variable Attributes 
Once the Variable Attributes have been assigned and saved, they can then be used to set 
'instance' data for fixtures placed in a floor plan in the Planner or Merchandiser modules 
on in In-Store Space Collaboration. This is done by selecting one or more fixtures in the 
floor plan and then clicking the attributes icon on the Fixturing toolbar in the Object 
Browser. This will bring up the Attributes dialog box. 
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Information can then be entered and saved on a fixture by fixture basis. This can then be 
used for reporting purposes. For example, a KPI could be created to show all fixtures 
with incorrect planograms. This would mean an In-Store Space Collaboration user in an 
individual store could mark up planograms on site and a Macro Space Management user 
at headquarters could then see where reality in the store differed from what was in the 
floor plan. 

Within the Planner and Merchandiser modules (and in In-Store Space Collaboration) 
Variable Attributes can be set for individual fixtures by selecting a fixture, then clicking 
the Show Attribute option on the toolbar. 

 
This will bring up the Attributes dialog box. 
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This will contain a list of attributes specific to that block in that floor plan that were 
assigned in the UDA tab of the Block Details dialog box in Fixture Studio. The values for 
that instance of the block can then be set accordingly. In the above example, the variable 
attributes allow an In-Store Space Collaboration user to set values based on a Store 
Survey or Compliance Check. Once set, the values can then be read in Macro Space 
Management if the floor plan is opened in the Planner or Merchandiser modules and the 
attributes displayed for the appropriate fixtures. Alternatively, the assigned attributes 
can be used for reporting purposes. 
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20 
Styles/Ranges Tab 

The Styles/Ranges Tab 
The Styles/Ranges Tab has two purposes: to set the styles for items of equipment, and to 
specify any ranges for physical parameters limiting the shelves and products than can be 
placed on that parent fixture or shelf. They are assigned to both fixtures and shelves. 
Both styles and ranges are configured in the Administration module. 

 
The style options are as follows: 

Option  Description 

Available 
Styles 

This is the list of styles that can be selected. If the item of equipment is a fixture, only 
fixture styles will be visible. if the item of equipment is a shelf,  both fixture and shelf 
styles will be visible. 

Selected 
Styles 

These are the styles to be used for that specific item of equipment. If a fixture, a 
fixture style must be selected.  If a shelf object, both a fixture style and a shelf style 
must be selected. 

The range is set from a configurable drop down list. 
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Overview of Styles 
Styles are used in as filters in the Planner and Merchandiser modules and in In-Store 
Space Collaboration, primarily to avoid incorrect placement of shelves, products and 
planograms. There are a variety of styles and style relationships. 

 
 

Style 
Relationship Description 

Fixture - Shelf 
Fixtures are assigned a fixture style. Shelves are also assigned a fixture style. 
When placing shelves onto fixtures in the merchandiser the two styles must match 
or the shelf cannot be placed 

Shelf - Product 

Shelf objects are assigned a shelf style. Products are assigned a product style in 
Product Studio. If a relationship has been set up between the two in the 
Administration module, the product can be placed in Merchandiser. 
Shelf/Product styles do not affect product placement in Planner on In-Store Space 
Collaboration.  

Fixture - 
Product 

Fixtures are assigned a fixture style. Products are assigned a product style in 
Product Studio. If a relationship has been set up between the two in the 
Administration module, the product can be placed in Merchandiser. 
Fixture/Product styles do not affect product placement in Planner on In-Store 
Space Collaboration.  

Fixture - Joint - 
Product 

This represents a special case. Joints can be set up in the Administration module. 
These represent a fixture-shelf-product style relationship. If a user them places 
that product directly on a fixture in Merchandiser, the shelf object is automatically 
placed as well. This is most common when placing a product on a pegboard - 
placing the product causes the peg to be placed as well.  
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Style 
Relationship Description 

Fixture - 
Planogram 

Both the fixture and the planogram have fixture styles associated with them. If an 
attempt is made to place a planogram of a fixture that does not match the style 
associated with the planogram, a warning will result.  

Overview of Ranges 
Ranges are used as filters in the Planner and Merchandiser modules and in In-store Space 
Collaboration, primarily as a filter to ensure that planograms are not placed on 
incompatible equipment. For example, a planogram containing ice cream should be 
placed on freezers to prevent the ice cream melting when actually placed in the store. 

Working with Styles 
The Available Styles Tab contains a list of styles that have been defined in the 
Administration Module. If a fixture, the list will only contain Fixture styles. If a shelf, the 
list will contain both fixture and shelf styles. 

 

The style options are as follows: 

Option  Description 

Available 
Styles 

This is the list of styles that can be selected. If the item of equipment if a fixture, only 
fixture styles will be visible. if the item of equipment is a shelf,   
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Option  Description 

Selected 
Styles 

These are the styles to be used for that specific item of equipment. if ta fixture, a 
fixture style must be selected.  If a shelf object, both a fixture style and a shelf style 
must be selected. 

Managing the List of Selected Styles 

 
To add a style to the Selected Styles list, highlight the part in the Available Styles frame 
and use the Add arrow. Alternatively highlight and double click on the style in the 
Available Styles frame. Depending on the block, the styles will define the type of 
equipment it can connect with, and (if a shelf or fixture) the type of merchandise it can 
accept. 

To remove a part from the Selected Styles list, highlight the part in the Selected Styles 
frame and use the Remove arrow. Alternatively highlight and double click on the part in 
the Selected Styles frame. 

Configuration Module 
Whether Styles are used for filtering purposes in Macro Space Planning depends on 
settings the Check Rules frame of the Merchandising Tab in the Configuration Module - 
these are local settings that only a ffect the user making them. 

 

Planner and Merchandiser Modules 
If the range option has been turned on for an individual user in the Configuration 
Module, it will trigger a warning if the ranges on equipment and merchandise do not 
match when placing planograms. 
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In addition, if the user tries to place a Display Style product on an incompatible fixture or 
shelf in Merchandiser, a warning will result. 

 

In-Store Space Collaboration 
Styles can be used as a filter when placing planograms in In-Store Space Collaboration. 
This option is set in the Planogram Filter dialog box. 

 
If this option is selected, a warning will come up when the user tries to place a 
planogram. This warning can be overridden by the user, but they will have been alerted 
to a problem. 

 

Where Styles are Assigned 
Styles can be assigned to Fixtures, Shelf Objects, Products and Planograms. 
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Assigning Styles 

Fixtures 
Fixture Styles are assigned in the Fixture Studio Module in the Styles tab of the Block 
Details dialog box. A Fixture is required to have a Fixture style assigned. Only Fixture 
Styles will be available for selection in the Styles/Ranges Tab. 

 

Note: Whether an object is designated as a fixture is set in 
the Categories tab. 

Shelf Objects 
Both Fixture and Shelf Styles are assigned in the Fixture Studio Module in the Styles tab 
of the Block Details dialog box. A Shelf Object is required to have both Fixture and Shelf 
styles assigned. Both Fixture and Shelf Styles will be available for selection in the 
Styles/Ranges Tab. 
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Note: Whether an object is designated as a Shelf Object is set 
in the Categories tab. 

Products 
Only Products at Display Style Level can be assigned Styles. This is done in the Styles 
Tab of the Display Style dialog box in Product Studio. 
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Only Product Styles will be available for Selection. 

Planograms 
Planograms are assigned Fixture Styles in the Planogram Design dialog box in the 
Merchandiser Module. 
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Only Fixture Styles will be displayed. 

Range Options 
The Range Options  frame allows the user to set a permissible temperature range for the 
fixture/shelf. This is compared with the temperature range for any display style level 
merchandise placed in Merchandiser. The merchandise can be placed if the temperature 
ranges match, but will be rejected if they do not. 

Note: Temperature Ranges can also be used as a filter when 
placing planograms in In-Store Space Collaboration. 
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Temperature ranges are configured in the Administration module (Merchandising Menu 
> Ranges). They are then assigned to Fixtures and Shelf Objects in Fixture Studio. 
Temperature ranges can also be assigned to Products in Product Studio and to 
Planograms in Merchandiser (or can be imported with product or planogram 
information). 

Options 

Configuration Module 
Whether Ranges are used for filtering purposes in Macro Space Planning depends on 
settings the Check Rules frame of the Merchandising Tab in the Configuration Module - 
these are local settings that only a ffect the user making them. 
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Planner and Merchandiser Modules 
If the range option has been turned on for an individual user in the Configuration 
Module, it will trigger a warning if the ranges on equipment and merchandise do not 
match when placing planograms. 

 
In addition, if the user tries to place a Display Style product on an incompatible fixture or 
shelf in Merchandiser, a warning will result. 

 

In-Store Space Collaboration 
Ranges can be used as a filter when placing planograms in In-Store Space Collaboration. 
This option is set in the Planogram Filter dialog box. 
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If this option is selected, a warning will come up when the user tries to place a 
planogram. This warning can be overridden by the user, but they will have been alerted 
to a problem. 

 

Where Ranges are Assigned 
Temperature Ranges can be assigned  to Fixtures, Shelf Objects, Products and 
Planograms. 

Assigning Ranges 

Fixtures and Shelf Objects 
Ranges are assigned to fixtures and shelf objects in the Fixture Studio Module in the 
Styles tab of the Block Details dialog box.  
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Products 
Only Products at SKU Style Level can be assigned Temperature Ranges. This is done in 
the Styles Tab of the Display Style dialog box in Product Studio. The temperature range 
selected is then reflected in any Display Styles created as children of the SKU. 

 

Planograms 
Planograms are assigned Fixture Styles in the Planogram Design dialog box in the 
Merchandiser Module. 
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Merchandisable Areas Tab 

The Merchandisable Areas Tab 
The Merchandisable Areas Tab is used to indicate the extents of the space that 
merchandise can take up on the fixture or shelf object. 

 

There are two types of merchandisable areas - Primary Area or Further Area. The two are 
mutually exclusive - you can have a Primary Area or Further Areas, but not both. 

Types of Merchandisable Areas 
There are two types of merchandisable area; primary and further. The two are mutually 
exclusive: if you define further merchandisable areas, you cannot define a primary 
merchandisable area. 

Primary Area 
This option is used when there only one merchandisable area is required on a fixture or 
shelf object. In the example below, the fixture on the left shows a primary 
merchandisable area assigned to a chiller unit. The cross on the shelf on the right shows 
that it has been assigned a primary merchandisable area that in unconfined (unlimited) 
in the Z (height) axis. 
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Primary areas can be used with both fixed size and stretchable blocks. 

Further Area 
Further Areas are used when multiple merchandisable areas are required. In the example 
below, the freezer has a permanent internal divider and thus has been assigned 'left' and 
'right' merchandisable areas. Further areas are normally only used for fixed size blocks. 

 

Note: if a Primary Area has been assigned and a user defines 
a Further Area, the Primary Area will be disabled. 

The Primary Areas Frame 
The Primary Area Frame allows the user to specify the Primary Merchandisable Area. 
The Pick options will only be active if Fixture Studio is connected to Planner (File menu) 
and there is an instance of the block in the currently active drawing. 

Note: if a Primary Area has been assigned and a user defines 
a Further Area, the Primary Area will be disabled. 

Primary Merchandisable Areas can be used in conjunction with stretchable fixtures. 
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They are defined as a cuboid with reference to the extents of the fixture. Offset 1 defines 
the starting point of the Primary Area relative to the bottom-back-left corner of the 
fixture. Offset 2 defines the diagonally opposite corner of the Primary Area. This is 
relative to the top-front-right corner of the fixture 

 
The offsets work relative to the extents of the block. A positive value brings the corner of 
the cuboid inside of the extents of the fixture, while a negative value moves it outside. 
This can be seen in the diagram below. 
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The position of the Merchandisable area is also affected by the Child Insertion Position 
set in the Insertion tab. 

 

 If the Child Insertion position is set to bottom, the bottom-back-left corner of the 
merchandisable area will be aligned relative to the AutoCAD insertion pint of the 
fixture. 

 If the Child Insertion position is set to middle, the centre of the back-left-side of the 
merchandisable area will be aligned relative to the AutoCAD insertion pint of the 
fixture. 

 If the Child Insertion position is set to top, the top back-left corner of the 
merchandisable area will be aligned relative to the AutoCAD insertion pint of the 
fixture. 

Normally, the Child Insertion Point would be set to bottom for fixtures that are to have 
merchandise stacked on them and to top for pegs or other shelf objects, where 
merchandise will hang. 
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In the above example, the fixture has the Child Insertion Position set to Bottom, and the 
Rod has the Child Insertion Position set to Top. Setting up the merchandisable areas for 
the two types of object requires slightly different techniques. These are explained in the 
worked examples that follow. 

The size of the defined Primary area is shown towards the right of the frame, while the 
unconstrained check boxes allow merchandise to extend for any distance in that 
direction. If unconstrained areas are specified, these will be indicated by 'plus' or minus' 
symbols in the preview tab. 

 

Note: The unconstrained check boxes are normally only used 
with pegs and rods. 

Additional Fixture Height 
The height of a primary merchandisable area can also be affected by the 
ADDITIONAL_FIXTURE_HEIGHT system variable.  This global setting can add a 
specified additional height to all Primary Areas. It is configured in the Administration 
module. 

Configuring a Primary Merchandisable Area for a Fixture 
Primary Merchandisable Areas are configured in the Primary Areas frame. 
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In the specially created example fixture below, the fixture has a base and back. The 
merchandisable area has to take those into account. This example will show how to 
create that merchandisable area. 

 

Configuration 

AutoCAD ID Command 
When identifying the coordinates that identify the extents of each merchandisable area, 
the AutoCAD ID command can be useful. 
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Position the fixture which is having its merchandisable areas configured with its 
insertion point at 0,0,0. and type ID into the command line. The user will be invited to 
pick a point. When OSNAP is turned on, a precise point can be picked on the fixture. The 
coordinates of the point will then be shown on the command line. 

. 

Starting Condition of the Primary Area Frame 
For a new block (fixture) the frame will be blank. 

 

Before Starting 
Ensure that the Insertion Point and Child Insertion Point (Insertion Tab) are 
appropriately set. In this case both have been set to bottom-back-left. 

Creating the Primary Area 
In order to create the primary area, two offsets have to be entered. Offset 1 defines the 
starting point of the Primary Area relative to the bottom-back-left corner of the fixture. 
Offset 2 defines the diagonally opposite corner of the Primary Area. This is relative to the 
top-front-right corner of the fixture 
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For the bottom-back-left corner, it is necessary to allow for the thickness of the back and 
the base of the fixture. Positive coordinates move the positions of the merchandisable 
areas inside the fixture, so coordinates of 0,6,6 are required. This leaves the position of 
the corner relative to the X Axis unchanged, but moves it up 6 units and forward 6 units. 
For the top-front-right corner, there is no need to change the coordinates. Accordingly, 
the defaults of 0,0,0 can be left unchanged. 

The settings look as follows - the size of the merchandisable area is shown towards the 
right. 

 
And the end result looks as follows: 

 
If the fixture has been defined as stretchable; when the dimensions of the fixture are 
specified in the floor plan, the merchandisable area will move relative to those 
dimensions and extend for the specified portion of the fixture. 

Configuring a Primary Merchandisable Area for Circular Fixtures 
Primary Merchandisable Areas for Circular Fixtures are configured in the Primary Areas 
frame. 
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There are two 'special cases' provided for in the Category Tab. These are selected by 
setting the drop down list in the Graphics frame to Circular or Semi-Circular. 

 

 
This example will show how to create a primary merchandisable area for a circular 
fixture - a semi-circular fixture follows exactly the same principles. 



Configuring a Primary Merchandisable Area for Circular Fixtures 

196 Oracle Retail Macro Space Management 

Note: the shape must previously have been set to Circular in 
the Category tab. 

Settings 

Starting Condition of the Primary Area Frame 
For a new block (fixture) the frame will be blank. 

 

Before Starting 
Ensure that the Insertion Point and Child Insertion Point (Insertion Tab) are 
appropriately set. 

Creating the Primary Area 
In order to create the primary area, two offsets have to be entered. The data in Offset 1is 
used to specify the height of the primary area relative to the AutoCAD insertion point of 
the block. This necessitates entering a value for the Z (vertical) axis. Offset 2 defines the 
diameter of the primary area relative to that of the block. Entering a pair of values for the 
X and Y values will alter that diameter. The settings look as follows - the size of the 
merchandisable area is shown towards the right. 

 
 Offset 1 is set to a value of 6 for the Z axis. Positive offsets move the starting point of 

the merchandisable area inside the fixture. In this case the value of the offset moves 
the start of the merchandisable area to the top face of the block. 

 Offset 2 is set to a Z value of -36. Negative offsets move the starting point of the 
merchandisable area outside of the fixture - in this case 36 inches above the top face 
of the block. The X and Y offsets are set to 6. Positive offsets move the starting point 
of the merchandisable area inside the fixture - in this case making the 
merchandisable area 6 inches less in diameter than the diameter of the block. 

The end result looks as follows: 
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If the fixture has been defined as stretchable; when the dimensions of the fixture are 
specified in the floor plan, the merchandisable area will move relative to those 
dimensions and extend for the specified portion of the fixture. 

Configuring a Primary Merchandisable Area for a Peg or a Rod 
Primary Merchandisable Areas are configured in the Primary Areas frame. 

 

In the specially created example fixture below, a rod is represented by a simple cylinder. 
The merchandisable area has to take those into account. This example will show how to 
create that merchandisable area. 
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Settings 

Setting the Child Insertion Position 
The first stage is to set the Child Insertion position. 

 
This must be set to Top for a Peg or Rod. 

Starting Condition of the Primary Area Frame 
For a new block (fixture) the frame will be blank. 

 

Before Starting 
Ensure that the Insertion Point is appropriately set. For most pegs and rods, this will be 
middle-back-centre. 

Offset 1 and Offset 2 
The positions of the two offset points have changed slightly. Offset 1 is now top-back-left 
and Offset 2 is bottom-front-right. 
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Negative values take the merchandisable area outside the extents of the rod. In this case 
we want the merchandisable area to extend three units to the side. Offset 1 is thus set to -
3,0,0. We also want the merchandisable area to extend three units to the other side and 
twelve units down. Offset 2 is thus set to -3, 0,-12. 

The settings look as follows - the size of the merchandisable area is shown towards the 
right. 

 
And the end result looks as follows: 

 
The size is shown towards the right of the frame. Although the height of the 
merchandisable area has been set to 12 units, this has been overridden by the software 
and any height of package can be hung from the rod (subject to not sharing the same 
space with other merchandise). At present the maximum width of packaging that can be 
hung from the rod is six inches. This can be overridden by ticking the 'Y' unconstrained 
check boxes. 

Note: using the unconstrained option should only be used if 
the working axis (Category tab) is set to 'Y' and there are no 
stacking axes set. 
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Configuring a Primary Merchandisable Area for Non-Rectangular Areas 

Overview 
Most fixtures or shelves are rectangular, circular or semi-circular in section. Occasionally 
however, fixtures or shelves are less regular in shape. Fixture Studio provides a way of 
delineating the boundary of an irregularly shaped merchandisable area. 

 

This is achieved by using functionality accessed on the category tab of the Block Details 
dialog box in Fixture Studio. The steps are as follows: 

1. Open Fixture Studio and Planner. 

2. Select the Connect to AutoCAD option on the file menu. 

3. Open the required object for editing in Fixture Studio (Block Details dialog box). 

4. Set the shape to Triangular on the Category tab and click the Pick button - this will 
open a raw AutoCAD drawing in with the extents of the object outlined in yellow. 

5. Use the Load Blocks into Drawing command on the File Menu to load an instance of 
the block into the drawing. 

6. Draw the shape of the object in the drawing. 

7. Delete the instance of the block in the drawing 

8. Close the temporary drawing without saving it. 

9. If necessary reset the dimensions of the fixture using the Calculate button. 

10. Save the Block in Fixture Studio. 

The result has associated a boundary with the block that defines the horizontal contours 
of the merchandisable area. The block will then only accept merchandise within that 
defined area. 

 

Note: How to configure Merchandisable Areas for non-
rectangular areas is described in the section for the 
Merchandisable areas tab. 
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Operations in the Category Tab 
In order to define the shape of a non-rectangular area, select the Connect To AutoCAD 
option on the File menu. This will connect Fixture studio to the Planner module. Next 
open the Block Details dialog box for that fixture. 

Switching to AutoCAD 
In the Category Tab of the Block Details dialog box select Triangular from the drop down 
list in the Graphics Frame. If Fixture Studio is connected to AutoCAD, this will make the 
pick button next to it active. Click the pick button and the user will be taken to the 
Planner module where a 'raw' AutoCAD drawing will open. 

 
The raw AutoCAD drawing will have a yellow rectangle in it. This represents the extents 
of the block. Its origin will be at 0,0 in the drawing. 

 

Loading the block into the Raw AutoCAD Drawing 
In Fixture Studio, highlight the block in the fixture hierarchy and select the Load Blocks 
into Drawing option from the File Menu. The block will be drawn with its insertion 
point at 0,0, overlaying the yellow rectangle representing the extents. 
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Drawing the Shape of the Irregular Area 
Using the fixtures as a guide, draw in a boundary representing the area that can be used 
for merchandising purposes. The boundary should be drawn with a polyline (PLINE in 
the AutoCAD command line) and the Close command should be used to ensure that the 
boundary is a single continuous line. AutoCAD's OSNAP functionality can be used to 
accurately follow the required outline. 

 

Note: The outline here has been drawn in red for clarity - 
normally it would be the same color of the block. 

Next, delete the instance of the block from the drawing, leaving behind the outline of the 
irregular area. 

 

Close the AutoCAD drawing without Saving 
The next action is to close the AutoCAD drawing without saving it. This may sound 
counter-intuitive, but Fixture Studio has stored the coordinates for the outline in 
memory. Closing the drawing may be down by clicking the small 'x' at the top right 
corner and then stating you do not wish to save the drawing when a confirmatory dialog 
box appears. After the confirmatory dialog box has gone, the AutoCAD drawing may not 
immediately close. This is because if the boundary of the non-rectangular area has been 
drawn inside the extents of the block (for example for a fixture), Fixture Studio will 
change the extents of the block. This will be confirmed by a dialog box. 
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Click the OK button and the AutoCAD drawing will close. To reset the extents of the 
block back to the original value, click the Calculate button in the Actual Size frame of the 
Size tab. 

 

Save the Block in  Fixture Studio 
The final stage is to save the block in Fixture Studio. This is done by highlighting the 
block in the fixture hierarchy and selecting the Save option from the file menu. It is only 
necessary to write the information back to the database. 

Operations in the Merchandisable Areas Tab 
The next stage is to define the size of the merchandisable area in the Merchandisable 
Areas tab. 

Starting Condition of the Primary Area Frame 
For a new block (fixture) the frame will be blank. 

 

Before Starting 
Ensure that the Insertion Point and Child Insertion Point (Insertion Tab) are 
appropriately set. 
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Creating the Primary Area 

In order to create the primary area, two offsets have to be entered. The data in Offset 1is 
used to specify the height of the primary area relative to the AutoCAD insertion point of 
the block. This necessitates entering a value for the Z (vertical) axis. Offset 2 can be used 
to specify the height of the primary area relative to the top of the block. This necessitates 
entering a value for the Z (vertical) axis. The settings look as follows - the size of the 
merchandisable area is shown towards the right. 

 
These work in combination with the non-rectangular area defined in the first stage. 
Offset 1 defines the bottom, back left corner. Offset 2 defines to top, front right 
corner, thus defining the starting position and height. The actual shape follows the 
non-rectangular area defined earlier. 

 
In this example: 

 Offset 1 is set to a value of 3 for the Z axis. Positive offsets move the starting point of 
the merchandisable area inside the fixture. In this case the value of the offset moves 
the start of the merchandisable area to the top face of the base of the block. 

 Offset 2 has no settings. This is because the top of the merchandisable area is already 
correctly positioned at the top-front-right corner of the block. 

 There is no need to enter X or Y coordinates for the primary area. This is read from 
data stored when the 'triangular' area was defined in the Category tab. 

If the fixture has been defined as stretchable; when the dimensions of the fixture are 
specified in the floor plan, the merchandisable area will move relative to those 
dimensions and extend for the specified portion of the fixture. 

The Further Areas Frame 
The Further Areas frame allows other merchandisable areas to be specified. Further 
Areas are of fixed size and are not normally used with stretchable blocks. 

Note: if a Primary Area has been assigned and a user defines 
a Further Area, the Primary Area will be disabled. 
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Settings 

Names 
Entering data into the text box and pressing Return will enter the name of a Further Area 
into the grid below. Highlighting the name of a Further Area and pressing Delete will 
remove it. Highlighting the name of a Further Area in the list will enable the data on the 
right hand side to be entered or edited. 

Dimensions 
The pair of X, Y, Z coordinates is used to specify the bounds of the Further 
Merchandisable area. The left hand set of X, Y and Z coordinates is used to specify the 
bottom-back-left corner of a cuboid. The right hand set of X, Y and Z coordinates is used 
to specify the top-front-right corner of a cuboid - the dimensions of this cuboid are 
relative to the first set of points. For example the two sets of points 6,6,6 and 12,18,24 
describe a cuboid with its origin at 6,6,6. It has a length of 12 units, a depth of 18 and a 
height of 24. 

The Pick buttons can be used to toggle the user to the currently active drawing in 
Planner. If an instance of the block is present, the user can pick the required points rather 
than manually enter them. 

Note: The pick buttons are currently not working correctly. 

The dimensions for the origin of the further merchandisable area obey a standard 
Cartesian coordinate system drawn relative to the insertion point of the block as defined 
in AutoCAD (Planner). The directions of the axes in this coordinate system are shown 
below.  
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Horizontal and Vertical Angle 
These options determine the orientation of the cuboid defined by the directions. This 
orientation can be changed by means of the Horizontal Angle and Vertical Angle 
controls. The effects of these controls are shown in the diagram below. 
  

 

Note: the Horizontal Angle is often set to correspond with 
the Front direction of the fixture (Insertion tab). 

Origin of Further Area 
The origin of the further area (the first set of X, Y, Z coordinates) is indicated by an 'X'. 
This has been exaggerated in size in the diagram below for clarity - it is normally 
significantly smaller. 
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Configuring Further Merchandisable Areas 
Further Merchandisable Areas are configured in the Further Areas frame. 

 
In the specially created example fixture below, the fixture has two merchandisable area; 
left (green) and right (blue). This allows merchandise to be placed taking into account the 
thickness of the base, rear and internal dividing wall. This example will show how to 
create those merchandisable areas 

 

Settings 

AutoCAD ID Command 
When identifying the coordinates that identify the extents of each merchandisable area, 
the AutoCAD ID command can be useful. 
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Position the fixture which is having its merchandisable areas configured with its 
insertion point at 0,0,0 and type ID into the command line. The user will be invited to 
pick a point. When OSNAP is turned on, a precise point can be picked on the fixture. The 
coordinates of the point will then be shown on the command line. 

. 

Starting Condition of the Further Areas Frame 
For a new block (fixture) the frame will be blank with no Further Areas added. The 
options will be grayed out and unavailable until a name has been entered and Return 
pressed. 

 

Before Starting 
Ensure that the Insertion Point and Child Insertion Point (Insertion Tab) are 
appropriately set. In this case both have been set to bottom-back-left. 

Creating the Left Hand Area 

The first stage is to enter the name of the Further Merchandisable Area in the text box 
and press Return - in this case 'Left'. The name will appear in the list of available names. 
Highlighting it will activate the rest of the frame, which until now will have been grayed 
out.  The next stage is to set the dimensions. We need to set them for the bottom-back-left 
and top-front-right corners of a cuboid. The coordinates for the bottom-back-left point 
are 0,-6, 6. These define the starting point of the cuboid. The next set of coordinates 
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(12,18,24) define the volume of the cuboid - 12 units in positive X, 18 units in positive Y, 
24 units in positive Z. 

 
The Horizontal angle is set to 270 degrees. This matches the front direction of the fixture. 
The Vertical Angle is set to 0 degrees as the Further Area is parallel to the ground. 

 
The settings look as follows: 

 
And the end result looks as follows: 
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Creating the Right Hand Area 
The right hand is created in the same way as the left, except the first set of coordinates is 
set to 21, -6, 6 because this Further Area starts in a different place. The second set of 
coordinates is the same because the Further Area is the same physical size. The settlings 
are as follows: 

 
The result is as follows (with the Left Further Area (colored green), and the Right Further 
Area (colored blue). 

 

Constrained and Unconstrained Merchandisable Areas 
Primary Merchandisable Areas can either be constrained or unconstrained. 

 Constrained Areas are areas that stay within the specified coordinates. 

 Unconstrained Areas may take up any volume in the specified direction. 

These options are set by checking the unconstrained check boxes in the Primary areas 
frame. 
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Unconstrained axes are shown visually in the Preview tab as plus or minus signs if the 
Merchandisable Area option is selected. 
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Shelf Tab 

The Shelf Tab 
The Shelf Tab can be used to define the permissible angles for shelves to be set at when 
placed on a fixture. This is only used in the Merchandiser module. Currently defined 
Angle Categories can be seen from the drop down list. 

 

These Angles can then be used as predefined values when assigning shelves in the 
Merchandiser module - the screenshot below is the Add shelves dialog box from that 
module. 
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Specifying Permissible Shelf Angles 
Angle categories many be created, edited or deleted. 

Creating an Angle Category 
To create an Angle Category, click on the Create button in the Angle Category frame. 

 

This will bring up the Shelf Angles dialogue box. 
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Type in the required Angle Category name then left click into the Angles box. (Do not 
press <Return> at this stage or it will close the dialogue box). Type the required angle in 
and press <Return>. Continue to type in the required angles and pressing return until the 
desired list of angles has been built up. 

 
When the required Angles have been entered, click OK to save the information to the 
database and close the dialogue box. 

Editing an Angle Category 
To Edit an Angle Category, select the required angle category in the drop down list. Click 
Edit in the Angle Category frame. This will bring up the Shelf Angles dialogue box. 
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The Shelf Group Name cannot be edited. The Angles can be edited by typing in the 
required angle and pressing return. When the required changes have been made, click on 
OK to save the information to the database and close the dialogue box. 

Deleting an Angle Category 
To delete an Angle Category, select the required angle category in the drop down list. 
Click Delete button in the Angle Category frame. The selected category will be deleted 
without further confirmation. 
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Preview Tab 

Overview of the Preview Tab 
The Preview Tab allows users to visually see merchandisable areas, connection points, 
the origin (insertion point) and the position of the first product placed on a fixture. 

 

Note: In order to display an image in the preview frame, a 
3DS file of that block must be present in the directory 
specified in the Category tab. 

In the above image, the shelf is enclosed by a red selection frame. 

 While the selection frame is present the fixture can be rotated by holding down the 
left mouse key and moving the mouse cursor around the fixture. Alternatively, 
different viewpoints can be adopted by clicking the icons in the Preview toolbar. 

 The selection frame can be removed by holding down the Control key and left 
clicking with the mouse on the fixture. (Alternatively use the <Escape Key>). While 
the selection frame is removed, the fixture can be moved on zoomed in and out on by 
holding down either the left or right mouse buttons and moving the mouse cursor 
around the fixture. Alternatively, different viewpoints can be adopted by clicking the 
icons in the Preview toolbar. 
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 The selection frame can be restored by holding down the Control key and left 
clicking with the mouse on the fixture. 

The Preview Tab Toolbar allows users to select the point of view for the displayed 
preview. 

 
 

Icon Description 

 

  
Front view of selected object 

 

  
Back view of selected object 

 

  
Top view of selected object 

 

  
Bottom view of selected object 

 

  
Left view of selected object 

 

  
Right view of selected object 

 

  
NW isometric view of selected object 

 

  
NE isometric view of selected object 

 

  
SE isometric view of selected object 

 

  
SW isometric view of selected object 

Merchandisable Areas Option 
The Merchandisable Areas option allows users to see the assigned merchandisable areas 
for a fixture or shelves represented as a colored box. Activate it by ticking the checkbox. 

Note: Fittings cannot have merchandisable areas so this 
option will be grayed out and unavailable.  
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Merchandisable Areas are configured in the Merchandisable Areas tab. The exact 
appearance of the merchandisable area depends on the form that has been configured. 

 
In the above example, the fixture on the left has a Primary Merchandisable Area, whiles 
the fixture in the centre shows two Further Merchandisable Areas; each distinguished by 
a different color. The shelf on the right shows a cross denoting a merchandisable area 
unbounded in a specific direction - in this case the Z axis.  Individual Users can set their 
preferred color for the primary merchandisable area by using the Merchandisable Area 
Color option in the Fixturing tab of the Configuration Module. 
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Connection Points Option 
The Connection Points option allows users to see the assigned connection points for a 
fixture, fitting or shelf object. Activate it by ticking the checkbox. In the example below, 
one connection point can be seen at the base of the fixture - this is used for connecting to 
other fixtures. Another set of connection points can be seen inside the fixture - these are 
used to ensure shelves position correctly. 
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Note: Connection Points are configured in the Connections 
tab. 

Individual Users can set their preferred display size and colors for the connection points 
in the Fixturing tab of the Configuration Module. 
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Origin Option 
The Origin  option allows users to see the assigned origin (set in the Insertion tab) for a 
fixture, fitting or shelf object. Activate it by ticking the checkbox. 

 
In the example below, the origin can be seen as a set of red, green and blue lines set at 90 
degrees to each other. 
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Blue Line Direction of X Axis 

Green Line Direction of Y Axis 

Red Line Direction of Z Axis 

Note: This origin point corresponds to that set in the 
Insertion tab. It does not correspond to the AutoCAD DWG 
file insertion point. 

First Product Option 
The First Product checkbox (if selected) allows users to see where the first product will 
place on a fixture or shelf object. It is determined by the Child Insertion Position in the 
Insertion tab. Activate it by ticking the checkbox. In the example below, the child 
Insertion Position has been set to Bottom-Back-Left and the first product is shown as 
placing accordingly within the bounds of the merchandisable area. 
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The Dragging Option 
The dragging option allows users to manually change the positions of connection points 
or change the size and position of the merchandisable areas. The option is selected by 
ticking the Enable Dragging check box. It will also be necessary to check a second option 
for either Merchandisable Areas or Connection Points. 

 

Connection Points 

Moving a Connection Point 
The first stage of dragging a connection point to a new position is to ensure the selection 
box around the object is de-selected by using Escape. The example below shows a shelf 
with and without a selection box. 

 
Select a connection point by holding down the Control key and left clicking on it. It will 
be enclosed in a red selection box. While holding down the control key, move the mouse 
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pointer over the selected connection point and hold down the left mouse key. The 
connection point can now be dragged to its new position. 

 

Rotating a Connection Point 
Select a connection point by holding down the Control key and left clicking on it. It will 
be enclosed in a red selection box. While holding down the control key, move the mouse 
pointer over the selected connection point and hold down the right mouse key. The 
connection point can now be dragged to its new angle or rotation. 

 

Connections Tab 
Changes made to connection points by dragging or rotating will be reflected in the 
Connections tab. Similarly, small changes in position can be made by changing the 
coordinates in the Connections tab, then confirming in the preview tab. 

Dragging a Merchandisable Area 
To drag a Merchandisable Area, select a fixture that has had one or more merchandisable 
areas assigned. Check the Merchandisable Areas and Enable Dragging check boxes. Next 
ensure that the fixture is de-selected and the merchandisable area selected. This can be 
done by holding down the Control key, then left clicking on the fixture to de-select it. The 
merchandisable area can then be selected by holding down the Control key, then left 
clicking on the merchandisable area to select it. 

 

In the example above, the fixture is shown as selected on the left, while the 
merchandisable area is shown as selected on the right. The merchandisable area can then 
be dragged by the mouse. Move the mouse pointer over the merchandisable area and 
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hold down the left mouse key. The merchandisable area can now be dragged to its new 
size. 

 

Merchandisable Areas Tab 
Changes made to merchandisable areas by dragging will be reflected in the 
Merchandisable Areas tab. Similarly, small changes in position can be made by changing 
the coordinates in the Merchandisable Areas tab, then confirming in the preview tab. 
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Special Types of Blocks 

Composite Blocks 
Composite blocks are 'super-blocks' made up of a number of individual AutoCAD 
blocks. In the example below the composite at the rear represents a combination of 
fixtures that might form a checkout installation. These include the checkout itself, a 
cupboard for storing bags, racking for holding products for last minute impulse buys and 
a chair for the checkout operator. These are shown in expanded form at the front of the 
diagram. 

 
Composites provide a simple way of repetitively placing combinations of objects. 
Examples of how composites could be used include: 

 Combinations of equipment - such as checkout complexes. 

 Entire departments of equipment. 

 Custom arrangements of equipment such as storage racking 

Composites are made by first creating the individual blocks, placing then into the correct 
alignment then making them into a composite block. Both the individual blocks and the 
composite block have to be registered in Fixture Studio. 

Composite Blocks and Merchandiser 
Composite blocks are not visible in the Fixture Hierarchy in Merchandiser. If unexploded 
composites are present in a floor plan, they will not be visible in the Merchandiser floor 
plan. 

Configuring Composite Blocks 
Composite blocks are 'super-blocks' made up of a number of individual AutoCAD 
blocks. In the example below a desk, chair and filing cabinet are going to be made into a 
composite for placing into offices in superstores. These are shown in composite form on 
the left and separated into their individual components on the right. 
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To make a composite block, the individual blocks must first have been created and 
registered in Fixture Studio. 

 
Next the individual blocks are inserted into a Planner drawing and put into the required 
alignment. 

 
There are then selected and the AutoCAD Block command used. 
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Once the composite block has been created, it can be registered in Fixture Studio using 
standard methods. The settings specific to a composite block in the Block Details dialog 
box are as follows: 

Category Tab 

 
 Set Retail type to Composite. This acts as a flag for some of the Macro Space Planning 

functionality, meaning that the composite block will be treated in a specific way. For 
example the composite block will not be visible in the Fixture Hierarchy in 
Merchandiser. 
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 Set the Icon to Composite. This will indicate to users in Planner that this particular 
block is a composite. 

Insertion Tab 

 
The Explode Block on Insert option must be checked. This will cause the composite to 
break up into its component parts when inserted into a floor plan. This is important 
because composite blocks are not visible in Merchandiser. 

Product Blocks 
Product blocks are used to represent the volume taken up by products. 

Overview of Product Blocks 

Planner 
In the Planner module product blocks are used as placeholders. They show the volume 
that products may occupy but give no information on product quantities. 

 
A different product block has to be created for each shape of fixture. In  the above 
example, three different forms of product block are required to suit the three different 
shapes of fixtures. 

Merchandiser 
In the Merchandiser module, product blocks can be used to represent the shape of the 
product at display style level. 
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In the above example, the left hand set of products is displayed as a Textured Box, the 
right hand set of products as a Graphical display using a product block to represent the 
shape of the products. 

Note: individual products have been given different colors 
for the purpose of this illustration. 

Creating the Product Block 
Product blocks are created in two stages: 

1. The Product Block is drawn in the Planner module. 

2. The Product Block is registered in Fixture Studio. 

Product Blocks can be used in the Planner module, the Merchandiser module, or 
both.  Depending on where they are used, they may require slightly different 
properties. 

 For the Planner module, the product block needs to be hatched so that it will stand 
out in a wire frame drawing 

 For the Merchandiser module, the DWG file for the product block needs to be 
converted into 3DS format so it can be displayed. If the product block is to be display 
in Merchandiser only, it does not require hatching. 

Drawing the Product Block 
The product block should be drawn in the planner module. If the product block is being 
drawn for the Planner module, its faces should be hatched. As hatching can only be 
carried out on flat surfaces, this restricts the form of the product block. The example 
below shows a triangular product block and (on the right) a partially exploded form 
showing how it was constructed. 
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Curved surfaces can be approximated by many sided polygons. In the example below a 
circular product block has been created from a 32 sided polygon. (The right hand side 
shows a partially exploded 

 
Alternatively more complex product blocks can be drawn purely for Merchandiser. In 
the example below, a desk shaped product block has been created in Planner (left side). 
When appropriately configured, this can be used to represent desks at Display Style level 
in the Merchandiser module. 

 
Once the product block has been drawn it can be made into an AutoCAD block and 
imported into Fixture Studio. 

Registering Product Blocks 
Product blocks are created in Planner and then designated as such in Fixture Studio. This 
is done by setting the Retail Type in the Equipment Type frame in Categories tab of the 
Block details dialog box to Product. 
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Assigning Product Blocks to F ixtures 
Product blocks are assigned to Fixtures in the Fixture tab of the Block Details dialog box 
in Fixture Studio. 

 
The assigned product block will then be used to display product placeholders when a 
product is placed in the Planner module. 

Assigning Product Blocks to Display Styles 
Product blocks are assigned to display styles in the Shape drop down list of the Size and 
Shape tab of the Display Style dialog box in Product Studio. 
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This product will be used when the 'Draw Products as option (right click menu) is set to 
Graphical in Product Studio. 

Reference Blocks 
Reference blocks are used for Bay and Aisle numbering. 

 
In the example above, the fixtures have been allocated bay numbers using a circular 
reference block, while the same reference block has been used to add the aisle number. 
Reference blocks are supplied with the application and there is not usually any need to 
change them. 

Overview of Title Blocks 
Title Blocks are used to add information to a floor plan in preparation for publishing it 
in hard copy or PDF form. Title Blocks can also contain information on the drawing. 
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Note: For a more complete explanation of title blocks see the 
Macro Space Management Administration Module Help File. 

 
 

Option Description 

Title Block 
This is a special form of AutoCAD DWG file that overlays the store plan on model 
space. It contains text based information on the floor plan and one or more View 
Ports to display the drawing. 

View Port The View Port (of which there may be one or several) can be a window cut through 
the title block to show the floor plan underneath. 

Title Block 
Information 

This is a series of fields that can be populated with specific items of information. In 
the example above data like the store code and store name are shown, but any 
information in the database can be configured to appear. 

Scaled Floor 
Plan 

The floor plan is visible through the View Port. It is set to a specific scale.  

Each Title Block is designed for a specific size of paper, so if drawings are to be printed 
off in a range of sizes, title blocks should be created for each size. A metric 
implementation of Macro Space Management may contain title blocks for A2, A3 and A4 
size paper, while and imperial one may contain title blocks for ANSI A, ANSI B, ANSI C, 
ANSI D and ANSI E size paper. 
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Using Title Blocks 
There are three ways title blocks can be used: 

Option Description 

Manually Publish 
from AutoCAD 

Once a title block has been added to a floor plan it can be published using 
AutoCAD Plot functionality. Using this method, floor plans can be published 
at any status. 

Publish Floor Plans 
from Planner 
module 

The Publish Floor Plans option on the File menu allows users to manually 
publish selected floor plans. Dependent on settings in the Floor Plan 
Publishing configuration dialog box, a title block can be included. 

Batch Publish Floor 
Plans 

Floor plans can be batch published - the normal way of publishing floor plans 
in bulk. The functionality allows a title block to be specified. 

Overview of Creating Title Blocks 
There are two stages to creating title blocks: preparation and configuration. 

Preparation 
There are two actions required for preparation. These are carried out at the 
implementation stage and will generally not be modified afterwards. 

 
 

Action Description 

Read in 
Canonical 
Media 

Canonical media is the AutoCAD term for paper size. These have to be read into 
the database from the network printers before floor plans can be published. 

Create Custom 
SQL 

Custom SQL is a slightly modified form of standard SQL. It can be used to extract 
information from the Macro Space Planning database so that it can be inserted into 
the title block. 

Configuration 
There are a series of steps to be following in order to create a title block and make it 
available for use in published floor plans. 

 
 

Action Description 

Create Title Block in 
Planner 

A Title Block is a special form of AutoCAD drawing. This had to be 
created in the Planner module and written to a specific Windows folder. 

Register Title Block in After the Title Block has been created, it must next be registered in Fixture 
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Fixture Studio  Studio. This will make it appear in the list of blocks available for 
placement. 

Add Title Block 
Information in 
Administration 

Once the title block has been registered in Fixture Studio, some additional 
information needs to be added in the Administration module. This 
includes information such as the size of the viewport - in effect a window 
cut through the title block so that the floor plan can be seen through it. 

Add Title Block to floor 
plans 

After the Title Block has been created in Planner registered in Fixture 
Studio and added to the list of title blocks in Administration, it can then 
be used in floor plans. 

Influence of AutoCAD Settings on Title Block Parameters 
Some AutoCAD parameters influence the configuration of Title Blocks.  An example is 
the AutoCAD options dialog box. 

 

One of several settings that a ffect how title blocks function is the option to plot offset 
from the printable area or edge of the paper. This affects the parameters set in the Title 
Blocks dialog box accessed from the Planning Menu in the Administration module. 
 These AutoCAD settings should be consistent on all machines used to publish floor 
plans. 

Note: See the AutoCAD help files for more information. 

Creating the Title Block in Planner 
Creating the Title Block in the Planner Module requires a series of actions to be carried 
out. 
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Establishing Required Paper size 
Title Block Size has to take into account the printable area on the selected paper size. For 
example, A3 paper is 297 x 420 mm. However, printers (and plotters) cannot make use of 
all that area. A border (called the non-printable area) that cannot contain any lines or text 
exists around the edges of the paper. The size of the title block needs to allow for the non-
printable area. If A3 paper is used, and the non-printable area is 6 mm wide, then the title 
block needs to be drawn at 285 x 408 mm to fit exactly into the printable area of the 
paper. The insertion point of the title block is normally defined as 0,0 when it is created. 

 

Draw Frame and Text Boxes 
After the size has been established a frame can be drawn in planner, and text boxes 
added. 
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The Title block is usually drawn with the origin at 0,0. 

Add Attribute Definitions 
Attribute Definitions are used to set up the 'template'  Attributes for the text boxes. They 
are invoked by typing ATTDEF into the AutoCAD command line in Planner and 
pressing Return. 

 
This will bring up the Attribute Definition dialogue box. 
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The Attribute Definitions can then be put into the drawing. 

 

Attribute Tags should not contain spaces. If necessary, join two words with an 
underscore: WORD1_WORD2. The Attribute Tags should either match the names of the 
hard coded data or the column names or aliases in the Custom SQL  Two forms of 
attribute definition may be put into the Title Block: constant and populated. The constant 
attribute acts as a title for each item of information and remains the same irrespective of 
the floor plan it is inserted into. The populated attribute will update with data specific to 
the floor plan it is being inserted into. 
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Note: See the AutoCAD help file for more information on 
Attributes. 

Convert into Block 
The Title Block can then be turned into a block with the 'block' command. This can either 
be initiated from the AutoCAD command line. 

 
The individual components of the Title Block will then be combined to make a single 
object. This block definition is stored in the current drawing and is not yet globally 
available. 

Write Block to External folder 
The Write Block (WBlock) command is used to write the block definition to an external 
directory where it can be used in any Macro Space Management drawing. The command 
is invoked by typing WBlock into the command line. 
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The destination should be a directory specified in the Directories Tab of the 
Configuration Module.  This tab can only be accessed from within the Administration 
module. 

Registering the Title Block in Fixture Studio 
Registering the Title Block  in Fixture Studio requires the following steps. 

 

Registering the Block 

Selecting the Parent F ixture Group 
All blocks within Fixture Studio are arranged within a hierarchy. The default hierarchy 
provided with the application contains a Fixture Group called Title Blocks. This is the 
usual location for title blocks. 

 

Create a Block and Enter the Block Name 
Highlight the Title Blocks Fixture Group and create a block by invoking the Add Block 
option from the Edit menu or the toolbar. This will bring up the New block name 
dialogue box.   
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Ensure that the block name entered exactly matches the block name specified in the 
WBlock command used in Planner.  If these names do not match, the title block will not 
work when inserted into a floor plan.  On clicking OK, the Block Details dialogue box 
will appear for editing. 

Enter Settings in the Block Details Dialogue Box 
The Block Details dialogue box allows custom properties to be assigned to the title block. 

 

Full details of how to use this dialogue box can be found in the Fixture Studio help file. 
The principal settings pertinent to title blocks are: 

Category Tab 

Option Description 

Retail Type 
This must be set to Title Block. This will be used by the software to identify blocks 
that can be used for this purpose. It will also ensure that the title block is grayed out 
and unavailable for placement except via the Insert menu in Planner. 



Registering the Title Block in Fixture Studio 

244 Oracle Retail Macro Space Management 

Directory 
This must be set to the same directory that the Title block was written to (WBlocked) 
from Planner. If this is not done, the application will not be able to find the title block 
when it is inserted into a floor plan. 

Units This is to ensure the Title Block is displayed at the correct scale when it is used. 
Using millimeters in place of inches will result in an incorrectly sized Title Block. 

Icon This should be set to title block. This provides an easy way of identifying title blocks 
in the Fixture Studio hierarchy. 

Exclude 
From 
Reports 

This option sets a flag which can be used to exclude the title block from the list of 
blocks in a floor plan. This flag improves accuracy in reporting. 
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Insertion Tab 

Option Description 

Layer The application comes with a pre-configured layer called TITLEBLOCK. 

Level This should be set to undefined 

Insertion 
Position 

Set the Insertion Position to match that of the AutoCAD insertion position for the title 
block. In the example in this help file, this is Bottom, Front, Left 

Size Tab 

Option Description 

Length This should be set to the actual dimension of the paper - including that on the non-
printable area. 

Depth This should be set to the actual dimension of the paper - including that on the non-
printable area. 

Height The height should be set to 0.00001. This nominal value is to avoid 'divide by zero' 
errors in the code. 

Saving Locally 
With all information entered into the Block Details dialog box, click OK to save the 
information locally. 

Saving to the Database 
To save the information to the database: 

1. Highlight the title block in the list of blocks. 

2. Select Save Blocks from the File menu. This will bring up the Save block Definitions 
dialog box. 

 
3. Select Database, Add New Definitions, Enforce Save and Only Save Selected Blocks. 

4. Click OK and the information will be saved to the database. 
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Configuring the Title Block in the Administration Module 
Once registered in fixture Studio, the Title Block needs to be registered in the 
Administration Module before it can be used in the Planner module. This is done using 
the title blocks option from the Planning menu.  

 
See the Oracle Retail Macro Space Planning Administration Module User Guide for more 
information. 
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Gondola Hierarchies 

Adding, Editing and Deleting Gondola Groups 
Groups are used to arrange fixture and gondola definitions into logical sub-sets. The 
resulting hierarchy is used in Fixture Studio for maintaining information on the 
equipment used in Macro Space Planning. The hierarchy also appears in the Object 
Browser in the Planner and Merchandiser modules and in In-Store Space Collaboration. 
These groups are a way of arranging large numbers of fixtures into sub-sets sharing a 
common characteristic. For example, one group could hold all fittings and fixtures used 
for clothing, another all those used for chilled or frozen foods.  

 
 Groups can be Added, Edited and Deleted using the options on the toolbar. (They may 
also be added using the options on the right click menu). 

 
 

Icon Option 

 

Add Group 

 

Edit Group 

 

Delete Group 

Adding a Group 
To add a group, highlight the parent group to which it is going to be added. Click the 
Add Group icon. The Group dialogue box will appear. 
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Enter a description and select an icon from the drop down list. Click on OK to conform. 

The group to be added is a child of its selected parent group. 

Edit Group 
To add a group, highlight the group which is to be edited. Click the Edit Group  icon. The 
Group dialogue box will appear. 

 
Edit the description if requited. It is also possible to select an alternative icon from the 
drop down list. Click OK to conform. The Group details will now be updated. 

Delete Group 
To delete a group, highlight the group to be deleted. Click on the Delete Group icon. If 
the Group to be deleted has child groups or block definitions, a warning dialogue will 
appear. 

 
If there are no child objects, the group will be deleted without any requirement for 
confirmation. 

Note: Information of Fixture Groups will not be written back 
to the database until the Save option is used from the File 
menu. Information on Gondola Groups will not be written 
back to the database until the Save Gondolas option is used 
from the File menu. 
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26 
Basic Concepts for Gondola Creation 

Overview of Gondola Creation and Use 
Gondolas are predefined arrangements of fixtures and fittings that are aligned to each 
other in a precise spatial relationship. This enables long runs of equipment to be placed 
using just a few commands - saving considerable time when creating store plans. In the 
example below, the run of storage racking is configured as a gondola and can be placed 
in four separate sizes in either two or three tiers. 

 
Gondolas are made up of repeating units called bays. A gondola consists of one or more 
bays. Each bay contains a specific arrangement of fixtures and fittings. A bay could be as 
simple as a simple fixture, for example a Chiller unit. 

 
Equally, a bay could be made up multiple components. In the example below, the 
slatwall gondola consists of a number of bays. The first bay has been exploded to show it 
is made up of three components: a leg, slatwall and base. 
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Gondolas are defined in Fixture Studio using the Gondola definition dialog box. 

 
They can then be placed in the Planner and Merchandiser module (and in In-Store Space 
Collaboration) using the Gondola Run dialog box. 
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This dialog box allows this specific gondola to be: 

 Placed in any combination of six lengths and heights. 

 Have optional start and end caps. 

 Have a specific number of bays. 

 Be placed at a specific angle from a specific starting point. 

This makes laying out equipment in a store plan fast and easy. 

Basic Steps in Gondola Creation 
There are a number of basic steps to gondola creation. Some of these steps must be taken 
at the time the fixtures are created; for example deciding on a naming convention. The 
steps are: 

 Decide on and implement a naming convention 

  Import the blocks into Fixture studio (not covered in this section) 

–  Ensure Insertion points are consistently located 

 Assign Gondola Part Types  

 Assign Gondola Sizes 

 Define Gondola  

– Define name, main length and maximum bays 

– Select and assign dimensions 

– Specify the list of parts 

– Define the part details 

– Define the part size position and rotation 

Naming Conventions and Block Names 
When a gondola is placed in the Planner or Merchandiser modules, i t relies on using a 
DWG or 3DS file to represent the gondola. In order to find the required file Macro Space 
Planning reconstructs the block name from selections made in the Add Gondola dialog 
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box and information in the Gondola definitions dialog box. This process will be followed 
for every part in the gondola. 

Steps to Build Up Block Names 
Block names are built up as follows: 

Create a List of Sizes 
A list of dimensions is built up using the Gondola sizes dialog box. A variety of sizes has 
been created, each with a set of dimensions associated with them.  In the example below 
there are a range of sizes including Slatwall Length and HD Racking Length. HD Racking 
Length then has the following options associated with it:  6 feet, 8 feet, 10 feet and 12 feet. 

 

Associate a Size with a Gondola Definition. 
Once a size has been created it can be associated with a specific gondola definition. In the 
example below the Racking Length, Racking Depth and Racking Height sizes have been 
chosen. Additional information has also been entered on suffixes, name order and so on 
which will affect the final block name. 
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Configure Further Details in the Gondola Defin ition dialog box 
Further details affecting the calculated block are entered in the Details sub-tab of the 
Parts of the Gondola Definition dialog box. These include such things as the prefix name 
for any block and which of the dimensions to use. 

 

Calculating a Block Name 
The starting point for calculating a block name comes when selections are made in the 
Add Gondola dialog box. This in then married up with the information in the Block 
Definitions dialog box to produce a block name. 

 Add Gondola dialog box 
The starting point for placing a gondola is the Add Gondola dialog box. Here the user 
selects the required dimensions. In this example, there are three; Racking Length, 
Racking Depth and Racking Height. Values of 48 inches, 24 inches and 96 inches have 
been selected. On clicking the OK button, the application starts to reference information 
in the Gondola Definitions dialog box. Here the length has been selected as 36 inches, the 
depth as 24 inches and the height as 72 inches. 
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Gondola Definitions dialog box - Prefix 
The next stage is derived from the Parts sub-tab of the Details tab of the Gondola 
Definitions dialog box. The Prefix (if any) is selected and becomes the first part of the 
block name. In this case it is I_BR_Fixture_ This gives the first part of the block name. 

 

Building up the Dimensions of the Block 
The dimensions of the block are built up from three things: 

 The dimensions selected in the Add Gondola dialog box. 
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 Information specified in the Dimensions tab of the Gondola Definition dialog box. 

 Information specified in the Details sub-tab of the Parts tab of the  

 

The dimensions are built up in name order. 

 The starting point for the block name is the suffix: I_BR_Fixture_. 

 The first name dependency is Racking Length. This was selected as being 36 inches, 
so a value of 36 is added to the suffix, together with the Suffix for Racking Length. 
This modifies the block name to I_BR_Fixture_36x 

 The next name dependency is Racking Depth. This was selected as being 24 inches, 
so a value of 24 is added to the block name, together with the Suffix for Racking 
Depth. This modifies the block name to I_BR_Fixture_36x24x 

 The final name dependency is Racking Depth. This was selected as being 72 inches, 
so a value of 72 is added to the block name. There is no Suffix for Racking Depth. 
This modifies the block name to I_BR_Fixture_36x24x72. 

Note: see the section on Assigning Gondola Sizes for more 
information on how Name dependencies/Dimensions are 
configured. 

Selecting the Block 
The final block name is I_BR_Fixture_36x24x72. The functionality identifies that block 
name in the fixture hierarchy and uses it to draw the gondola. 

 

Note: if the result of the above calculations is a block name 
that does not exist, the gondola will error when an attempt is 
made to place it in the Planner or Merchandiser modules or 
in In-Store Space Collaboration. 
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Gondola Parts 
Gondolas can be considered to be made up from a number of components. In  the 
example below, the gondola is made up of Freezers of type 'Structure' and Condiment 
Cabinets of type 'Bench Mounted'. This information can then be used for reporting 
purposes. 

 
These reporting types can be defined in the Gondola Parts dialogue box. This is accessed 
from the Gondola Parts icon on the toolbar. 

 
This will bring up the Gondola Parts dialogue box. Gondola parts can be added by 
typing entries into the top row and pressing Return to write the entry to the database. 

 
Gondola parts can be deleted by highlight the pertinent entry and pressing Delete. 

These part types will then be available in the Type drop down list of the Details sub-tab 
of the Parts tab of the Gondola Definition dialog box. 
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Mapping Gondola Parts 
Sometimes a client has an existing fixture library where the block names do not conform 
to a naming convention. Gondolas require blocks with naming conventions. Mapping 
Gondola Parts is initiated from the Mapping button of the Details sub-tab of the Parts tab 
of the Gondola Definition dialog box. 
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This will bring up the Gondola Block Mapping dialog box. It will already be populated 
with the names that would result if required blocks had a naming convention. (These are 
calculated from the information in the Gondola Definition dialog box).  Enter the 
corresponding block names, together with  any rotation required if they are in a different 
orientation from a Front direction of South (Insertion Tab - Block Details dialog box). 

 
Once the dialog box is populated, it can be edited by recalling it from the toolbar. 
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Assigning Gondola Sizes 
The parts that make up a gondola run come in specific sizes. The possible sizes for 
specific gondola dimensions are entered in the Gondola Sizes dialogue box. This is 
accessed by clicking on the Gondola Sizes icon on the toolbar. 

 
This will bring up the Gondola Sizes dialogue box. 

 
Dimensions can be added on the left hand size by clicking the Add Size icon. This will 
create a new line in the list of sizes. Enter a name in the Description field and select a 
unit from the Units drop down list. Press Return to add this dimension to the list of 
dimension and write the information back to the database. (If return is not pressed, the 
data will not be saved). Data can then be entered on the right. 

Data Description 

Size 
This is the physical size that will be used for calculation purposes by Macro Space 
Planning when drawing the bay. In the above example, the bays are 6 inches longer 
than the size of the main part for the bay. 

Description 

This is the text that will appear in the Add Gondola dialog box in the Planner and 
Merchandiser module (and in In-Store Space Collaboration). In the above example the 
description is in feet, which is easier for users to select than if the dimension were in 
inches. 

Name 
This is the text that will be matched to the block name. In the above example the '72' 
name will eventually be matched up to the pertinent part of the I_HDR_Beam_72x1-
5x4 block name that will be used to draw the gondola. 

Note: Entries are only written to the database on pressing 
Return. 
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Once assigned to a gondola definition, Gondola sizes become available for selection in 
the Add Gondola dialog box in the Planner and Merchandiser module (and in In-Store 
Space Collaboration). 

 

Gondola Definitions - the Dimensions Tab 
The Dimensions Tab is primarily used to specify the name and the dimensions used in 
the gondola. The list of dimensions available for selection is configured in the Gondola 
sizes dialog box. This is accessed from the toolbar.   

 

Options at the top of the dialog box: 
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Option  Description 

Name The Name must be unique within the Macro Space Planning database.  

Description The Description can be used to give more information as to the gondola definition if 
required. It does not have to be unique. 

Main 
Length 

If the main length is set to 0, the length of a bay will be set automatically based on the 
dimension selected when the gondola is placed in a floor plan. If the main length is set 
to any positive value, then each bay in the gondola will be that single, fixed length. 

Max Bays 
If set to 0, then the number of bays that can be placed in a floor plan is unlimited. If set 
to a positive number, this will limit the number of bays that can be placed when the 
gondola is added to a floor plan. 

The list of available dimensions is available in the left hand pane. These are configured in 
the Gondola sizes dialog box that can be accessed from the toolbar. They can be selected 
for use by double clicking in the left hand pane - they will then appear in the right hand 
pane. 

Options for Dimensions: 

Option  Description 

Size Range  This is the name of the dimension. It is defined in the gondolas sizes dialog box. It 
cannot be edited in the dimensions tab. 

Label 

This is the title given to the title for the dimension in the Add Gondola dialog box that 
is used to place gondolas in the Planner and Merchandiser modules and in In-Store 
Space Collaboration. This enables the dimension name to be modified to make it easy 
for store planners. 

 

Suffix This is used in building up the block name when the gondola is placed in a store plan. 
This is discussed in more detail in the section on the Parts tab. 

Name 
Order 

This is used in building up the block name when the gondola is placed in a store plan. 
This is discussed in more detail in the section on the Parts tab. Because of problems 
with the way Name Order currently works, it is recommended that the dimensions are 
selected in the sequence that will be used. 

Main 
This check box is used to specify the length of the bay when the gondola is placed in a 
store plan. Only one dimension can be designated as main. There should always be a 
'Main' dimension specified unless the Main Length text box has a value specified. 
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Gondola Definitions: Parts Tab - Details 
The Details sub-tab of the Parts tab enables users to set up a list of gondola parts, define 
some rules as to how the blocks used to draw the gondola in a floor plan will be 
identified and specify the gondola bays that part will be used in. 

 

Parts 
Names for specific parts within a gondola are entered by typing a name in the text box at 
the top off the Parts frame and pressing Return. Pressing return is necessary for the 
information to be stored. Highlighting a specific name in the list will then activate the 
Details sub-tab. 

 
Parts can be deleted by highlighting them in the list then pressing Delete. Highlighting a 
gondola part also makes it available for editing. 

Block Names 
Two part of the Parts Tab/Details sub-tab are used to create a series of rules used to 
determine the name of the block used to create that part of the gondola. 
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The Name Dependency is used to specify which values for the dimensions will be 
used to build up the block name. In  the above example, Racking Length, Depth and 
Height will be used. 

Option Description 

Type This is selected from a drop down list and is used for reporting purposes. The drop 
down list is configured using the Gondola Parts option on the toolbar. 

Description This is the part name. It is copies across from the left hand pane holding the list of part 
names. 

Prefix 
This will become the first part of the block name used to draw the gondola when it is 
placed in a floor plan. All blocks used to draw this gondola part will start 
I_BR_Fixture_ 

Suffix  This will be the concluding part of the block name. Suffixes like _Wood or _Red could 
be used to specify particular types of blocks. 

An example block name would be built up as follows: 

Option Value 

Prefix I_BR_Fixture_ 

Racking 
Length 

48. This will have a local suffix of 'x' as specified in the Parts tab.  

Racking 
Depth  

24. This will have a local suffix of 'x' as specified in the Parts tab.  
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Option Value 

Racking 
Height 72. This has no suffix specified. 

Suffix None specified. 

This will result in a block name of I_BR_Fixture_48x24x72. Both a DWG and a 3DS file of 
this name (or a mapped name) must exist for the gondola to be drawn.  

Include If 
These options are used to specify what bay the part will appear in.  

 
 

Option Description 

First 
Bay Include the part in the first bay. This option is useful for end caps. 

Odd 
Bay Include the part in odd numbered bays. 

Even 
Bay 

Include the part in even numbered bays. Both the Odd and even numbered options are 
generally checked to put the parts in all bays. 

Middle 
Bay Put the path in the middle bay of the gondola run. 

Last 
Bay Include the part in the last bay. This option is useful for end caps. 

In this example alternating gondola parts have been defined using either Odd Bay or 
Even Bay.  
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Optional 
These three options allow users to configure further parts of the gondola. 

 
 

Option Description 

Optional 
If the text is left untouched the part will appear in every gondola. If text is edited, the 
part will become optional with the option of including it added to the Add Gondola 
dialog box.  

Bay 
Group This functionality has not been implemented. 

Even Bay  This functionality has not been implemented. 

Creating an Optional Part 
To create an optional part, first enter text in the   
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The option then appears in the Options frame of the Add Gondola dialog box. 

 
The part can then be selected or de-selected by means of the check boxes when the 
gondola is added in the Planner and Merchandiser modules or in In-Store Space 
Collaboration. 

Specifying Size, Position and Rotation 
A gondola can contain a wide variety of parts. Some of these may need to be orientated 
relative to the base point of the bay and rotated relative to the initial insertion position of 
the block. This information is entered in the Size, Position and Rotation Tab 
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Stretchable Blocks 
The top section of the sub-tab specifies the dimensional offsets for stretchable block. 
Blocks are made stretchable by assigning a size to them in the Sizes tab of the Block 
Definition dialog box. 

 

Fixed Size Blocks 
The top section of the sub-tab specifies the dimensional offsets for blocks of fixed size. 
These are blocks that have a single fixed size assigned to them in the Sizes tab of the 
Block Definition dialog box. The dimensions used are the Actual Size - in this example 
length of 48 inches, depth of 36.5 inches and height of 72 inches. 
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Block Rotations 
The bottom section of the sub-tab gives the rotation required to orientate each part within 
the gondola. Sections of the gondola such as the back and the start and end caps 
generally require a rotation. 

Note: rotations are normally in the Z (Vertical) plane. It is 
unusual to rotate on the X or Y planes. 

Baselines and Base Points 

Overview 
When configuring a gondola it can be considered as having fixtures placed along an 
imaginary baseline. Each point along the baseline is the origin for a specific bay. 

 

If there are multiple parts within a bay, all are associated with that base point. 
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In the above plan view, the two 'L' legs and fixture making up the start cap of a gondola, 
together with the 'T' leg and two fixtures are all associated with the first base point. Many 
of the parts have been given differing offsets and rotations so they draw in the correct 
position when the gondola is placed. The start cap and first few bays of the gondola are 
seen below. 

 
All parts are rotated and offset relative to their insertion point. In the example below, the 
insertion point (represented by a red circle) is situated at bottom-back-left of the fixture. 

 

Length of Each Bay  
The distance between base points is specified in the Size, Position and Rotation sub tab 
of the Parts  tab in the Add Gondola dialog box. 
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There are two options: 

 Set a fixed Main Length - all bays will be this fixed length irrespective of the parts in 
them. 

 Set a main length that will vary according to the dimension selected in the Add 
Gondola dialog box. 

 

In the above example the length parameter for a block of fixed size has been set to Offset 
by Racking Length so the length of the block will be used as the dimension of the bay. (If 
a fixed length was to be used, the Main Length field would have a value in). 

Rotations of Gondola Parts 
All fixtures and fittings have a designated front direction. This is normally set to point 
down the drawing when they are inserted. 

 
When a gondola is created, some of the parts (Start Cap, Back and End Cap) need to have 
their components rotated so that the front of those parts is facing in the right direction 
when the gondola is drawn. 
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If we wanted to add a part to the back of the gondola, we would specify a 180 degree Z 
Axis Rotation  in the Size, Position and Rotation sub-tab of the Parts tab of the Gondola 
Definition dialogue box. 

 

Rotation and Offsetting of Gondola Parts 
When a gondola component is rotated to get it into the correct orientation, it is rotated 
around its insertion point. 
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In the case of a component to be used for the back of the gondola, it is rotated through 
180 degrees. 

Because it rotates around the insertion point its position changes. In the above example, 
we can see that the component to be used for the back of the gondola has been displaced 
to the left during the rotation. 

We therefore have to apply an offset to get it back into its intended position. 

These offsets will vary depending on which part of the gondola is being defined. 

Note that all offsets are relative to the un-rotated orientation of the block. 

 Offsets in the X axis are relative to length 

 Offsets in the Y axis are relative to depth 

 Offsets in the Z axis are relative to height 

Required Offsets 

Side 
The sides of a gondola do not require any rotations or systematic offsets. 

Back 
The Back of the gondola is rotated through 180 degrees to get the front facing in the 
correct direction. 

 
It then needs a positive offset equal to the width of the block. 
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Start Cap 
The Start Cap is rotated through 270 degrees to get the front facing in the correct 
direction. 

 
It then needs a positive offset equal to half of the width of the block. 

 

End Cap 
The End Cap is rotated through 90 degrees to get the front facing in the correct direction. 

 
It then requires two offsets to get it into the correct final position. 
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Firstly, it requires a positive offset equal to the width of the Side component of the 
gondola to move it to the right. Then it requires a negative offset of half i ts width to move 
it the correct distance down. (The negative offset is to move the block down, as opposed 
to up). 

 
In the above example the part is to be used in an end cap. It has been given a rotation, 
together with offsets for length and depth to get it into the correct position. 
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Fixed Size Gondola Creation Example 

Gondola Details 
This worked example will show how to create a simple gondola. 

 

It is made up of four parts: front, back, start cap (optional) and end cap (optional). These 
are defined in the Gondola Definition dialog box in Fixture Studio. 
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After definition in the Fixture Studio module, it can be placed using any combination of 
two lengths, two depths or three heights in the Planner or Merchandiser modules or in 
In-Store Space Collaboration. 

 

Testing the Gondola during Definition 
When defining gondolas, it is a good idea to test each part a fter it has been defined. This 
enables the user to correct any errors before moving onto the next part. Test can be done 
by having a  temporary floor plan open in the Planner module. The required sequence of 
actions is: 

1. Click the OK button on the Gondola Definition dialog box - this saves the 
information locally in Fixture Studio. 
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2. Select the Save Gondolas option on the File menu - this saves the information to the 
Macro Space Planning database. 

3. Click the Refresh option on the Toolbar of the Fixturing tab of the Object Browser - 
this reads the latest gondola definition information from the database into the 
Planner module. 

4. Place the gondola and verify the parts are in the expected position. 

Creating the Gondola Sizes 
In order to create the Gondola Sizes, we must first analyze the dimensions of the fixtures 
and fixtures and fittings that will be used to make up the gondola. In this example, the 
gondola will be formed from metal uprights. These follow a naming convention of Block 
Name_LengthxDepthxHeight, enabling the sizes to be easily determined. 

 
Looking at the list, it is possible to identify the dimensions required. 

Dimension Values 

Length 36 and 48 inches 

Depth 24 and 30 inches 

Height 72, 84 and 96 inches. 

 

The Size option can then be selected from the toolbar. 

 
The values can then be entered into the Gondola Sizes dialog box. 



Creating the Basic Information 

278 Oracle Retail Macro Space Management 

 
The sizes will then be available for selection in the Add Gondola dialog box when a 
gondola is placed in Planner, Merchandiser or in In-Store Space Collaboration. Note that 
the title for the dimension has come from the description assigned in the Gondola Size 
dialog box and similarly the text for the actual value has come from the description 
assigned to that particular size. 

 

Creating the Basic Information 
The first stage of creating the gondola is to highlight a Gondola group and then select 
Add Gondola in the right click menu. 
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This will bring up the Gondola Definition dialog box. The first stage is to add name 
information and select the required dimensions. 

 
 

Option Description 

Name 
This is entered as Basic Double Sided Metal Upright. This is the title that the user 
will see in the Planner and Merchandiser modules and in In-Store Space 
collaboration. 

Description 
This is the additional information available within the Gondola Definition dialog 
box. It has been left as Basic Double Sided Metal Upright but could be expanded 
at need. 

Main Length This is left at 0 as the length of a bay will be defined by the length selected in the 
Add Gondola dialog box. 
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Max Bays This is left at 0 as it is not desired to set a maximum limit on the number of bays 
that can be placed. 

Dimensions 
These are selected in the sequence they are required; Metal Upright Length, Metal 
Upright Depth and Metal Upright Height. This sequence is important because it 
will affect how the block names are calculated when the gondola is placed. 

Dimension 
Options 

Once selected, the dimensions need a little configuration. The Metal Upright 
Length has been selected as the main dimensions - the value selected when 
adding a gondola into a floor plan will define the length of the bay drawn. As the 
blocks use a naming convention of Block Name_LengthxDepthxHeight suffixes 
of 'x' have been added for the Length and Depth to ensure the block name is 
calculated correctly. 

Creating the Front 
The first part of the gondola to be created is the front. This is shown in blue in plan and 
perspective in the diagram below. 

 

Details Sub-Tab of Parts Tab 
In order to do this, the following actions are required in the details Sub-Tab of the Parts 
tab of the Gondola Definition dialog box: 
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Option Description 

Part Name 
This is generated by typing Front into the Parts text box and pressing Return. On 
highlighting Front in the list of parts, the Details sub-tab will become active, 
allowing the details to be configured. 

Type Structure has been selected from the predefined drop down list. This can be used 
for reporting purposes. 

Description This is identical to the text typed into the Parts text box. There is no need to 
change this. 

Prefix 

This is the first part of the bock name that will be used to draw this specific part of 
the gondola. The naming convention for the block name is of the form Block 
Name_LengthxDepthxHeight. I_Metal_Upright_ is therefore entered into the 
Prefix field. 

Suffix The naming convention does not have a suffix for the block name, so this field it 
left blank. 

Optional The start and end caps for this gondola are to be mandatory, so this field is left 
unchanged.  

Bay Group This option is not implemented yet, so is left unchanged. 

Report Group This option is not implemented yet, so is left unchanged. 

Include If 
This option determines which bays the part will be drawn in. It will be drawn in 
all bays, so all options are checked. 

Name 
Dependency 

This determines what dimensions are going to be used in building up the block 
name. As the block name includes Length, Depth and Height, all three 
dependencies are checked. 
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Mapping Option 
It is good practice to confirm the block names required to draw the gondola will be 
recreated correctly. This can be done by clicking the Mapping button.  This confirms that 
the block names generated by the gondola functionality conform to those which are 
present in the database. It is suggested this is done for every gondola part created to 
verify data has been correctly entered.  

 

Size, Position and Rotation Sub-Tab of Parts Tab 
As the blocks used for the front of the gondola do not need any offsets or rotations, the 
Size, Position and Rotation tab can be left unchanged. 

 

Creating the Back 
The next part of the gondola to be created is the back. This is shown in blue in plan and 
perspective in the diagram below. 
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Details Sub-Tab of Parts Tab 
In order to do this, the following actions are required in the Details Sub-Tab of the Parts 
tab of the Gondola Definition dialog box: 

 
 

Option Description 

Part Name 
This is generated by typing Back into the Parts text box and pressing Return. On 
highlighting Front in the list of parts, the Details sub-tab will become active, 
allowing the details to be configured. 



Creating the Back 

284 Oracle Retail Macro Space Management 

Option Description 

Type 
Structure has been selected from the predefined drop down list. This can be used 
for reporting purposes. 

Description 
This is identical to the text typed into the Parts text box. There is no need to 
change this. 

Prefix 

This is the first part of the bock name that will be used to draw this specific part 
of the gondola. The naming convention for the block name is of the form Block 
Name_LengthxDepthxHeight. I_Metal_Upright_ is therefore entered into the 
Prefix field. 

Suffix 
The naming convention does not have a suffix for the block name, so this field it 
left blank. 

Optional 
The start and end caps for this gondola are to be mandatory, so this field is left 
unchanged.  

Bay Group This option is not implemented yet, so is left unchanged. 

Report Group This option is not implemented yet, so is left unchanged. 

Include If This option determines which bays the part will be drawn in. It will be drawn in 
all bays, so all options are checked. 

Name 
Dependency 

This determines what dimensions are going to be used in building up the block 
name. As the block name includes Length, Depth and Height, all three 
dependencies are checked. 

Size, Position and Rotation Sub-Tab of Parts Tab 
Other settings are required in the Size, Position & Rotation sub-tab. When the parts for 
the back are placed, they will initially be placed in the default position (green fixture). 
They then require a combination of a 180o rotation (blue fixture) and an offset to move it 
into position (red fixture) behind the equivalent front fixture. 
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Option Description 

Rotation The required rotation is 180o around the Z (vertical) axis. 

Offset 

Because the bays can be different lengths depending on selections made when the 
gondola is placed, the Length (X Axis) offset is set to "Offset by Metal Upright Length" 
from the drop down list. If the user selects 3 ft long fixtures, the offset will be three feet, 
if the user selects 4 ft long fixtures, the offset will be four feet. 
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Creating the Start Cap 
The next part of the gondola to be created is the start cap. This is shown in blue in plan 
and perspective in the diagram below. 

 

Details Sub-Tab of Parts Tab 
In order to do this, the following actions are required in the Details Sub-Tab of the Parts 
tab of the Gondola Definition dialog box: 
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Option Description 

Part Name 
This is generated by typing Start Cap into the Parts text box and pressing Return. 
On highlighting Front in the list of parts, the Details sub-tab will become active, 
allowing the details to be configured. 

Type Structure has been selected from the predefined drop down list. This can be used for 
reporting purposes. 

Description This is identical to the text typed into the Parts text box. There is no need to change 
this. 

Prefix 

This is the first part of the bock name that will be used to draw this specific part of 
the gondola. The naming convention for the block name is of the form Block 
Name_LengthxDepthxHeight. I_Metal_Upright_ is therefore entered into the Prefix 
field. 

Suffix The naming convention does not have a suffix for the block name, so this field it left 
blank. 

Optional The start and end caps for this gondola are to be mandatory, so this field is left 
unchanged.  

Bay Group This option is not implemented yet, so is left unchanged. 

Report Group This option is not implemented yet, so is left unchanged. 

Include If This option determines which bays the part will be drawn in. It will only be drawn 
in the first bay, so only this option is checked. 

Name 
Dependency 

This determines what dimensions are going to be used in building up the block 
name. As the block name includes Length, Depth and Height, all three dependencies 
are checked. 

Size, Position and Rotation Sub-Tab of Parts Tab 
When the parts for the start cap are placed, they will initially be placed in the default 
position (green fixture). They then require a combination of a 270o rotation (blue fixture) 
and an offset to move it into position (red fixture) relative to the front fixture in the first 
bay. 
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Option Description 

Rotation The required rotation is 270o around the Z (vertical) axis. 
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Option Description 

Offset 

Because the bays can be different lengths depending on selections made when the 
gondola is placed, the Depth offset (Y Axis) is set to "Offset by Metal Upright 
Length" from the drop down list. The Scale Factor is set to 0.5. This means the 
fixture will be moved along by a distance equivalent to half its length. This places 
the centre of the fixture in the middle of the axis of the gondola. If the user selects 3 
ft long fixtures, the offset will be 18 inches; if the user selects 4 ft long fixtures, the 
offset will be two feet. 

Creating the End Cap 
The final part of the gondola to be created is the end cap. This is shown in blue in plan 
and perspective in the diagram below. 

 

Details Sub-Tab of Parts Tab 
In order to do this, the following actions are required in the Details Sub-Tab of the Parts 
tab of the Gondola Definition dialog box: 
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Option Description 

Part Name 
This is generated by typing Start Cap into the Parts text box and pressing 
Return. On highlighting Front in the list of parts, the Details sub-tab will 
become active, allowing the details to be configured. 

Type Structure has been selected from the predefined drop down list. This can be 
used for reporting purposes. 

Description This is identical to the text typed into the Parts text box. There is no need to 
change this. 

Prefix 

This is the first part of the bock name that will be used to draw this specific 
part of the gondola. The naming convention for the block name is of the form 
Block Name_LengthxDepthxHeight. I_Metal_Upright_ is therefore entered 
into the Prefix field. 

Suffix The naming convention does not have a suffix for the block name, so this 
field it left blank. 

Optional 
Because the End Cap does not have to be present, it can be made option by 
typing End Cap in place of the default <no> in the Optional text box. It will 
then appear as an optional part in the Add Gondola dialog box.  

Bay Group This option is not implemented yet, so is left unchanged. 

Report Group This option is not implemented yet, so is left unchanged. 

Include If 
This option determines which bays the part will be drawn in. It will only be 
drawn in the last bay, so this option is checked. Because the last bay could be 
an odd or an even number, both of these options are also checked. 

Name Dependency 
This determines what dimensions are going to be used in building up the 
block name. As the block name includes Length, Depth and Height, all three 
dependencies are checked. 
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Size, Position and Rotation Sub-Tab of Parts Tab 
When the parts for the end are placed, they will initially be placed in the default position 
(green fixture). They then require a combination of a 90o rotation (blue fixture) and two 
offsets to move it into position (red fixture) relative to the front fixture in the last bay. 
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Option Description 

Rotation The required rotation is 90o around the Z (vertical) axis. 

Offsets (general) 
Two offsets are required; one to move the fixture from the beginning of the last 
bay to the other side and one to adjust its position so that it is centered between 
the front and back (not shown) fixtures. 

Offset 1 

The first offset is an offset for length. Because the bays can be different lengths 
depending on selections made when the gondola is placed, the Length (X Axis) 
offset is set to "Offset by Metal Upright Length" from the drop down list. If the 
user selects 3 feet long fixtures, the offset will be three feet, if the user selects 4 
feet long fixtures, the offset will be four feet. 

Offset 2 

The second offset is for depth. Because the bays can be different lengths 
depending on selections made when the gondola is placed, the Depth offset (Y 
Axis) is set to "Offset by Metal Upright Length" from the drop down list. The 
Scale Factor is set to -0.5. This means the fixture will be moved along by a 
distance equivalent to half its length - and because the offset is negative, the 
fixture will be moved along the -Y axis. If the user selects 3 feet long fixtures, the 
offset will be 18 inches; if the user selects 4 feet long fixtures, the offset will be 
two feet. 

Saving the Gondola 

Saving the Gondola in Fixture Studio 
The gondola can be saved in Fixture Studio as follows: 

1. Click the OK button on the Gondola Definition dialog box - this saves the 
information locally in Fixture Studio. 

2. Select the Save Gondolas option on the File menu - this saves the information to the 
Macro Space Planning database. 

Updating Gondola Definitions in Planner and Merchandiser 
If either the Planner or Merchandiser modules are open when a Gondola is being defined 
or updated in Fixture Studio, the definition must be updated in the Planner or 
Merchandiser modules before it can be used. The steps are as follows: 

1. Ensure the Gondola Definition has been Saved in Fixture Studio with the Save 
Gondolas option on the File menu. 

2. Click the Refresh option on the Toolbar of the Fixturing tab of the Object Browser - 
this reads the latest gondola definition information from the database into the 
Planner module. 

Updating Gondola Definitions in In-Store Space Collaboration 
If In-Store Space collaboration is open when a Gondola is being defined or updated in 
Fixture Studio, the definition must be updated in ISSC before it can be used. The steps 
are as follows: 

1. Ensure the Gondola Definition has been Saved in Fixture Studio with the Save 
Gondolas option on the File menu. 

2. Use the Refresh option in the In-Store Space Collaboration toolbar to load the latest 
changes. 
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28 
Stretchable Gondola Creation Example 

Stretchable Gondola Details 
Note: Please refer to the worked example on how to create a 
fixed size gondola. It provides information that is necessary 
to understanding this example. 

This worked example will show how to create a stretchable gondola. It uses two parts - a 
stretchable leg and a stretchable fixture. Each bay consists of a leg and a fixture, except 
the end bay which has an additional leg. 

 

These are defined in the Gondola Definition dialog box in Fixture Studio. 
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After definition in the Fixture Studio module, it can be placed using any combination of 
eleven lengths, five depths or nine heights in the Planner or Merchandiser modules or in 
In-Store Space Collaboration. This allows a gondola to be place using any one of 495 
combinations of length, depth and height using only two basic fixtures. This makes this 
method economical in terms of creating fixtures, but requires care when reporting bills of 
materials for a floor plan. 

 

Testing the Gondola during Definition 
When defining gondolas, it is a good idea to test each part a fter it has been defined. This 
enables the user to correct any errors before moving onto the next part. Test can be done 
by having a  temporary floor plan open in the Planner module. The required sequence of 
actions is: 
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1. Click the OK button on the Gondola Definition dialog box - this saves the 
information locally in Fixture Studio. 

2. Select the Save Gondolas option on the File menu - this saves the information to the 
Macro Space Planning database. 

3. Click the Refresh option on the Toolbar of the Fixturing tab of the Object Browser - 
this reads the latest gondola definition information from the database into the 
Planner module. 

4. Place the gondola and verify the parts are in the expected position. 

Assigning Sizes to the Stretchable Blocks 
Stretchable gondolas use blocks that can have their sizes determined upon insertion into 
a floor plan. Sizes are assigned to blocks by selecting the Edit Sizes option from the Edit 
menu. 

 
This in turn brings up the Sizes dialog box. Two different forms of stretchable sizes have 
been defined - one for stretchable fixtures and one for stretchable legs. 

 
Specific sizes can then be defined in the Size dialog box. The maximum, minimum and 
increment should be noted as these will be required when setting up the list of gondola 
sizes. 
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These Sizes can then be assigned to specific blocks in the Sizes tab of the block Details 
dialog box. 

 

Creating the Stretchable Gondola Sizes 
In order to create the Gondola Sizes, we must first analyze the dimensions of the fixtures 
and fixtures and fittings that will be used to make up the gondola. In this example, the 
gondola will be formed from stretchable blocks. Because the blocks are stretchable, for 
this gondola, we only need two blocks. 

 
The dimensions required for the Gondola sizes are those defined in the Sizes dialog box 
accessed from the Edit menu. 
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Once the sizes are known, the Size option can then be selected from the toolbar. 

 
The values can then be entered into the Gondola Sizes dialog box. The options should 
match those in the Size dialog box. 

 
This is the same process as for creating sizes for gondolas used for blocks of fixed 
dimensions. The differences arise when the sizes are used in the Gondola Definition 
dialog box. 

Creating the Basic Information for the Stretchable Gondola 
The first stage of creating the gondola is to highlight a Gondola group and then select 
Add Gondola in the right click menu. 
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This will bring up the Gondola Definition dialog box. The first stage is to add name 
information and select the required dimensions. 

 
 

Option Description 

Name This is entered as Stretchable Gondola. This is the title that the user will see in the 
Planner and Merchandiser modules and in In-Store Space collaboration. 

Description This is the additional information available within the Gondola Definition dialog 
box. It has been left as Stretchable Gondola but could be expanded at need. 

Main Length This is left at 0 as the length of a bay will be defined by the length selected in the 
Add Gondola dialog box. 

Max Bays This is left at 0 as it is not desired to set a maximum limit on the number of bays that 
can be placed. 
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Option Description 

Dimensions 

These are selected in the sequence they are required; Stretchable Racking 
Length, Stretchable Racking Depth and Stretchable Racking Height. This sequence is 
important because it will affect how the block names are calculated when the 
gondola is placed. 

Dimension 
Options 

Once selected, the dimensions need a little configuration. The Stretchable Racking 
Length has been selected as the main dimensions - the value selected when adding a 
gondola into a floor plan will define the length of the bay drawn. For stretchable 
gondolas no suffixes are required. 

Creating the Stretchable Gondola Leg 
The first part of the gondola to be created is the leg. This will appear at the beginning of 
each bay. 

 

Details Sub-Tab of Parts Tab 
In order to do this, the following actions are required in the details Sub-Tab of the Parts 
tab of the Gondola Definition dialog box: 
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Option Description 

Part Name 
This is generated by typing Leg into the Parts text box and pressing Return. On 
highlighting Leg in the list of parts, the Details sub-tab will become active, allowing 
the details to be configured. 

Type Leg has been selected from the predefined drop down list. This can be used for 
reporting purposes. 

Description This is identical to the text typed into the Parts text box. There is no need to change 
this. 

Prefix For a stretchable gondola, the entire block name can be entered into the Prefix field. 
In this case it is I_Stretchable_Racking_L-Leg.  

Suffix No suffix is required, so this field it left blank. 

Optional The leg is mandatory for this gondola, so this field is left unchanged.  

Bay Group This option is not implemented yet, so is left unchanged. 

Report Group This option is not implemented yet, so is left unchanged. 

Include If This option determines which bays the part will be drawn in. It will be drawn in all 
bays, so all options are checked. 

Name 
Dependency 

This determines what dimensions are going to be used in building up the block 
name. For stretchable gondolas, these should be left unchecked. 

Mapping Option 
For fixed size gondolas, it is good practice to confirm the block names required to draw 
the gondola will be recreated correctly. This option is not available for stretchable 
gondolas. Clicking the mapping button will just bring up a warning dialog box. 
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Size, Position and Rotation Sub-Tab of Parts Tab 

 

Delta Options 
Delta options are used for the stretchable properties. They are governed in part by 
options in the Size dialog box and in the Gondola sizes dialog box (The sizes in the 
Gondola size dialog box should reflect those in the Add Gondola dialog box).  For the 
leg, the stretchable sizes have been defined as fixed as 1 inch for length and stretchable 
for depth and height. 
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Option Description 

Length This is left as None as the length has been fixed at 1 inch. 

Depth This has been set as Match Stretchable Racking Depth so the depth of the leg will be set to 
match the selection in the Add Gondola dialog box. 

Height This has been set as Match Stretchable Racking Height so the height of the leg will be set to 
match the selection in the Add Gondola dialog box. 

Fixed Options 
A further setting is required in the lower part of the tab. This is for an offset to get the leg 
into the correct position. The leg is 1 inch in length (width) and the insertion point is set 
to bottom back middle. A small adjustment needs to be made so that the insertion point 
for the gondola is shifted to the bottom, back left corner of the leg. This means the corner 
of the leg will go down on the selected insertion point for the gondola, ensuring very 
accurate placement. 
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Option Description 

Length 
As we want the bottom-back-left corner of the leg to be the start position of the bay, 
the leg is given a positive offset of 0.5 inches in the length (X) axis. 

Depth No setting required 

Height No setting required. 

Creating the Stretchable Gondola Front 
The first part of the gondola to be created is the front. This will appear in each bay. 

 

Details Sub-Tab of Parts Tab 
In order to do this, the following actions are required in the details Sub-Tab of the Parts 
tab of the Gondola Definition dialog box: 
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Option Description 

Part Name 
This is generated by typing Front into the Parts text box and pressing Return. On 
highlighting Front in the list of parts, the Details sub-tab will become active, 
allowing the details to be configured. 

Type Leg has been selected from the predefined drop down list. This can be used for 
reporting purposes. 

Description This is identical to the text typed into the Parts text box. There is no need to 
change this. 

Prefix For a stretchable gondola, the entire block name can be entered into the Prefix 
field. In this case it is I_Stretchable_Racking_Fixture. 

Suffix No suffix is required, so this field it left blank. 

Optional The front is mandatory for this gondola, so this field is left unchanged.  

Bay Group This option is not implemented yet, so is left unchanged. 

Report Group This option is not implemented yet, so is left unchanged. 

Include If This option determines which bays the part will be drawn in. It will be drawn in 
all bays, so all options are checked. 

Name 
Dependency 

This determines what dimensions are going to be used in building up the block 
name. For stretchable gondolas, these should be left unchecked. 
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Size, Position and Rotation Sub-Tab of Parts Tab 

 

Delta Options 
Delta options are used for the stretchable properties. They are governed in part by 
options in the Size dialog box and in the Gondola sizes dialog box (The sizes in the 
Gondola size dialog box should reflect those in the Add Gondola dialog box).  For the 
leg, the stretchable sizes have been defined as fixed as 1 inch for length and stretchable 
for depth and height. 

 

Option Description 

Length 

This has been set as Match Stretchable Racking Length so the depth of the leg will be set 
to match the selection in the Add Gondola dialog box. It has also been given a delta 
value of -1. This reduces the length specified in the Add Gondola dialog box by one 
inch to allow for the thickness of the leg at the start of the bay. 



Creating the Stretchable Gondola End Leg 

306 Oracle Retail Macro Space Management 

Option Description 

Depth 
This has been set as Match Stretchable Racking Depth so the depth of the leg will be set 
to match the selection in the Add Gondola dialog box. 

Height 
This has been set as Match Stretchable Racking Height so the height of the leg will be 
set to match the selection in the Add Gondola dialog box. 

Fixed Options 
A further setting is required in the lower part of the tab. This is for an offset to get the leg 
into the correct position. The leg is 1 inch in length (width) and the insertion point is set 
to bottom back middle. A small adjustment needs to be made so that the insertion point 
for the gondola is shifted to the bottom, back left corner of the leg. This means the corner 
of the leg will go down on the selected insertion point for the gondola, ensuring very 
accurate placement. 

Option Description 

Length 
This has been given a fixed offset of one inch. This moves the insertion position of 
the front part up by one inch to allow for the present of a leg as the start of the 
bay. 

Depth No setting required 

Height No setting required. 

Creating the Stretchable Gondola End Leg 
The last part of the gondola to be created is the end leg. This will only appear on the end 
of the last bay. 
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Details Sub-Tab of Parts Tab 
In order to do this, the following actions are required in the details Sub-Tab of the Parts 
tab of the Gondola Definition dialog box: 
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Option Description 

Part Name 
This is generated by typing End Leg into the Parts text box and pressing Return. On 
highlighting End Leg in the list of parts, the Details sub-tab will become active, 
allowing the details to be configured. 

Type Leg has been selected from the predefined drop down list. This can be used for 
reporting purposes. 

Description This is identical to the text typed into the Parts text box. There is no need to change 
this. 

Prefix For a stretchable gondola, the entire block name can be entered into the Prefix field. 
In this case it is I_Stretchable_Racking_L-Leg.  

Suffix The naming convention does not have a suffix for the block name, so this field is left 
blank. 

Optional 
Because the End Cap does not have to be present, it can be made option by typing 
End Cap in place of the default <no> in the Optional text box. It will then appear as 
an optional part in the Add Gondola dialog box. 

Bay Group This option is not implemented yet, so is left unchanged. 

Report Group This option is not implemented yet, so is left unchanged. 

Include If 
This option determines which bays the part will be drawn in. It will only be drawn 
in the last bay, so this option is checked. Because the last bay could be an odd or an 
even number, both of these options are also checked. 

Name 
Dependency 

This determines what dimensions are going to be used in building up the block 
name. As the block name includes Length, Depth and Height, all three 
dependencies are checked. 
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Size, Position and Rotation Sub-Tab of Parts Tab 

 

Delta Options 

 
 

Option Description 

Length This is left as None as the length has been fixed at 1 inch. 

Depth This has been set as Match Stretchable Racking Depth so the depth of the leg will be 
set to match the selection in the Add Gondola dialog box. 

Height This has been set as Match Stretchable Racking Height so the height of the leg will be 
set to match the selection in the Add Gondola dialog box. 
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Fixed Options 
A further setting is required in the lower part of the tab. This is for an offset to get the leg 
into the correct position. The leg is 1 inch in length (width) and the insertion point is set 
to bottom back middle. A small adjustment needs to be made so the leg places adjacent to 
the part to the left of it. 

 
 

Option Description 

Length 

As we want the bottom-back-left corner of the leg to be the start position of the bay, 
the leg is given a positive offset of 0.5 inches in the length (X) axis. The leg also has to 
be moved to the right hand side of the 'front' part of the bay. To do this, it is given an 
offset of 'Offset by Stretch Racking Length'.  

Depth No setting required 

Height No setting required. 

Saving the Stretchable Gondola 

Saving the Gondola in Fixture Studio 
The gondola can be saved in Fixture Studio as follows: 

1. Click the OK button on the Gondola Definition dialog box - this saves the 
information locally in Fixture Studio. 

2. Select the Save Gondolas option on the File menu - this saves the information to the 
Macro Space Planning database. 

Updating Gondola Definitions in Planner and Merchandiser 
If either the Planner or Merchandiser modules are open when a Gondola is being defined 
or updated in Fixture Studio, the definition must be updated in the Planner or 
Merchandiser modules before it can be used. The steps are as follows: 

1. Ensure the Gondola Definition has been Saved in Fixture Studio with the Save 
Gondolas option on the File menu. 

2. Click the Refresh option on the Toolbar of the Fixturing tab of the Object Browser - 
this reads the latest gondola definition information from the database into the 
Planner module. 
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Updating Gondola Definitions in In-Store Space Collaboration 
If In-Store Space collaboration is open when a Gondola is being defined or updated in 
Fixture Studio, the definition must be updated in ISSC before it can be used. The steps 
are as follows: 

1. Ensure the Gondola Definition has been Saved in Fixture Studio with the Save 
Gondolas option on the File menu. 

2. Use the Refresh option in the In-Store Space Collaboration toolbar to load the latest 
changes. 
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